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NOTE The Voice Command application is not available in all 
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Microsoft® Voice Command Version 1.5 for Windows Mobile®

IMPORTANT Do not become distracted from driving safely if 
operating a motor vehicle while using Device Software.

Operating certain parts of this Device requires user attention. 
Diverting attention away from the road while driving can possibly 
cause an accident or other serious consequences. Even occasional, 
short diversions of attention can be dangerous if your attention is 
diverted away from your driving task at a critical time. Do not change 
system settings or enter data non-verbally (using your hands) while 
driving. Stop the vehicle in a safe and legal manner before attempting 
these operations. This is important since while setting up or changing 
some functions you might be required to distract your attention away 
from the road and remove your hands from the wheel.

Microsoft makes no representations, warranties, or other 
determinations that ANY use of the Software Product is legal, safe, or 
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General Operation

NOTE The Voice Command application is not available in all 
languages. See Setting up voice commands .

Voice Command Control: Many of the functions of the Device 
Software can be accomplished using only voice commands. Using 
voice commands while driving allows you to initiate the command 
with a button and then operate the Device mostly without removing 
your hands from the wheel.

Prolonged Views of Screen: If you are driving, do not access any 
function requiring a prolonged view of the screen. Pull over in a safe 
and legal manner before attempting to access a function of the 
system requiring prolonged attention. Even occasional short scans to 



the screen may be hazardous if your attention has been diverted 
away from your driving task at a critical time.

Volume Setting: Do not raise the volume excessively. Keep the 
volume at a level where you can still hear outside traffic and 
emergency signals while driving. Driving while unable to hear these 
sounds could cause an accident.

Let Your Judgment Prevail: The Device Software is only an aid. 
Make your driving decisions based on your observations of local 

conditions and existing traffic regulations. The Device Software is not 
a substitute for your personal judgment. 

Use of Speech Recognition Functions: Speech recognition 
software is inherently a statistical process which is subject to errors. 
It is your responsibility to monitor the speech recognition functions 
and address any errors.
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Welcome

Congratulations on the purchase of your 
Palm® Treo™ 750 smart device. In one 
compact and indispensable device, you 
now have all of the following:

• An advanced wireless smart device

• A Windows Mobile® organizer with 
portable expansion capability (miniSD)

• High-speed data with GPRS/EDGE and 
UMTS support

• A 1.3-megapixel digital camera (camera 
version only)

• Support for numerous mobile email 
solutions

• Text and multimedia messaging

• Windows Media® Player Mobile

• Microsoft® Office Mobile suite

This guide will help you set up your Treo 
750 and quickly learn to use it. 

NOTE If you want to use your phone and 
send and receive text messages, you need 
a service contract with Cingular. If you also 
want to browse the web and send and 
receive email, you need not only a service 
contract but also high-speed data service 
from Cingular. You may also need 
high-speed data service to send and 
receive multimedia messages. Data 
speeds vary based on network availability 
and capacity.

What’s in the box?

You should have received all of the 
following items in the Treo 750 box:

Hardware

• Treo 750 smart device

• Rechargeable battery (1200 mAh)

• AC charger 

• USB sync cable

DID YOU KNOW? The Cingular 
business-to-business sales department offers 
a Treo 750 without a camera. 

TIP LOOK HERE: Don’t miss the helpful tips 
and cross-references given in this column.
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• SIM card (certain Treo 750 packages 
only)

• Stereo headset

• Screen protector

Documentation and software

• Read This First setup poster

• Treo 750 Smart Device Quick Reference 
Guide

• Windows Mobile Getting Started Disc, 
which includes the following:

• Microsoft Office Outlook® software

• ActiveSync® desktop synchronization 
software 

• Additional software for your Treo 750

• User Guide (this guide) 

• Palm warranty

• End User License Agreement

What do I need to 
get started?

As you work through the instructions in this 
guide, you need all the items that came in 
the Treo 750 box (see What’s in the box?) 
as well as the following:

• An activated wireless account (using a 
Cingular SIM card) with data services

• If you plan to synchronize personal 
information between your Treo 750 and 
a computer, you need access to that 
computer during setup.

• You must also have your Treo 750 within 
range of Cingular cellular coverage.



CHAPTER

1

Setting up
Congratulations on the purchase of your new Palm® Treo™ 750 
smart device. You’re about to discover the many things about 
your Treo 750 that will help you better manage your life and 
have fun, too.

As you become more familiar with your Treo 750, you’ll want to 
personalize the settings and add applications to make it 
uniquely yours. But first, take these few easy steps to set up 
your Treo 750 and get it running.

Benefits

• Know where your Treo 750 
controls are located

• Start using your Treo 750 right 
away
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Palm Treo 750 smart device overview

Front view

Indicator light (phone 
and charge indicator)

Multi-connector

5-way navigator 
with Center button

Earpiece

Power/End button

Microphone

Headset jack

Start 
buttonPhone/Send 

button

Side button

OK button

Volume button

Left action 
key

Right action key
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IMPORTANT The Treo 750 speaker 
includes a large magnet, so be sure not to 
store your Treo 750 near credit cards or 
other items that could be demagnetized.

Back view

TIP Be careful not to scratch or crush your 
Treo 750 screen. Do not store it in a place 
where other items might damage it. Visit 
www.palm.com/mytreo750cingular to find a 
variety of useful accessories, including 
carrying cases that protect the screen.

DID YOU KNOW? By default, pressing the Side 
opens the Windows Media® Player Mobile 
application (see Windows Media Player 
Mobile). You can change the function of the 
Side button (see Reassigning buttons).

Camera lens 
(camera 
version only)

Battery door 
release button

SpeakerSelf-portrait mirror

Infrared (IR) 
port

Expansion card 
slot

Reset button 
(located inside 
expansion card 
slot door)
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Top view

Inserting the SIM 
card and battery

Your SIM card contains account 
information such as your phone number 
and voicemail access number. To use your 
Treo 750 smart device’s phone, email, or 

web features, you need to insert a SIM 
card. If a SIM card is not included in your 
Treo 750 box, Cingular will provide you with 
one.

1 Use one hand to press the Battery 

door release button, and use your other 
hand to slide the battery door 
downward to remove it from your 
Treo 750.

Ringer switch

Stylus

DID YOU KNOW? The Ringer switch silences all 
sounds, including music, at once; you don’t 
need to hunt for “off” or “mute” settings in 
individual applications.

TIP If you don’t have a SIM card, contact 
Cingular customer care at 1-866-CINGULAR 
(1-866-246-4852) or dial 611 from your 
Treo 750.
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2 If the battery is installed, remove it. 
Slide your finger under the left side of 
the battery (nearest the stylus) and lift 
up to remove.

3 With the metal contacts facing the 
battery compartment, slide the SIM 
card into the cutout in the lower-right 
corner of the compartment until you 
feel it snap into place. Align the notches 
to make sure you have the card oriented 
correctly.

4 Align the metal contacts on the battery 
with the contacts inside the battery 
compartment, insert the battery into the 
compartment at a 45-degree angle, and 
then press it into place. 

5 Slide the battery door back into place. 

Your Treo 750 screen turns on. Wait for 
the progress bar to fill and the Windows 
Mobile® screen to appear.

Battery door 
release button

Notch

Battery 
contacts
Compartment 
contacts



S E T T I N G  U P

C H A R G I N G  T H E  B A T T E R Y 9

1

C
H

A
P

T
E

R

6 Follow the onscreen instructions to 
finish the installation.

7 If your SIM card is not already activated, 
follow the activation steps provided by 
Cingular, or contact Cingular directly for 
assistance. If you plan to use email and 
web browsing, you need high-speed 
data service from Cingular in addition to 
your service contract. You may also 
need high-speed data service to send 
and receive multimedia messages.

Charging the battery

Although the battery may come with a 
sufficient charge to complete the setup 
process, we recommend that after setup 
you charge your Treo 750 for three hours 
(or until the indicator light is solid green) to 
give it a full charge. See Maximizing battery 
life for tips on making your battery’s power 
last longer.

BEFORE YOU BEGIN Make sure the 
battery is inserted before you charge. If you 
connect your Treo 750 to a power source 
without the battery inserted, nothing 
happens.

1 Plug the AC charger into a wall outlet.

2 With the arrow on the connector facing 
up (toward your Treo 750 screen), 
connect the charger cable to the bottom 
of your Treo 750. 

TIP If your Treo 750 does not turn on after you 
insert the battery, you need to connect it to 
the AC charger to charge it; see Charging the 
battery. If it still doesn’t start, perform a soft 
reset; see Performing a soft reset for 
information.

TIP You can buy an extra battery as a spare for 
long airplane trips or periods of heavy data 
use. To ensure proper functioning, be sure to 
use batteries from Palm only. Visit 
www.palm.com.
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3 Check the indicator light to confirm that 
your Treo 750 is being charged. 

• Solid red indicates that your Treo 750 
is being charged.

• Solid green indicates that your 
Treo 750 is fully charged. 

When your Treo 750 is on (see Turning your 
Palm® Treo™ 750 smart device on/off), the 

onscreen battery icon displays the charging 
status:

DID YOU KNOW? If the battery is low, the 
indicator light flashes red.

Indicator light

A solid lightning bolt indicates that 
the battery is connected to a wall 
outlet and is charging.

A shaded lightning bolt indicates 
that the battery is connected to a 
wall outlet and is fully charged.

A partial battery without a lightning 
bolt indicates that the battery is not 
connected to a wall outlet and that 
it has some power.

An exclamation point (!) indicates 
that the battery needs to be 
charged immediately.

Battery 
icon
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Maximizing battery life

Battery life depends on how you use your 
Treo 750. You can maximize the life of your 
battery by following a few easy guidelines:

• Charge your Treo 750 whenever you’re 
at your desk, or charge it overnight each 
day. The battery in your Treo 750 has a 
much longer useful life if you charge it 
frequently instead of waiting until it’s 
fully drained.

• If you spend a lot of time using the 
camera (if included), games, media 
players (including listening to music 
with wireless headphones using the 
built-in Bluetooth® wireless technology), 
eBooks, or other applications, keep an 
eye on the battery icon and charge 
when necessary.

• The wireless features (phone, email, 
messaging, and web) on your Treo 750 
generally consume more power than 
the organizer features. If you don’t plan 

to use the wireless features on your 
Treo 750 for a while, turn off your 
wireless services (see Turning wireless 
services on/off). You can forward calls 
to a different number or let all calls be 
picked up by voicemail (see Forwarding 
calls). To see if your wireless services 
are on, tap the phone-off  icon, and 
then select Wireless Manager.

• If you are synchronizing email and other 
information directly with your corporate 
Exchange Server using Microsoft 
Exchange ActiveSync®, set the 
synchronization interval to a maximum 
of every 15 minutes during peak times 
and every hour (or turned off 
completely) during non-peak times (see 
Setting the synchronization schedule).

• Turn off the Bluetooth feature when you 
do not need to make a Bluetooth 
connection (see Entering basic 
Bluetooth settings).

DID YOU KNOW? If your battery ever becomes 
fully drained, your info remains safely stored 
on your Treo 750. Recharge the battery to 
access your info.

DID YOU KNOW? You can also see if your 
wireless services are on by pressing Menu 
(right action key) and selecting Wireless 

Manager.
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• Turn the voice command feature off 
(see Setting up voice commands).

• As with any mobile phone, if you are in 
an area with no wireless coverage, your 
Treo 750 searches for a signal, which 
consumes power. If you cannot move to 
an area of better coverage, temporarily 
turn off your phone (see Turning your 
Palm® Treo™ 750 smart device on/off). 

• Turn down the screen brightness (see 
Adjusting the brightness).

• Set your screen to turn off automatically 
after a shorter period of inactivity (see 
Optimizing power settings). 

• Turn off the option to receive beamed 
information (see Beaming a record).

• Keep your battery away from direct 
sunlight and other sources of heat. 
Temperatures over 120 degrees 
Farenheit (50 degrees Celsius) can 
permanently reduce the capacity and 
life span of any lithium ion battery.

Making your first call

1 Press Phone/Send  to display your 
Today screen.

2 If prompted, press Center  to turn 
off Keyguard (see Locking your 
keyboard (Keyguard) for more info).

3 Use the number pad on the keyboard to 
enter the number you want to call.

TIP You can also press Power/End to display 
your Today screen, unless you are on a call. If 
you’re on a call, pressing Power/End hangs up 
the call.
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4 Press Phone/Send  to dial.

5 When your call is complete, press 
Power/End  to end the call.

Adjusting call volume

While a call is in progress, press the 
Volume button on the side of your 
Treo 750 to adjust the call volume.

What’s my number?

1 Make sure your phone is on (see 
Turning your Palm® Treo™ 750 smart 
device on/off).

2 If you do not see your Today screen, 
press Phone/Send .

3 Press Menu  (right action key).

4 Select Preferences > Phone Settings.

5 On the Phone tab, look for your phone 
number below the title bar.

TIP The Dial Lookup list might appear while 
you are dialing a number. Continue entering 
numbers to place the call. For more info on 
the Dial Lookup list, see Dialing by contact 
name. 

Volume 
button



S E T T I N G  U P

S E T T I N G  U P  S Y N C H R O N I Z A T I O N14

1
C

H
A

P
T

E
R

6 Press OK .

Setting up 
synchronization

Once you’ve finished setting up your 
Treo 750, we recommend that you set up a 
synchronization method to get the most 
out of your Treo 750. Synchronization 
allows you to enter or change information 
on your Treo 750 or in Microsoft Office 
Outlook® on your computer; your info is 
then automatically updated in both 
places—no need to enter the info twice. 
See Synchronizing information.

TIP If your phone number doesn’t appear on 
the Phone Settings screen, your network has 
not yet sent the number to the SIM card (this 
does not affect SIM card functionality). Turn 
your phone off, wait a few hours, and then 
turn on your phone and repeat these steps. If 
your phone number still does not appear, 
please contact Cingular for assistance.

Look here for your 
phone number
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Moving around on your Palm
®

 
Treo

™

 750 smart device
Have you ever been to a new city and felt a bit lost until you 
figured out that the numbered streets run north/south and the 
avenues run east/west? Learning to move around on your 
Palm® Treo™ 750 smart device is similar. Most applications that 
work on your Treo 750 use the same set of controls. So once 
you learn how to use these controls, you’ll be driving all over 
town and you won’t even need a map.

Benefits

• Quickly move around and 
complete tasks in applications 
using one thumb on the 5-way 
navigator

• Access extra features with menus

• Find and open applications quickly
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Navigating around 
the screen

To navigate around the Treo 750 screen, 
you can use the 5-way navigator or you can 
tap items on the screen with the stylus. As 
you become familiar with your Treo 750, 
you’ll find your own favorite way to scroll, 
highlight, and select items.

Using the 5-way, press Right , Left , 
Up , or Down  to move around the 

screen. Press Center  to highlight and 
select items.

TIP Some third-party applications may not 
work with the 5-way navigator, and you must 
use the stylus instead.

DID YOU KNOW? Custom navigation features 
are available when you browse the web using 
Internet Explorer. See Viewing a web page.

TIP The arrow icons that indicate directions on 
the 5-way are different from the onscreen 
scroll arrows and the arrows that indicate that 
a list is available (see Selecting options in a 
list). 

Up 

Down 

Left Right 

Center 
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Scrolling through screens

As on a computer, on your Treo 750 you 
scroll to move from field to field or page to 
page, or in some cases to highlight an item 
or option in a list. There are several 
methods of scrolling:

• Press the 5-way on the front of your 
Treo 750. Press Right , Left , Up 

, or Down  to move to the next 
field, button, or action in that direction.

• Press and hold Option  while 
pressing Up  or Down  to scroll 
one screen at a time. These keys work 
just like the Page Up and Page Down 
keys on your computer keyboard.

• Press and hold Option  while 
pressing Left  or Right  to jump to 
the top or bottom of the current 
document or entry.

• When viewing a screen with tabs, such 
as when adding a contact, press 
Down  to scroll to the tabs, and then 
press Left  or Right  to move 
between tabs.

• When inside a text field, press Right  
or Left  to move to the next character, 
and press Up  or Down  to move 
between lines. 

• When inside a list, press and hold 
Up  or Down  to rapidly scroll 
through the list.

• Tap an onscreen scroll arrow.

TIP Can’t find the Option key? See Using the 
keyboard.

TIP When you are using applications such as 
Inbox, Internet Explorer Mobile, and Word 
Mobile, press and hold Option while pressing 
Left or Right on the 5-way to automatically go 
to the top and bottom of a screen.
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• Tap and drag the slider of an onscreen 
scroll bar.

Closing screens

To accept the information you entered on a 
screen and to return to the previous 
screen—or to return to the previous screen 
without making any changes—do one of 
the following:

• Press OK .

• Use the stylus to tap  or  in the 
upper-right corner of the screen. These 
buttons are not accessible using the 
5-way.

Highlighting and selecting items

On most screens, one item—a button, a 
list entry, or a check box—is highlighted by 
default. The highlight identifies which item 
is affected by your next action. Use the 
5-way to move the highlight from one item 
to another before opening or selecting it. 

The highlight can take one of two forms, 
depending on what is highlighted:

• Border: This rectangular border 
highlights items such as an onscreen 
button (such as OK, Dismiss, or Hide), a 
check box, an option, or a web link. 

Scroll arrows

Scroll arrows

TIP The best way to learn to use the 5-way is 
to experiment. Press the 5-way buttons and as 
you do, follow the movement of the border 
around the screen. The behavior of the 5-way 
varies slightly in each application.
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• Reverse type (light text on a dark 

background): This highlights items 
such as a phone number, an email 
address, text, or an item in a list.

After highlighting an item with the 5-way, 
you can select or activate it by pressing 
Center  or by tapping the item with the 
stylus. 

Highlighting text

You can use the 5-way or the stylus to 
highlight text on the screen:

• 5-way: Press and hold Shift (  or 
) while pressing Right , Left , 

Up , or Down  to extend the 
highlight in that direction.

• Stylus: Tap and drag the stylus across 
the text you want to highlight. To 
highlight a word, double-tap it. To 
highlight a paragraph, triple-tap it.

Using the action keys

The left and right action keys give you quick 
access to tasks that you can do on the 
current screen, so the action key items 
vary from application to application and 
from screen to screen. Look on the screen 
directly above the action key to see the 
action that it takes in the current context. 
In some contexts, these keys may do 
nothing at all. In most cases the right 
action key  opens the menu, and the 
left action key  activates a specific 
command, such as New or Edit. 
Remember that action key functions vary 
from screen to screen, so be sure to check 
the onscreen label before pressing the 
action keys. 

TIP When text is highlighted, you can press 
Backspace to delete the highlighted text.



M O V I N G  A R O U N D  O N  Y O U R  P A L M ®  T R E O ™  7 5 0  S M A R T  D E V I C E

N A V I G A T I N G  A R O U N D  T H E  S C R E E N 21

2

C
H

A
P

T
E

R

Selecting menu items

In many applications, a menu provides 
access to additional features. The menu is 
hidden until you press Menu  (right 
action key). To get the most out of your 
Treo 750, it’s a good idea to familiarize 
yourself with the additional features 
available through the menu in various 
applications.

1 Press Menu  (right action key) to 
display an application’s menu. 2 Press Up  or Down  to highlight a 

menu item.

Left action key Right action key

Left action key 
activates this 
command

Right action key 
activates this 
command
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3 If an arrow appears next to a menu 
item, press Center  or Right  to 
display additional options for that item, 
and then press Up  or Down  to 
highlight a menu item. To return to the 
main menu without making a selection, 
press Left .

4 Press Center  to select the menu 
item, or press Left  or Menu  
(right action key) to close the menu and 
cancel your selection.

Selecting options in a shortcut menu

Most applications also provide access to 
context-sensitive, shortcut menus—similar 
to the right-click menus on a computer. The 
shortcut menu options vary based on the 
highlighted selection.

1 Highlight the item whose shortcut 
menu you want to see.

2 Press and hold Center  to open the 
shortcut menu.

3 Press Up  or Down  to highlight a 
menu item.

4 Press Center  to select the menu 
item or press Left  to cancel your 
selection.

Selecting options in a list

Lists enable you to select from a range of 
options. You can identify whether a list is 
available when you select the field. If a 
rectangle appears around the field along 
with a downward-pointing arrow, a list is 

DID YOU KNOW? You can select most menu 
items by pressing a key on the keyboard. To 
quickly access a menu item, press Menu 
(right action key) followed by the underlined 
letter in the menu item’s name. 

TIP You can also tap and hold the stylus on an 
item to open the shortcut menu.
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available. Lists are different from the 
menus described earlier in this section.
 

To select from a list, do any of the 
following:

• Use the 5-way to highlight the field, and 
then press Center  to display the 
items in the list. Press Up  or Down 

 to highlight the item you want, and 
then press Center  to make your 
selection.

• Use your stylus to tap the arrow, and 
then tap the item in the list.

• To exit the list and cancel your selection, 
press Left .

TIP When selecting fields you might not see 
the downward-pointing arrow until you press 
Center on the 5-way. 

DID YOU KNOW? In fields where you see a 
downward-pointing arrow but no rectangle, 
you must tap the arrow with the stylus to 
expand the field. 
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Using the keyboard

Understanding the keyboard backlight

Your Treo 750 includes a keyboard backlight 
for low light conditions. The keyboard 
backlight activates automatically when the 
screen turns on. The backlight turns off 
automatically when the screen turns off or 
when you are on a call or playing music in 
the background for longer than the time 
specified in Backlight Settings. You can set 
different time intervals depending on 
whether the Treo 750 is operating on 
battery power or is connected to an 

Left
action key

Right
action key

Phone/Send
Start

Power/End
OK

Backspace

Option

Shift/Search

Space

Return

Shift

Alt

TIP When using the keyboard, most people 
find it easiest to hold the Treo 750 with two 
hands, using the tips of both thumbs to press 
the keys.

DID YOU KNOW? You can also use the onscreen 
keyboard to enter letters, numbers, and other 
characters in applications that support this 
feature. Tap the keyboard icon in the center at 
the bottom of any screen where it appears. 
After opening the keyboard, you can set 
various input options by tapping the arrow to 
the right of the keyboard icon.
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external power source. The backlight also 
turns off when an application’s 
power-saving features turn it off.

Entering lowercase and uppercase letters

By default, the first letter of each sentence 
or field is capitalized and the remaining text 
you enter is lowercase. To enter other 
uppercase letters, do one of the following: 

• Press Shift (  or ), and then enter 
a letter. You don’t need to press and 
hold Shift while entering a letter.

• Press Shift (  or ) twice to turn on 
Caps Lock, and then enter a series of 
letters. When Caps Lock is on, this 
symbol appears at the bottom of the 
screen: . To turn off Caps Lock, press 
Shift (  or ) again. 

Entering numbers, punctuation, and 

symbols 

Numbers, punctuation, and symbols 
appear above the letters on the keys. To 
enter these characters, do one of the 
following: 

• Press Option , and then press the 
key of the desired character. You don’t 
need to hold Option while pressing the 
key.

• Press Option  twice to turn on 
Option Lock, and then press the desired 
keys to enter a series of characters. 
When Option Lock is on, this symbol 
appears at the bottom of the screen: . 
To turn off Option Lock, press Option 

 again. 

TIP You can change the backlight shut-off 
interval. Press Start and select Settings. 
Select the System tab, and then select 
Backlight. Set the time interval on the Battery 
Power tab and on the External Power tab.

TIP You can turn off the first-letter 
capitalization setting. For details see Setting 
input options.
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Entering other symbols and accented 

characters

You can enter symbols and accented 
characters that don't appear on the keys by 
using the alternate characters list.

1 Press Alt  to display the alternate 
character list.

2 Narrow the list by pressing the key that 
corresponds to the character you want. 
For example, to enter an é, press e. See 
the following table for a list of 
corresponding characters.

3 Press Up  or Down  to highlight the 
desired character.

4 Press Center  to insert the 
character.

TIP The alternate characters are grouped 
according to their similarity to the 
corresponding key. For example, the alternate 
character available for the R key is ®, and for 
the T key is ™. If you press the wrong key, 
press Backspace to return to the full list of 
alternate characters. You can then press 
another key.
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0

Symbols and accented characters 

Press Alt 
 and 

enter… 

to select… Press Alt 
 and 

enter… 

to select… Press Alt 
 and 

enter… 

to select…

a á à ä â ã å æ n ñ x or X x ¤

A Á À Ä Â Ã Å Æ N Ñ y  ý ÿ 

b or B ß o ó ò ö ô œ õ Y  Ý Ÿ

c ç ¢ © O Ó Ò Ö Ô Œ Õ 0 °

C Ç ¢ © p or P ¶ 1 1 ¼ ½

e é è ë ê r or R ® 2 2

E É È Ë Ê s ß š 3 3 ¾

f or F ƒ S ß Š ! ¡

i í ì ï î t or T ™ $   £ ¥ ¢ $ 

I Í Ì Ï Î u ú ù ü û

l or L £ U Ú Ù Ü Û

Press Alt  by itself to select these characters:

: & _ • % = ÷ ^  £ ¥ ¢ $ [ ] { } < > « » © ® ° ~ \ Ø µ |



M O V I N G  A R O U N D  O N  Y O U R  P A L M ®  T R E O ™  7 5 0  S M A R T  D E V I C E

O P E N I N G  A N D  C L O S I N G  A P P L I C A T I O N S28

2
C

H
A

P
T

E
R

Opening and closing 
applications

Opening applications

You can access all the applications on your 
Treo 750 through the Start menu.

1 Press Start  to open the Start menu.

 

2 Use the 5-way navigator to highlight the 
application you want to use. To view 
additional applications, select 
Programs.

3 Press Center  to open the 
highlighted application.

4 (Optional) Press OK  to return to 
Programs and open another application. 
The current application continues to run 
in the background.

Closing applications

You can have several applications open at 
once, so you don’t need to exit an 
application to open another one. In most 
cases, applications close automatically 
when available memory is low, but you can 
also close applications manually.

TIP With the Start menu open, press the letter 
underlined in the application’s name to open 
the app. For example, press H to open Help. 
Or, select the shortcut icons at the top of the 
Start menu to open recently used 
applications.

In Programs, press a letter to jump to the first 
app that begins with that letter. For example, 
press C to jump to Calculator. Press C again to 
jump to Camera, and so on.

DID YOU KNOW? You can open apps by pressing 
and holding Option and then pressing Phone/

Send, Start, or OK. You can change which 
app a button combination opens; see 
Reassigning buttons for details.
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NOTE If you press OK  to leave an 
application, the current application 
continues to run in the background. 
Manually closing applications helps 
conserve battery power and frees up 
memory.

1 Press and hold OK  to open Memory 
Settings. 

2 On the Running Programs tab, do one 
of the following:

• Select the application you want to 
close, and then select Stop to close 
it. 

• Select Stop All to close all your open 
applications.

Using your Today 
screen

Your Today screen is your home base. From 
your Today screen you can quickly look up a 
contact, make a call, see your latest 
calendar appointments, see the number of 
unread email messages, and even perform 
a web search.

To access your Today screen, press 
Phone/Send . 

TIP If you press Phone/Send while a number 
is highlighted, your Treo 750 dials the number. 
If a number is highlighted, deselect the 
number, or use the Start menu to access the 
Today screen.

TIP You can also open the Today screen by 
pressing Power/End, unless you are on a call. 
If you’re on a call, pressing Power/End hangs 
up the call. If the Today screen is already 
displayed and you’re not on a call, pressing 
Power/End turns off the screen display.
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• Title bar and status info: See What are 
all those icons? to learn about the icons 
that appear in this area.

• Dial Lookup field: Type the number 
you want to call and press Center  
to dial, or begin typing a name to look 
up the associated number in Contacts. 
See Dialing by contact name for more 
info. 

• Web search field: Enter a web address 
or a keyword and press Center  or 
Return  to view a list of search 
results based on the address or word 
(data services connection required).

• Speed-dial entries: Select a speed-dial 
button—either a picture or text—to call 
the number assigned to it. See Defining 
speed-dial buttons to create your own.

Title bar and
status info

Dial Lookup field

Speed-dial
entries

Web search field

TIP You can select a picture for your Today 
screen background and select which items 
appear in the Today screen. See Today screen 
settings for details.
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Your phone
The phone, along with the Today screen, is your home base for 
making and receiving calls.

You can creatively manage multiple calls; for example, you can 
swap between calls, send text messages to ignored calls, and 
create conference calls. 

And you can do more than manage your phone calls. You can 
send text messages, open applications, go to your favorite web 
pages, see your upcoming appointments, and even find out 
how many unread email messages you have.

Benefits

• Stay in touch—you choose how

• Work in other applications when 
on an active call.

• Create speed-dial buttons with 
pictures of your friends
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Turning your Palm® 
Treo™ 750 smart 
device on/off

The term smart device (or device) refers to 
the device and its physical aspects. The 
term phone refers to the wireless feature 
of your Palm® Treo™ 750 smart device that 
enables you to connect to the Cingular 
network so that you can make and receive 
calls, and send and receive data.

The phone and the screen of your Treo 750 
can be turned off and on separately. This 
means you can wake up the screen to use 
just the organizer features of your device 
without turning on the phone. Also, when 
the screen is turned off the phone can be 
on and ready for you to receive phone calls 
or messages.

Turning your phone on

From the Today screen, press Menu  
(right action key), select Wireless 

Manager, and then select Phone. When 
your Treo 750 locates a signal, Cingular 
appears in the upper-left of the screen and 

the signal-strength  icon appears at the 
top of the screen. 

When you turn on your phone, it connects 
to a mobile network so that you can make 
and receive phone calls and use other 
wireless services (if supported by the local 
network). When you are inside a coverage 
area, the signal-strength  icon has bars 
in it. If you’re outside a coverage area, the 
indicator light flashes amber and no bars 
appear in the signal-strength icon.

Turning your phone off

From the Today screen, press Menu  
(right action key)), select Wireless 

Manager, and then select Phone. When 
your phone is off, the phone-off  icon 
appears at the top of the screen and Phone 
Off appears in the upper-left of the screen. 
Your phone is not connected to any mobile 
network. Although you can no longer use 

DID YOU KNOW? You can press and hold the 
Power/End button to turn your phone on and 
off.

DID YOU KNOW? You can go to Wireless 
Manager by tapping the signal-strength icon 
and tapping Wireless Manager.
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the phone, you can still use Microsoft 
Office apps and all the organizer features of 
your Treo 750.

Waking up the screen and turning it off

Wake up the screen and leave the phone 
turned off when you want to use only the 
organizer features of your Treo 750, for 
example, when you’re on a plane and want 
to look at your calendar. You can also turn 
off the screen without turning off the 
wireless features on your Treo 750. You can 
turn your screen on and off by pressing 
Power/End .

Making calls from the 
Today screen

Your Treo 750 offers several ways to make 
phone calls from the Today screen.

Dialing from the Today screen

1 Go to your Today screen.

2 Using the numbered keys on the 
keyboard, enter a phone number in the 
Dial Lookup field.

3 Press Phone/Send  to dial.

TIP You can set how long the screen stays on. 
Press Start, select Settings, select the 
System tab, and then select Power. Select 
the Advanced tab. Adjust the number of 
minutes the phone stays on when idle using 
the On battery power setting.

DID YOU KNOW? When you're dialing a phone 
number, you can enter * and # without first 
pressing Option. This makes it easy to 
respond to further dialing instructions.
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NOTE You do not need to press Option to 
access the numbers on the keyboard. 
However, when dialing short numbers, the 
number may conflict with a contact name. 
If this occurs, press Option  to avoid 
starting a contact lookup. For emergencies, 
you can always dial 911 without pressing 
Option first.

Dialing with a speed-dial button 

Your Treo 750 enables you to create both 
picture and text speed-dial buttons so that 
you can select a button on the Today 
screen to quickly dial a number.

BEFORE YOU BEGIN Create some 
speed-dial buttons. See Defining speed-dial 
buttons. You can customize the default 
speed-dial buttons. See Editing a 
speed-dial button.

You can make a call using your speed-dial 
buttons by doing any of the following: 

• Select a speed-dial button with the 
5-way, and then press Center .

• Tap a speed-dial button with the stylus. 

• Press and hold the Quick Key that you 
assigned to the speed-dial button.

• To dial an alternate number for a 
contact, highlight the speed-dial button 
and press and hold Center , or tap 
and hold the button, and then select a 
number from the shortcut menu.

To see more speed-dial buttons, highlight 
the picture speed-dial area and press Right 

 or Left  repeatedly, or highlight the text 
speed-dial area and press Up , Down , 
Right , or Left .

TIP If you press Phone/Send while a number 
is highlighted, your device dials the number. If 
a number is highlighted and you want to 
access the Today screen, deselect the 
number or use the Start menu.
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Dialing by contact name

You can look up contacts quickly by 
entering just a few letters of a contact’s 
name directly from your Today screen. 

BEFORE YOU BEGIN Before you can dial a 
number by contact name, you must create 
some contacts (see Adding a contact,) or 
import them by synchronizing (see Defining 
speed-dial buttons). 

Make sure your phone is on and that you’re 
inside a coverage area (see Turning your 
phone on).

1 Go to your Today screen. 

2 Using the keyboard, begin entering one 
of the following for the contact you 
want to call:

• First name (JOH for John)

• Last name (SMI for Smith)

• First initial, a space, and then last 
initial (J S for John Smith)

• First name and last name 
(JOH SMI for John Smith)

For example, entering SM finds both 
Smilla Anderson and John Smith. 
Entering SMA finds only Smilla 
Anderson.

To clear the Dial Lookup field and start 
another Contacts search, press OK. To 
delete letters when correcting a 
misspelled name, press Backspace.

TIP You can hide your speed-dial buttons on 
your Today Screen and still use your Quick 
Keys to call a speed-dial number. 
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3 Select the number you want to dial.

4 Press Phone/Send  or press 
Center  to dial.

Dialing using the onscreen Dial Pad

The onscreen Dial Pad is useful when you 
need to dial numbers that are expressed as 
letters and when you need large numbers 
that you can tap with your finger or the 
stylus. 

BEFORE YOU BEGIN Make sure your 
phone is on (see Turning your phone on).

1 Go to your Today screen. 

2 Press Phone/Send  and select 
Dial Pad.

3 Tap the onscreen Dial Pad to enter the 
number.

4 Press Phone/Send  to dial.

TIP To see a contact’s address, company, and 
other details, press Up to highlight the name 
and press Center on the 5-way.

DID YOU KNOW? After you look up a contact, 
you can select how you want to communicate 
with that person. Press and hold Center on 
the 5-way, or tap and hold, and then select the 
communication method you want to use.

DID YOU KNOW? You can paste numbers 
directly into the Dial Pad. Copy a number from 
another application, switch to Dial Pad, and 
then press and hold Center on the 5-way to 
paste the number.
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Redialing a recently called number

• To dial the last number you called: 

Go to your Today screen, and then press 
and hold Phone/Send .

• To select from your most recently 

dialed numbers: Go to your Today 
screen, press Phone/Send , 
highlight the number or contact name 
you want to call, and then press Phone/

Send  to dial.

• To select from a chronological list of 

calls: Go to your Today screen, press 
Phone/Send , and then select Call 

Log. Highlight the number you want to 
call, and then press Call  (left 
action key) to dial or press Phone/

Send .

Other ways of 
making calls

Your Treo 750 offers several other ways to 
make phone calls than from the Today 
screen. Try them all and you’ll discover 
which methods you prefer.

Dialing by company name

BEFORE YOU BEGIN Make sure your 
phone is on (see Turning your phone on).

1 Press Start  and select Contacts.

2 Press Menu  (right action key) 
and select View By > Company.

3 Press Phone/Send  to go to your 
Today screen.

4 Using the keyboard, begin entering the 
first few letters of the company name.

5 Select the number you want to dial.

TIP You can also access the Call Log and Dial 
Pad from the Today screen by pressing Menu 
(right action key). 
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6 Press Phone/Send  to dial.

Dialing from a web page or message

Your Treo 750 recognizes most phone 
numbers that appear in web pages or in 
messages (text, email, or multimedia). 

1 Use the 5-way to highlight the phone 
number you want to dial in the web 
page or message.

2 Press Center  to open the Phone 
dialog box, and then select Yes to dial.

Receiving calls

To receive calls, your phone must be on. 
This is different from having only the 
screen turned on (see Turning your phone 
on). When your phone is off, your calls go 
to voicemail.

To see a picture of the person calling you! 
Learn how to assign a caller ID picture in 
Assigning a caller ID ringtone.

If music is playing when a call arrives, the 
Treo 750 rings softly. You can answer the 
phone as you normally would. The audio 
pauses during your call.

To answer a call, do one of the following:

• Press Phone/Send .

• Press Answer  (left action key).

• If the headset is attached, press the 
headset button.

To ignore a call and send it to voicemail, 
press Menu  (right action key) and 
select Ignore or press the Power/End  
key.

TIP If you can’t dial a phone number directly 
from a web page or a message, then highlight 
the number, select Edit (right action key), and 
select Copy. Open the Dial Pad, and then 
press and hold Center on the 5-way to paste. 
Press Phone/Send to dial.
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To silence the ringer while your Treo 750 is 
ringing:

• Press the Volume button or any key on 
your Treo 750 except Phone/Send , 
Power/End , Alt , Start , OK 

, or the 5-way.

• To immediately silence all system 
sounds including the ringer, slide the 
ringer switch to Sound Mode Off . 
All sounds remain off until you slide the 
ringer switch back to Sound On .

When you silence the ringer, you can either 
answer the call or let it ring through to 
voicemail.

Using voicemail

Setting up voicemail.

1 Go to your Today screen.

2 Press and hold 1 on the keyboard or tap 
the Voicemail speed-dial button to dial 
the Cingular voicemail system.

3 Follow the voice prompts to set up your 
voicemail.

Retrieving voicemail messages from the 

Today screen

When you have unretrieved voicemail 
messages, a Voicemail icon  appears at 
the top of your screen.

DID YOU KNOW? You can also ignore a call and 
send a text message. Press Menu (right 
action key) and select Ignore with text 

message. 
DID YOU KNOW? When a Voicemail icon 
appears at the top of the screen, you can tap 
this icon to retrieve your voicemail.
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1 Go to your Today screen.

2 Press 1 on the keyboard to dial the 
Cingular voicemail system. 

3 Enter your voicemail password using 
the keyboard, or press Extra Digits 

 (left action key) if you defined 
this option (see Creating a speed-dial 
button for details).

4 Select Play  to listen to your 
messages.

Retrieving messages from a voicemail 

notification

NOTE Not all service plans support 
voicemail notification. Check with Cingular 
for more information.

You can retrieve voicemail messages when 
you receive a notification or you can 
dismiss the notification and retrieve the 
messages later.

• When you have a new voicemail 
message, a notification screen appears.

• To hear your message now, press 
Listen  (left action key). 

• To retrieve your message later, press 
Dismiss  (right action key). 

What can I do during 
a call?

Your Treo 750 offers many advanced 
telephone features, including call waiting, 
six-way conferencing, and call forwarding. 
These features depend on your service 
plan. Please contact Cingular for more 
information.

When you make or receive a call, the active 
call info appears on your Today screen.
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During a call, you can do any of the 
following:

• Navigate around the Today screen: 

Use Up  and Down  to move 
around or highlight items.

• Put the call on hold: Press Hold  
(left action key). To take the call off hold, 
press Off Hold  (left action key).

• Use the built-in speakerphone: Press 
Menu  (right action key) and 
select Speakerphone. To use the 
earpiece again, press Menu  
(right action key) again and select 
Speakerphone Off.

• Mute the microphone so you can’t be 

heard: Press Menu  (right action 
key)) and select Mute. To turn the 
microphone back on, press Menu 

 (right action key) again and select 
Cancel Mute.

• Switch to another application: Press 
Start  and select the application.

Ending a call

Do one of the following:

• Press Power/End .

• Press the headset button (if the headset 
is attached and has a button on it). 
Some headsets do not have a button.

Current duration 
of call

Caller’s name 
and number

DID YOU KNOW? You can send and receive text 
messages during a call. This is a great way to 
stay connected with colleagues during a long 
call.

DID YOU KNOW? When a call lasts longer than 
one minute, the screen dims. After two 
minutes, it dims more. Press any key, except 
Power/End, to light up the screen.
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Switching applications during an active 

call 

You can use many other applications on 
your Treo 750 while holding a phone 
conversation, including the organizer and 
text message features. You cannot, 
however, make some data connections 
during an active call while connected to a 
GPRS network. If you’re connected to a 
GPRS network, you cannot browse the 
web, or send and receive email or MMS 
messages while on a voice call. If you’re 
connected to a UMTS network, you can 
perform simultaneous voice and data 
functions. How can you tell which kind of 
network you’re connected to? See What 
are all those icons?

To open an application, see Opening and 
closing applications.

From any application, press Phone/Send 
 to return to your Today screen.

Saving phone numbers

After you hang up, you can add the number 
to Contacts if it's not already in your list. If 
an incoming call uses caller ID blocking, 
you do not see the Add Contact prompt.

• To create a new contact for this number, 
select Create New Contact.

• To add this number to an existing 
contact, select Copy and Add, and 
then select a contact name.

• To decline adding the number, press 
Dismiss  (left action key).

• To permanently disable the Add Contact 
prompt, select Don’t show this again.

TIP You can also save contact info from other 
applications, such as Messaging.
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If you don’t add a number right away, follow 
these steps to add it later: 

1 Go to the Call Log (see Other ways of 
making calls). 

2 Highlight the number you want to save. 

3 Press and hold Center  to open the 
shortcut menu, and then select Save to 

Contacts.

4 Enter the information for the entry.

5 Press OK .

Making a second call 

You can make a second call while your first 
call is still active:

1 Place your first call on hold by pressing 
Hold  (left action key).

 

2 Dial a second number using any of the 
methods described in Making calls from 
the Today screen. If you’re dialing by 
contact name or with the keyboard, you 
must first use the 5-way to select the 
Dial Lookup field.

When two calls are active, your Today 
screen includes two call status sections, 
each representing one of the calls. 

Answering a second call (call waiting)

When you’re on a call and you receive a 
second call, the call waiting notification 
appears if you have chosen to be notified 
(see Setting call waiting notification). You 
can do any of the following:

• Send the new call to voicemail: Press 
Menu  (right action key) and 
select Ignore.

• Send the new caller a text message: 

Press Menu  (right action key) 
and select Ignore with text message. 
The second call is sent to voicemail. A 
new text message opens with the 
phone number of the caller entered in 
the To field.
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• Hang up the current call and answer 

the new call: Press Menu  (right 
action key)) and select Drop and 

Answer. You can also press Power/End 
 to hang up the current call, and 

then choose to answer or ignore the 
new call.

• Place the current call on hold and 
answer the new call: 
Press Answer  (left action key) or 
Phone/Send . Once you have 
answered the call:

• Press Swap  (left action key) to 
move between callers by placing the 
current active call on hold and talking 
on the other line. 

• Make the calls a conference call. See 
Making a conference call.

Making a conference call

IMPORTANT You can join up to five calls 
into a 6-way conference call. The number 
of calls you can join in conference depends 
on your service plan. Additional charges 
may apply, and minutes in your mobile 
account may be deducted for each call. 
Please contact Cingular for more 
information.

1 Answer a second call or put the first call 
on hold, and make a second call.

2 Press Conference  (right action 
key); this joins the two calls with you in 
a conference.
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3 (Optional) Do one or more of the 
following:

• Make more calls and join them into 
the conference call. The number of 
calls you can join in conference 
depends on your service plan. 

• Extract a caller from the conference 
call to talk with them privately by 
pressing Menu  (right action 
key), selecting Extract, and then 
selecting the name. The extracted call 
becomes the active call.

 

• Swap between the conference call 
and the private call by pressing Swap 

 (left action key).

4 When you’re done, press Power/End 
 twice to hang up on all calls or 

press Power/End  once to hang up 
on the active call.

Forwarding calls

You can forward calls to another phone 
number. Please check with Cingular about 
availability and pricing of forwarded calls; 
additional charges may apply.

When all calls are forwarded, the call 
forwarding icon  appears in the title bar.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key), 
select Preferences, and then select 
Phone Settings. 

3 Select the Services tab, and then select 
Call Forwarding from the list.
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4 Set your call forwarding settings. Some 
of the settings are already set by 
Cingular to send your calls to Voicemail.

5 Press OK .

Defining speed-dial 
buttons

Your Treo 750 enables you to create both 
picture and text speed-dial buttons so that 
you can select a button on the Today 
screen to quickly dial a number. 

Creating a speed-dial button

You can create up to 20 picture buttons and 
50 text buttons. 

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select New Speed Dial. 

3 Do one of the following:

• Select Link to contact, select the 
contact you want to link to this button, 
and then select the number you want 
to dial with this button.

• Select Label and enter a name for this 
button, and then select Number and 
enter the phone number you want to 
dial with this button.
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4 (Optional) Enter a Quick Key. When the 
Today screen is showing, you can press 
and hold the Quick Key to instantly dial 
this number.

Quick Keys can be letters or numbers, 
but you can’t use both the letter and 
number on the same key. For example, 
the voicemail Quick Key is 1. The letter 
equivalent for that key is E, so you 
cannot assign E as a Quick Key to 
another speed-dial button.

5 If this button is linked to a contact entry 
with a picture, select either Text Speed 

Dial or Picture Speed Dial to indicate 
which type of button you want to 
create. If this button is not linked to a 
contact or the contact doesn’t have a 
picture, the Picture Speed Dial option is 
not available.

6 (Optional) Select the Advanced tab and 
set any of the following options:

Extra Digits: Defines additional 
numbers to dial, such as a password or 

extension. In addition to numbers, you 
can enter the following symbols: star 
(*) and pound (#). To enter a one- 
second pause, enter a comma (,). 

Dial extra digits automatically: Dials 
predefined Extra Digits immediately 
after dialing the phone number. If you 
do not check this box, you need to press 
Extra Digits  (left action key) to 
dial these digits.

Show voice mail buttons: Displays the 
voicemail playback controls after you 
dial this speed-dial number. When this 
option is checked, you can enter 
numbers below each control to tailor 
the controls to your voicemail system.

 Plays the previous message.

TIP You can add a special ringtone to a contact 
associated with the speed-dial button. See 
Adding a contact.
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 Saves the current message.

 Plays the current message.

 Deletes the current message.

 Repeats the current message.

 Plays the next message.

7 Press OK . 

Editing a speed-dial button

1 Go to your Today screen.

2 Highlight the speed-dial button you 
want to edit.

3 Press and hold Center  to open the 
shortcut menu, and then select Edit 

Speed Dial. 

4 Make the desired changes.

5 Press OK . 

Deleting a speed-dial button

1 Go to your Today screen.

2 Highlight the speed-dial button you 
want to delete.

3 Press and hold Center  to open the 
shortcut menu, and then select Edit 

Speed Dial. 

4 Press Delete  (right action key).

5 Select Yes to confirm the deletion.

Arranging your speed-dial buttons

1 Go to your Today screen.

2 Press Menu  (right action key) 
and select Speed Dial Options.

3 Highlight the button you want to move.

4 Press Option  + Left  or Right  or 
Up  or Down  to move the button 
in that direction.

DID YOU KNOW? The playback controls for the 
Cingular Voicemail speed-dial button are 
already set up.

TIP You can also edit a speed-dial button by 
pressing Menu and selecting Speed Dial 

Options, and then selecting the button you 
want to edit.
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Using a phone 
headset

You can connect a phone headset for 
hands-free operation. You can use the 
headset that came with your Treo 750 or 
compatible third-party headsets.

IMPORTANT If driving while using a Treo 
750 is permitted where you are and you 
need to make a call, we recommend using 
a phone headset or a hands-free car kit 
(sold separately). If you must use the wired 
headset while driving, place a speaker in 
only one ear. Leave the other ear free to 
hear outside noises. Make such a call only 
if it is legal to do so and you can do so 
safely.

Using a wired headset

Microphone

Speakers

Headset button
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The headset button is context-sensitive, 
and it performs various actions based on 
the situation. You can press the headset 
button to perform any of the following 
tasks:

• Answer an incoming call

• Respond to call waiting

• Hang up all calls

• Swap between calls 

NOTE Your Treo 750 works with headsets 
that have a 2.5mm, 3-pin connector (look 
for two colored bands on the plug). When 
in doubt, ask the third-party headset 
manufacturer if the product is compatible 
with your Treo 750. If you hear a headset 
buzz or poor microphone performance, 
your headset may be incompatible with 
your Treo 750.

Connecting to a Bluetooth® hands-free 

device

Your Treo 750 is also compatible with many 
headsets and car kits (sold separately) 
enabled with Bluetooth® wireless 
technology version 1.1 or 1.2. 

For a list of compatible hands-free devices 
with Bluetooth wireless technology, go to 
www.palm.com/us/support/treo/
treo750cingular.

After you set up a connection with a 
Bluetooth headset or hands-free car kit, 
you can communicate with that device 
whenever it is within range and the 
Bluetooth feature on your Treo 750 is 
turned on. The range varies greatly, 
depending on environmental factors; the 
maximum is about 30 feet (10 meters).

1 If necessary, prepare the device you 
want to connect with to accept a new 
connection. Check the device’s 
documentation for details; be sure to 
find out if the device has a predefined 
passkey that you need to enter on your 
Treo 750 in step 7.

DID YOU KNOW? If you have both a compatible 
Bluetooth headset and car kit, the one you 
connected to your Treo 750 last becomes the 
active device.
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2 Go to your Today screen, and then tap 
Bluetooth .

3 Check the Turn on Bluetooth box to 
turn on the Bluetooth feature.

4 Select the Devices tab, and then select 
New Partnership.

5 Wait for your Treo 750 to search for 
devices and to display the device list.

6 Select the device you want to connect 
to, and then press Next  (right 
action key).

7 Enter a passkey between 1 and 16 
digits long, and then press Next  
(right action key).

IMPORTANT Some hands-free devices 
have a predefined passkey; if your 
hands-free device has one, you can find 
the passkey in the documentation for that 
device. Other devices provide a screen 
where you enter a passkey that you make 
up. In either case, you must use the same 
passkey on both your Treo 750 and your 
hands-free device. We recommend that 
you use a passkey of 16 digits, where 
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possible, to improve the security of your 
Treo 750. The longer the passkey, the 
more difficult it is for the passkey to be 
deciphered.

8 If the passkey is not predefined, enter 
the same passkey on the other 
Bluetooth device, and then press Finish 

 (right action key).

9 Check the Hands Free box, and then 
press Finish  (right action key). 

10 Press OK .

You can now communicate with this device 
whenever it is within range and the 
Bluetooth feature on your Treo 750 is 
turned on. The range varies greatly, 
depending on environmental factors; the 
maximum is about 30 feet (10 meters).

Using a Bluetooth hands-free device

To learn how to set up and connect to 
Bluetooth devices, see Connecting to a 
Bluetooth® hands-free device. 

Here are tips for working with a Bluetooth 
hands-free device:

• To transfer a call from the handset to a 
Bluetooth hands-free device during a 
call, press Menu  (right action 
key) and select Connect Bluetooth. To 
transfer the call back to the headset, 
press Menu  (right action key) 
and select Cancel Bluetooth.

• To transfer a call from a wired headset 
to a Bluetooth headset or car kit that is 
within range and with which you’ve 
previously set up a partnership 
(Bluetooth headset or car kit required, 
sold separately), unplug the wired 
headset and press the button on the 
Bluetooth headset or car kit. 

• To find out how to transfer your 
contacts from your Treo 750 to your car 
kit, go to www.palm.com/us/support/
treo/treo750cingular.

DID YOU KNOW? The Bluetooth icon on your 
Today screen indicates the status of the 
Bluetooth feature: 

Gray = Bluetooth off.

Blue = Bluetooth on.

White = Connected to a Bluetooth device.

Headset icon = Call in progress with a 
Bluetooth headset or car kit.



Y O U R  P H O N E

C U S T O M I Z I N G  P H O N E  S E T T I N G S54

3
C

H
A

P
T

E
R

Customizing phone 
settings

Selecting ringtones and display notices

You can set different tones for different 
types of incoming phone calls and 
notifications. You can download MP3, 
MIDI, AMR, WAV, and WMA ringtones 
directly to your Treo 750 (see Downloading 
files and images from a web page). You can 
also download ringtones to your computer 
and then email them to your phone.

1 Press Start  and select Settings.

2 On the Personal tab, select Sounds & 

Notifications .

3 Select the Notifications tab.

4 Select the Event, and then select which 
type of call or notification you want to 
set the ringtone for:

Phone: Known Caller: An incoming call 
from someone in your Contacts list or 
Speed Dial list.

Phone: Missed call: A call you did not 
answer.

Phone: Roaming: A call that comes in 
when you’re outside your home mobile 
network.

Phone: Unknown Caller: An incoming 
call from someone identified by caller 
ID who is not in your Contacts list or 
Speed Dial list. 

Phone: Voice mail: A new voicemail.

DID YOU KNOW? If you’re using a Bluetooth 
hands-free device and it is within range, your 
Treo 750 routes all calls to the hands-free 
device instead of to the earpiece on your Treo 
750. Bluetooth range is up to 30 feet (10 
meters) in optimum environmental conditions. 
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5 Check the Play Sound box if you want 
to have a sound played when the event 
occurs. 

6 If you checked the Play Sound box, 
then select the sound for the selected 
type of call. You can also check the 
Repeat box to have the sound repeat.

7 (Optional) Select the Play icon to 
preview the sound.

8 Check the Display message on screen 
box to have a message displayed when 
the event occurs.

9 Check the Vibrate when… boxes to 
turn the vibrate feature on/off based on 
the ringer switch setting.

10 Repeat steps 4–9 to select ringtones for 
other types of calls. 

11 Press OK .

Adjusting call and ringer volume.

• Call volume: While a call is in progress, 
press the Volume button (on the side of 
your Treo 750) to adjust the call volume. 

• Ringer volume: When a call is not in 
progress and you are not playing music 
or a video, press the Volume button to 
adjust ringer volume.

Assigning a caller ID ringtone

1 Press Start  and select Contacts.

2 Select the contact’s name.

3 Press Menu  (right action key) 
and select Edit.

DID YOU KNOW? You can record, preview, 
delete, and send sounds on your Treo 750. 
See Selecting Sounds & Notifications. You can 
also set sounds for messaging notifications 
and calendar reminders. See Selecting 
ringtones and display notices.

Volume button
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4 Select Ring tone.

5 Select a tone for this contact entry.

6 Select OK.

Enabling TTY

You can enable your Treo 750 for use with a 
TTY/TDD device. A TTY (also known as a 
TDD or Text Telephone) is a 
telecommunications device that enables 
people who are deaf or hard of hearing, or 
who have speech or language disabilities, 
to communicate by telephone.

Your Treo 750 is compatible with select 
TTY devices. You can connect a TTY/TDD 
machine, headset, or hands-free kit to your 
Treo 750 through the headset jack while in 
TTY/TDD mode. Please check with the 
manufacturer of your TTY device for 
connectivity information. Be sure that the 
TTY device supports digital wireless 
transmission.

BEFORE YOU BEGIN Turn on your phone 
to access your Phone Settings. See Turning 
your phone on..

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 On the Phone tab, select TTY/TDD, 
and then select either On or Off.

4 Press OK .

NOTE When TTY/TDD is on, a TTY/TDD 
icon  appears at the top of the Today 
screen.

Adding Contacts numbers from new 

callers

You are prompted to add contact entries for 
numbers that are not already in your 
Contacts list.

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .
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3 On the Phone tab, check the After calls 

from numbers that are not in 

Contacts, ask if I want to add them 

box.

4 Press OK .

Blocking calls

You can block incoming or outgoing calls.

BEFORE YOU BEGIN You need to do the 
following:

• Make sure that call barring is supported 
by your service plan. Check with 
Cingular for more information.

• Get a call barring password from 
Cingular.

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key), 
select Preferences, and then select 
Phone Settings.

3 Select the Services tab, and then select 
Call Barring from the list.

4 Select the Block incoming calls list, 
and then select one of the options:

Off: No incoming calls are blocked.

When roaming: All incoming calls are 
blocked when roaming.

All calls: All incoming calls are blocked.

5 Select the Block outgoing calls list, 
and then select one of the options:

Off: No outgoing calls are blocked.

International: All outgoing international 
calls are blocked.

International except to home 

country: All outgoing international calls 
are blocked except to the country 
where the phone is based.
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All calls: All outgoing calls are blocked.

6 Press OK .

7 Enter the call barring password and 
select Done  (right action key).

Setting caller ID

You can turn caller ID on or off.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key), 
select Preferences, and then select 
Phone Settings. 

3 Select the Services tab, and then select 
Caller ID from the list.

4 Check the appropriate box to provide 
your caller ID to Everyone or No one.

5 Press OK .

Setting call waiting notification

You can choose to be notified when you 
receive a call while you are on a call. You 
can choose to accept the call or not. See 
Answering a second call (call waiting).

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).
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1 Go to your Today screen.

2 Press Menu  (right action key), 
select Preferences, and then select 
Phone Settings. 

3 Select the Services tab, and then select 
Call Waiting from the list.

4 Check the appropriate box to receive 
notification or not.

5 Press OK .

Manually selecting your wireless band

The wireless band setting is preset for 
optimum performance. Do not change this 
setting unless instructed to do so by a 
Cingular representative.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key), 
select Preferences, and then select 
Phone Settings.

3 Select the Services tab, and then select 
Band Selection from the list.

4 Select the Select network type list, 
and and select one of the following:

Auto: Automatically selects a network.

GSM: Connects only to GSM networks.

UMTS: Connects only to UMTS 
networks.

5 Select the Select your GSM/UMTS 

Band list, and then select one of the 
bands:

Auto

GSM (900+1800) + UMTS 2100

GSM (1900+850) + UMTS (1900+ 850)

6 Press OK .
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Enabling fixed dialing

Fixed dialing allows you to restrict your 
outgoing calls and messages to selected 
phone numbers, included in your fixed 
dialing list. Once the service is activated, 
you can call and send messages only to the 
phone numbers from the list.

The list is protected by a PIN2. If you enter 
an incorrect PIN2 more times than allowed 
by Cingular, the SIM card locks. Once the 
SIM card locks, you need the PUK2 to 
unlock the SIM card. Contact Cingular for 
more information and the PUK2.

BEFORE YOU BEGIN You need the 
following:

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your phone on).

• Get your PIN2 from Cingular

1 Go to your Today screen.

2 Press Menu  (right action key), 
select Preferences, and then select 
Phone Settings. 

3 Select the Services tab, and then select 
Fixed Dialing from the list.

4 Check the Enable fixed dialing box.

5 Press Menu  (right action key) to 
add, delete, or edit the phone numbers 
in the list.

6 Enter your PIN2 and press Done  
(left action key).

7 Press OK .

Manually selecting your network settings

The network setting is preset for optimum 
performance. Do not change this setting 



Y O U R  P H O N E

W H A T  A R E  A L L  T H O S E  I C O N S ? 61

3

C
H

A
P

T
E

R

unless instructed to do so by a Cingular 
representative.

BEFORE YOU BEGIN Make sure your 
phone is on and that you’re inside a 
coverage area (see Turning your phone on).

1 Go to your Today screen.

2 Press Menu  (right action key), 
select Preferences, and then select 
Phone Settings. 

3 Select the Network tab.

4 To switch to another network, select 
Find Network and select an available 
network.

5 To change your preferred network, 
select Set Networks, check the box 

next to the networks you want, and 
then select your order of preference.

6 From the Network Selection list, select 
an option:

Automatic: The network connection is 
automatically made.

Manual: Network connections are 
manually made. If you are manually 
selecting a network, select a network 
from the list of available networks.

7 Press OK .

What are all those 
icons?

You can monitor the status of several items 
using icons at the top of your Today screen:

You missed an incoming call.

You have a voicemail message.

You have a new email message.
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You have a new text, or 
multimedia message.

No SIM inserted in device or 
software unable to recognize 
SIM.

You have more than one of the 
conditions listed above.

Your phone is on. The bars 
display the signal strength. 
The stronger the signal, the 
more bars appear. If you are 
outside a coverage area, no bars 
appear.

Your phone is off.

A voice call is in progress.

TTY/TDD is turned on.

All calls are being forwarded.

Your phone is connected to a 
UMTS network, but you are not 
actively transmitting data. You 
can still make or receive calls.

Your phone is on and a UMTS 
data connection is active. You 
can make and receive calls and 
transmit data simultaneously.

Your phone is connected to a 
GPRS (EDGE if available) 
network, but you are not actively 
transmitting data. You can still 
make or receive calls.

Your phone is on and a GPRS 
(EDGE if available) data 
connection is active. You can still 
make or receive calls, but the 
data transmission is 
automatically interrupted during 
a call.

ActiveSync synchronization is in 
progress.

Your Treo 750 is connecting to a 
computer or network.

A data connection is not available 
or your phone is off.

Your smart device’s battery is 
low.
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Your smart device’s battery is 
charging.

Your smart device is connected 
to a power outlet and the battery 
is fully charged.

Network 
operator 
name

Your phone is on. When you turn 
off your phone, Phone Off 
appears instead.

The Bluetooth® wireless 
technology status indicator 
appears in gray when this feature 
is off, in blue when this feature is 
on, and in reverse blue when 
your smart device 
is communicating with another 
Bluetooth device. 

A call is in progress and your 
smart device is connected to a 
Bluetooth headset or car kit. 
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CHAPTER

4

Synchronizing information
Synchronizing simply means that information that has been 
entered or updated in one place—your Palm® Treo™ 750, smart 
device your computer, or your corporate server—is automatically 
updated in the other. There’s no need to enter information twice. 
Some kinds of synchronization can happen on an automated 
schedule, so you don’t even have to think about it.

After you get into the habit of synchronizing regularly, you’ll 
know what a powerful tool synchronization is for transferring, 
updating, and backing up large amounts of information on your 
Treo 750.

Benefits

• Quickly enter and update 
information on your computer and 
your Treo 750

• Protect your information

• Send photos and videos to your 
Treo 750 from your desktop 
computer
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This chapter discusses using ActiveSync® 
desktop software and other methods to 
synchronize your Treo 750 and your 
computer.

Synchronization enables you to enter or 
change information on your Treo 750 or in 
Microsoft Office Outlook®. Your info is then 
automatically updated in both places; 
there’s no need to enter the info twice. 
This is true whether you sync with your 
computer using ActiveSync desktop 
software (see Setting up your computer for 
synchronization) or wirelessly with your 
company’s Exchange Server using 
Microsoft Exchange ActiveSync (see 
Setting up wireless synchronization).

By default, the info from the following 
applications is synchronized for either 
method of synchronization:

You can, however, customize sync settings 
to suit your needs and sync only some of 
these applications. 

If you set up ActiveSync synchronization 
with your computer, information in the 
Favorites application is synchronized by 
default as well. You can also change 
settings to synchronize Word, Excel, 
PowerPoint, and PDF files, as well as 
pictures, music, videos, and other types of 
files (see Changing which applications 
sync). For synchronization of music and 
videos, you also must have Windows 
Media® Player 10 on your computer.

You can set up your Treo 750 to use any 
combination of wireless sync, ActiveSync 
synchronization, and Windows Media 
Player sync.

DID YOU KNOW? When you sync Favorites, it 
creates a folder in your computer’s web 
browser called Mobile Favorites that backs up 
any favorites you create in the browser on 
your Treo 750. You can add or remove 
favorites directly to or from the folder.

TIP If you don’t already have Windows Media 
Player installed on your computer, you can 
install it from the Windows Mobile Getting 
Started Disc. Insert the CD into your 
computer’s CD drive, select Add Programs, 
and then select Windows Media Player.
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How do I 
synchronize?

There are a number of ways to make 
synchronization occur. You can install 
ActiveSync desktop software on your 
computer to synchronize in one of a 
number of ways, or you may be able to 
synchronize wirelessly with an Exchange 
Server. You can, of course, choose to sync 
both with an Exchange Server and with 
ActiveSync desktop software to maximize 
your sync options.

Synchronizing with ActiveSync desktop 

software

BEFORE YOU BEGIN Install the software 
from the Windows Mobile Getting Started 
Disc, which came with your Treo 750. You 
must install this software even if you have 
already installed a previous version of 
ActiveSync desktop software. 
See Installing the desktop synchronization 
software for instructions. 

If you install ActiveSync desktop software 
from the Windows Mobile Getting Started 
Disc, you can choose to synchronize in any 
of the following ways:

• By connecting your Treo 750 to your 
computer using the sync cable; see 
Synchronizing using the sync cable

• Wirelessly, using the built-in Bluetooth® 
wireless technology on your Treo 750; 
see Synchronizing over a Bluetooth 
connection

• Wirelessly, using the infrared (IR) port 
on your Treo 750; see Synchronizing 
over an infrared connection

Synchronizing wirelessly with the server

You can set up your Treo 750 to 
synchronize email and other information 
wirelessly with Microsoft Exchange Server 
2003 using Microsoft Exchange 
ActiveSync; see Setting up wireless 
synchronization. If you choose this method, 
synchronization takes place automatically 
after setup; you do not need to install the 
software from the Windows Mobile 
Getting Started Disc, which came with your 
Treo 750.
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NOTE We recommend that you install 
ActiveSync desktop software from the CD 
even if you synchronize wirelessly with the 
server. You need ActiveSync to synchronize 
pictures, videos, music files, and other info 
directly with your computer.

What can I 
synchronize?

This table lists the types of info you can 
synchronize and the methods to use.

Info type Method Where to learn more

Outlook Contacts, 
Calendar, Tasks

ActiveSync (sync with 
computer) or Exchange 
ActiveSync (direct sync 
with server)

Setting up your computer for 
synchronization or 

Setting up wireless synchronization

Outlook Email ActiveSync or Exchange 
ActiveSync

Setting up your computer for 
synchronization or 

Setting up wireless synchronization

Word, Excel, 
PowerPoint, PDF 
files

ActiveSync Setting up your computer for 
synchronization

Changing which applications sync

Music and video 
files

ActiveSync and Windows 
Media Player 10

Setting up your computer for 
synchronization

Changing which applications sync

Transferring media files to your Treo 
750



S Y N C H R O N I Z I N G  I N F O R M A T I O N

S E T T I N G  U P  Y O U R  C O M P U T E R  F O R  S Y N C H R O N I Z A T I O N70

4
C

H
A

P
T

E
R

Setting up your 
computer for 
synchronization

Why set up a connection between your 
Treo 750 and your computer? So you can 
synchronize them. Why synchronize? Here 
are two good reasons:

• Once you enter info on your computer, 
you don’t need to enter it again on your 
Treo 750. Whether you enter or change 

information on your computer using 
Microsoft Office Outlook or on your Treo 
750, when you synchronize, you 
automatically update the info in both 
places. 

• You have a backup copy of all your info. 
Should anything happen to your Treo 
750, your info still exists on your 
computer. 

We strongly recommend that you 
synchronize your Treo 750 with your 
computer frequently to keep your 
information up-to-date (and backed up) in 
both locations.

Pictures ActiveSync Setting up your computer for 
synchronization

Changing which applications sync

Outlook Notes ActiveSync Setting up your computer for 
synchronization

Changing which applications sync

Files to be 
transferred to an 
expansion card

ActiveSync Setting up your computer for 
synchronization

Changing which applications sync

Info type Method Where to learn more
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Before you can synchronize, you need to 
install the desktop synchronization 
software and connect the sync cable to 
your computer. Even if you have already 
installed a previous version of ActiveSync 
desktop software, you must install the 
software that came with your Treo 750 on 
the Windows Mobile Getting Started Disc.

System requirements

Your computer must meet the following 
minimum system requirements:

• Windows 2000 or XP (later versions 
may also be supported)

• 32MB of available memory (RAM)

• 170MB of free hard disk space

• CD drive

• Available USB port

Installing the desktop synchronization 

software

BEFORE YOU BEGIN If you are installing 
the software on a computer at work, make 
sure your company allows you to install 
new software. Contact your company’s 
IT department for help.

1 Close any applications that are currently 
running on your computer, including 
those running in the background. Your 
computer needs to have all its 
resources available to install the 
software.

2 Insert the Windows Mobile Getting 
Started Disc into the CD drive on your 
computer.

3 Follow the installation instructions on 
your computer.

During installation, you connect your 
Treo 750 to your computer and sync for 
the first time. Be sure to watch what’s 
happening on both your computer and 
your Treo 750. For more info, see 
Connecting your Treo 750 to your 
computer and Synchronizing 
information.

TIP If you want to synchronize with a personal 
information manager (PIM) other than 
Microsoft Office Outlook, you must install a 
third-party solution. Contact the PIM’s vendor 
to learn if software is available for your Treo 
750.
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Using ActiveSync desktop software

After you install ActiveSync desktop 
software, synchronization happens 
automatically anytime you connect your 
Treo 750 to your computer, as described in 
the next section. However, you can open 
the ActiveSync window on your computer 
to do tasks such as the following:

• Install applications from your computer 
to your Treo 750 (see Installing 
applications from your computer) or to 
an expansion card inserted into the 
expansion card slot on your Treo 750 
(see Installing applications onto an 
expansion card)

• Change which applications synchronize 

• Enter settings to synchronize wirelessly 
with Microsoft Exchange Server 2003

To open the ActiveSync window, 
double-click the ActiveSync icon  in the 
taskbar in the lower-right corner of your 
computer screen.

Desktop software installation also creates 
a Mobile Device folder on your computer, 
which you can see when you open My 
Computer or Windows Explorer. When 

DID YOU KNOW? During software installation, 
you can select an option to synchronize email, 
contacts, calendar events, and tasks directly 
with Microsoft Exchange Server 2003. If you 
choose this option, you are prompted to enter 
your mail server address and domain name 
and your Exchange Server account username 
and password.

TIP You can also install additional software 
from the Windows Mobile Getting Started 
Disc; see Installing bonus software from the 
CD.

DID YOU KNOW? You can also change which 
applications synchronize (see Changing which 
applications sync) and enter settings to 
synchronize wirelessly (see Setting up 
wireless synchronization) in the ActiveSync 
app on your Treo 750. Whether you enter 
changes on your Treo 750 or your computer, 
the changes are transferred to the other 
location the next time you synchronize.

TIP If the ActiveSync icon does not appear in 
the taskbar, go to Start, navigate to 
Programs, and select Microsoft ActiveSync 
to open the ActiveSync window.
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your Treo 750 is connected to your 
computer, opening the Mobile Device 
folder displays an icon representing your 
Treo 750. It also displays folders containing 
items you synchronized, such as music 
files, pictures, and videos. 

Connecting your Treo 750 to your 

computer

NOTE If you’re transferring info from a 
previous Windows Mobile® device or from 
a Palm OS® device, you can learn more 
about how to move content, such as 
pictures, music, and files, to your Treo 750 
by going to www.palm.com/us/support/
treo/treo750cingular.

1 Plug the AC charger into a wall outlet.

2 Plug the USB sync cable into an 
available USB port or into a powered 
USB hub on your computer.

3 Connect the sync cable to your Treo 750 
by inserting it into the two sockets to 
the left on the bottom of the Treo 750.

4 Connect the charger cable to the 
remaining socket on the bottom of your 
Treo 750.

TIP For best performance, plug your sync 
cable directly into a USB port on your 
computer. If your computer has USB ports on 
both the front and back, we suggest using the 
back port. If you use a USB hub, make sure it’s 
a powered hub.

DID YOU KNOW? The AC charger contains an 
indicator light that glows when the charger is 
connected to a power source.
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USB sync
cable

This button has no 
function with your 
Treo 750
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Synchronizing using 
the sync cable

After you install ActiveSync desktop 
software, synchronization takes place 
automatically anytime your Treo 750 is 
connected to your computer and info is 
updated in either location.

1 Connect your Treo 750 to your 
computer. You should hear the 
ActiveSync® tone.

2 Look for the ActiveSync icon  at the 
top of your Treo 750 screen and the 
ActiveSync icon  in the taskbar on 
your computer.

• If you don’t see the ActiveSync icon, 
make sure the desktop 
synchronization software that came 
with your Treo 750 is running on your 
computer. 

• If you have any problems 
synchronizing, see Synchronization for 
troubleshooting suggestions.

Setting up wireless 
synchronization

Does your company use Microsoft Outlook 
as its email solution? Does your company 
also use Microsoft Exchange Server 2003 

This button has no 
function with your 
Treo 750

TIP We recommend that you install the backup 
and restore app from the Windows Mobile 
Getting Started Disc. A backup and restore 
app preserves your data and settings if your 
Treo 750 is ever lost or stolen, and it protects 
your data during a hard reset.
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as its email server? If so, you may be able 
to wirelessly synchronize the email and 
other Outlook info on your Treo 750 and the 
same info stored on the Exchange Server 
using Microsoft Exchange ActiveSync. 

When the Exchange Server is upgraded to 
Service Pack 2, you may be able to take 
advantage of the additional features of 
Direct Push Technology. Direct Push 
Technology is a two-way wireless delivery 
method that keeps your Outlook 
information always up-to-date and provides 
more efficient communication between the 
server and your Treo 750. It includes 
features like Global Address List, Tasks 
Over The Air (OTA), and IP-based push 
updating of Calendar, Messaging, and 
Email.

To synchronize wirelessly, you need to set 
up an Exchange Server Account. Work with 
your system administrator to gather the 
following info, and then follow the steps in 
this section to set up an account.

• Mail server address and domain name

• The username and password you use to 
access your corporate mail server

• Security connection: Does your server 
use an encrypted (SSL) connection?

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right action key) 
and select Add Server Source. 

DID YOU KNOW? Because your desktop copy of 
Outlook also syncs with the server, whatever 
is synchronized to the server from your Treo 
750 also shows up in Outlook; and whatever 
you enter or change in Outlook on your 
computer syncs to the server and then shows 
up on your Treo 750.

TIP If you installed ActiveSync desktop 
software, you may have already set up your 
Treo 750 to synchronize wirelessly with the 
server. To check, press Start, select 
Programs, and select ActiveSync. Press 
Menu (right action key). If Configure Server 
appears instead of Add Server Source, 
wireless sync is already set up, and you can 
skip this procedure.
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4 Enter the server address, and then 
press Next  (right action key).

5 Enter the username and password you 
use to access your corporate mail 
server, and enter the Exchange Server 
domain. Check the box if your server 
uses an encrypted connection.

You can’t see your password as you 
enter it, so be careful. Be sure Caps 
Lock and Option Lock are not on unless 
you need them. For info on how to enter 
characters, see Entering lowercase and 
uppercase letters and Entering 
numbers, punctuation, and symbols.

6 Check the Save password box.

7 (Optional) Select Advanced to set the 
rules for fixing sync conflicts.

8 Press Next  (right action key) and 
check the boxes for the types of 

TIP The Exchange Server settings are case- 
sensitive. Be sure to enter uppercase and 
lowercase letters properly.

TIP Ask your system administrator if it is OK to 
store your corporate email password on your 
Treo 750 (for increased security, you may 
need to enter your password each time you 
access your email). If it is not OK, you must 
synchronize manually (see Initiating a wireless 
sync manually).
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information you want to synchronize 
with the Exchange Server.

9 (Optional) Highlight one of the items 
and select Settings to change the 
synchronization settings for that type 
of information. Settings are not available 
for all items. 

10 Press Finish  (right action key). 
Synchronization with your Exchange 
Server begins automatically. A status 

bar appears onscreen, indicating sync 
progress.

You can set a schedule for synchronization 
to take place any time info is updated on 
either your Treo 750 or the server or at 
certain intervals (see Setting the 
synchronization schedule), or allow 
synchronization to take place only when 
you initiate it manually (see Initiating a 
wireless sync manually).

Setting the synchronization schedule

You can set a synchronization schedule in 
either of the following situations:

• If your Microsoft Exchange Server 

2003 is upgraded to Service Pack 2: 
By default, wireless sync takes place 
any time info is updated on either your 
Treo 750 or the server using Direct Push 
Technology. To save battery life, 
however, you can set synchronization to 
take place at intervals that you specify.

• If your Microsoft Exchange Server 

2003 is not upgraded to Service 

Pack 2: By default, wireless sync does 
not take place automatically. Set a 
synchronization schedule to have sync 
take place either any time info is 

TIP To automatically download more of an 
incoming email message than the default 
setting, select E-mail in step 9 and increase 
the KB setting. If you don’t increase this 
setting, you can manually download the rest 
of the message at your convenience.
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updated on your Treo 750 or the server, 
or at certain intervals.

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right action key) 
and select Schedule. 

4 Set any of the following options:

Peak times: Sets the frequency for 
high-traffic time periods such as when 
you are at work or when email volume 
is high.

Off-peak times: Sets the frequency for 
low-traffic time periods such as late at 
night. 

Use above settings while roaming: 
Sets the frequency while you are 
roaming outside the Cingular network. 

You should keep this box checked to 
ensure that wireless sync works 
properly.

Send outgoing items immediately: 
Sets whether items are sent as soon as 
you select Send in the Inbox application, 
or whether they are held until the next 
synchronization. 

5 Press OK .

Initiating a wireless sync manually

If you want to control exactly when a 
wireless sync takes place, or if it is not OK 
to store your corporate email password on 
your Treo 750, you can initiate sync 
manually.

1 To set up manual sync, follow the 
preceding procedure, Setting the 
synchronization schedule. In the Peak 
times and Off-peak times lists, select 
Manual.

2 To initiate a manual sync, press Start 
 and select Programs.

3 Select ActiveSync .

4 Press Sync  (left action key).
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Other ways to 
synchronize

Synchronizing over a Bluetooth 

connection

You can wirelessly synchronize your 
computer and Treo 750 using Bluetooth 
wireless technology.

BEFORE YOU BEGIN Do the following:

• Make sure your computer is equipped 
with Bluetooth® wireless technology.

• If you did not do so during initial setup, 
install the ActiveSync Plug-in for 
Bluetooth wireless technology from the 
Windows Mobile Getting Started Disc.

1 On your computer, right-click the 
ActiveSync icon  in the taskbar in 

the lower-right corner of the screen, and 
select Connection Settings.

2 Check the Allow connections for one 

of the following box, and then select 
Bluetooth.

3 On your Treo 750, press Start  and 
select Settings.

4 Select the Connections tab, and then 
select Bluetooth .

5 Check the Turn on Bluetooth box to 
turn on the Bluetooth feature on your 
Treo 750.

6 Press Start  and select Programs.

7 Select ActiveSync .

8 Press Menu  (right action key) 
and select Connect via Bluetooth.

9 If this is the first time you’re making a 
Bluetooth connection to this computer, 
follow the onscreen prompts to set up a 
Bluetooth partnership with this 
computer. See Connecting to devices 
with Bluetooth® wireless technology for 
more information on partnerships.

10 Select Sync.

TIP To install the plug-in for Bluetooth 
technology, insert the Windows Mobile 
Getting Started Disc into your computer’s CD 
drive, and then select Add Programs. Select 
the plug-in option on the Add Programs 
screen and follow the onscreen instructions.
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11 When synchronization has finished, 
press Menu  (right action key) 
and select Disconnect Bluetooth.

Synchronizing over an infrared 

connection

If your computer has an IR (infrared) port, 
you can synchronize with your computer 
wirelessly using the IR port on your Treo 
750.

BEFORE YOU BEGIN Make sure your 
computer is equipped with an IR port.

1 Set up your computer to receive 
infrared beams. See ActiveSync Help on 
your computer for details.

2 Point the IR port directly on your Treo 
750 at the IR port on your computer.

3 On your Treo 750, press Start  and 
select Programs.

4 Select ActiveSync .

5 Press Menu  (right action key) 
and select Connect via IR.

6 Select Sync.

Synchronizing with multiple computers

You can set up your Treo 750 to 
synchronize with up to two computers as 
well as with Exchange Server 2003. When 
synchronizing with multiple computers, the 
items that you synchronize appear on all 
the computers.

For example, if you set up to sync your Treo 
750 with two computers named C1 and 
C2, when you sync Contacts and Calendar 
on your Treo 750 with both computers, you 
get the following results: 

• The contacts and calendar 
appointments that were on C1 are now 
also on C2. 

• The contacts and calendar 
appointments that were on C2 are now 
also on C1. 

• The contacts and calendar 
appointments from both computers are 
on your device. 

NOTE Microsoft® Office Outlook® E-mail 
can synchronize with only one computer.
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Setting 
synchronization 
options

Changing which applications sync

You must select sync options if you want to 
synchronize notes, pictures, and other 
types of files.

1 Press Start  and select Programs.

2 Select ActiveSync . 

3 Press Menu  (right action key) 
and select Options.

4 Do any of the following: 

• Check the box next to any items you 
want to synchronize. If you cannot 
check a box, you might have to 
uncheck a box for the same 
information type elsewhere in the list. 

• Uncheck the box next to any items 
you want to stop synchronizing. 

• Select an item and then select 
Settings to customize the settings for 
that item. Settings are not available 
for all items.

Stopping synchronization

If you ever need to manually stop 
synchronization, follow these steps:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Stop  (left action key).

TIP To stop synchronizing all items on a 
computer, select the computer name and 
then select Delete.
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Your email
You already know how efficient email is for staying in touch. 
Now your Palm® Treo™ 750 smart device brings you a new level 
of convenience: email on the go. Enjoy the ease and speed 
of communicating with friends, family, and colleagues 
anywhere you can access the Cingular data network.

You can send photos to your friends and family, or create 
Microsoft Word or Excel files and send them to your 
colleagues. You can also receive attachments to view and edit 
at your convenience.

Benefits

• Receive photos, sound files, Word 
and Excel files, and more

• Attach and send files of almost any 
type

• Save messages from your 
computer to view at a convenient 
time
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Setting up

BEFORE YOU BEGIN Do the following:

• You must have a data plan with Cingular 
to use email on your Treo 750. To find 
out if you have a plan, or to sign up if 
you don’t have one, call Customer 
Service by dialing 611 from your 
Treo 750 or 1-866-CINGULAR 
(1-866-246-4852) or dial 611 from your 
Treo 750, or check your most recent 
Cingular Wireless bill.

• If you want delivery of Outlook email 
using Direct Push Technology, make 
sure that your IT administrator has 
upgraded your Exchange Server 2003 to 
Service Pack 2.

Entering settings for an email account

You can use your Treo 750 to access email 
from both personal and corporate email 
accounts. You can easily set up personal or 
corporate wireless email yourself, or you 
can work with your company’s IT 
administrator to obtain access to your 
corporate email system. The following 
setup applications are available for 

do-it-yourself setup and IT-assisted setup. 
You can use one or more of these 
applications to access email for all of your 
accounts.

NOTE Once you enter settings for an 
account using one of the applications listed 
here, you view and compose messages for 
that account in the Inbox application on 
your Treo 750. The Inbox application is the 
home base for viewing and sending 
messages for all your email accounts.

Do-It-Yourself Setup Applications: 

Xpress Mail, Pocket MSN, Inbox. Use 
one of these apps to enter settings for a 
personal ISP account (such as EarthLink, 
Comcast, or CompuServe) or web-based 
account (such as Gmail or Yahoo! Mail 
Plus), or for a corporate account that uses 
Microsoft Outlook® or Lotus Notes.

IT-Assisted Setup Applications: 

GoodLink™ Mobile Messaging, 

Microsoft Exchange ActiveSync®. Use 
these applications to securely synchronize 
email with your corporate email server. 
Your IT administrator must have configured 
the server to work with these applications 
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and must have set up an account for you 
on the server before you can begin setup.

Using a do-it-yourself setup application

Xpress Mail: When you set up a personal 
or corporate email account using Xpress 
Mail, email for this account is automatically 
pushed from the server to your Treo 750. 
Using Xpress Mail with a corporate 
account also enables wireless 
synchronization of calendar appointments, 
contacts, and files that are stored in the My 
Documents folder on your Treo 750, as 
well as wireless corporate directory 
lookup. In addition, you get web-based 
access to corporate email, calendar, and 
contacts from any web browser.

For corporate email only, your computer 
needs to be on and connected to the 
company network for wireless 
synchronization to occur. Alternately, if you 
need to take your main business laptop 
with you, you can designate another 
computer to remain always on and 
connected to the corporate network, so 
that you can synchronize your email.

You can enter settings for up to three email 
accounts in Xpress Mail. A Cingular Xpress 

Mail account is required; additional charges 
may apply. See Setting up Xpress Mail.

Inbox (POP or IMAP): You can use the 
Inbox application to enter settings for one 
personal (POP or IMAP) email account. You 
must manually retrieve email for an 
account you set up using Inbox. See 
Setting up an IMAP or POP email account.

Pocket MSN (Hotmail): Pocket MSN 
enables you to access your Hotmail 
account. You can send and receive 
messages while connected to the data 
network, and you can review and draft 
messages when not connected, such as 
while on a plane. See Using Pocket MSN.

Using an IT-assisted setup application

BEFORE YOU BEGIN Do the following:

• Ask your IT administrator which 
wireless email solution your company 
supports.

• Obtain any required email setup 
information from your IT administrator.

• Confirm that your Cingular account 
includes the correct data plan to support 
your email solution. If you’re not sure, 
call 611 from your Treo 750 or 
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1-866-CINGULAR (1-866-246-4852) or 
dial 611 from your Treo 750 to speak to 
a customer service representative, or 
check your latest Cingular Wireless bill.

GoodLink Mobile Messaging: This app 
provides real-time wireless push of email, 
calendar, contacts, tasks, and notes for 
Microsoft Outlook and Lotus Notes. To use 
GoodLink, you need the following:

• An account on your company's Good 
Mobile Messaging server. Contact your 
IT administrator for info.

• An active PDA Connect for Good data 
plan on your Cingular Wireless account. 
Contact Cingular for more info.

For setup instructions, see Setting up Good 
Mobile Messaging.

Microsoft Exchange ActiveSync: This app 
provides wireless synchronization of email, 
contacts, calendar and tasks. If your 
company has Exchange 2003 and Service 
Pack 2 (SP2) installed, email and other info 
may be automatically pushed from the 
server to your Treo 750; otherwise, you 
need to initiate synchronization manually or 
set up a sync schedule. To use Exchange 
ActiveSync, the following must take place:

• For push email, your IT Exchange 
administrator must enable Mobile 
Services on the Exchange Server. 
Contact your IT administrator for info.

• You must have an active PDA Connect 
for Microsoft Direct Push data plan on 
your Cingular Wireless account. Contact 
Cingular for more info.

For setup instructions, see Setting up 
wireless synchronization.

Setting up Xpress Mail

Before you can use Xpress Mail to work 
with email on your Treo 750, you need to 
do the following:

• Know the address of the email account 
you want to access through Xpress Mail 
on your Treo 750.

• Know the phone number of your 
Treo 750 (see What’s my number?).

• Use your computer’s web browser to 
go to the Cingular Xpress Mail website 
(https://xpressmail.cingular.com) and 
create an Xpress Mail account. 

TIP Use the web browser to view your free 
Yahoo! mail account on the web.
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• On your computer, download, install, 
and set up Xpress Mail desktop 
software.

• On your Treo 750, install Xpress Mail 
software and set it up to work with your 
email account.

For complete information on setting up 
Xpress Mail, go to www.palm.com/
mytreo750cingular.

Setting up Good Mobile Messaging

Good Mobile Messaging provides access 
to your corporate email and personal 
information management (PIM) info from 
your Treo 750 and offers enhanced usability 
features and enterprise-class security 
features.

Your company must have Good Mobile 
Messaging server software in order for you 
to use Good Mobile Messaging on your 
Treo 750.

BEFORE YOU BEGIN Do the following:

• Make sure you have a PDA Connect for 
GoodLink data plan on your Cingular 
Wireless account. If you’re not sure, call 
customer care by dialing 611 from your 
Treo 750 or 866-4CWS-B2B (429-7222).

• Contact your system administrator to 
make sure you have been added as a 
user to the Good Mobile Messaging 
server.

• Make sure you have received a 
confirmation email message sent to you 
after you were added to the Good 
server; this message includes pertinent 
information for setting up your account.

• Make sure your phone is on.

1 Press Start  and select Programs.

2 Select Get Good .

3 When prompted, select Save & Open.

4 Follow the onscreen instructions to 
download and run OTA Setup.

5 On the following screen, enter your 
email address and the 30-digit numeric 
PIN contained in the confirmation email.

DID YOU KNOW? Xpress Mail is not an email 
provider. It works with a corporate or personal 
account to transfer messages to 
your Treo 750.
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6 Follow the onscreen instructions to 
download, install, and connect to 
GoodLink.

Setting up an IMAP or POP email account

You can send and receive email messages 
using an email account that you have with 
an Internet service provider (ISP), an email 
account that you access using a VPN 
server connection (such as a work 
account), or any other IMAP or POP email 
account.

BEFORE YOU BEGIN Work with your 
email provider or system administrator to 
gather the following info:

• Account type (POP3 or IMAP)

• Mail server name for receiving mail

• Mail server name for sending mail

• Your username and password

• Any special security requirements

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Press Menu  (right action key) 
and select Tools > New Account.

4 Enter the email address that you want 
to set up, and then press Next  
(right action key).

5 The setup process searches an online 
database to obtain the settings for your 
account. Wait until the Status box 
displays Completed, and then press 
Next  (right action key). If no 
settings are returned, enter the settings 

DID YOU KNOW? After installation, the Get Good 
program entry is replaced by GoodLink.

TIP If you have problems configuring your 
account, go to www.palm.com/emailsetup for 
more information.

DID YOU KNOW? On the Accounts tab in 
Messaging Options, an asterisk appears next 
to the accounts you create.

TIP To delete an email account or to edit 
account settings—for example, if you need to 
change the name of the outgoing mail 
server—press Menu (right action key) and 
select Tools > Options. To delete an account, 
highlight the account you want press and hold 
Center on the 5-way, and then select Delete. 
To edit an account, select the account and 
change the settings you want to edit.
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you obtained from your email provider, 
and then press Next  (right action 
key).

6 Enter your name, username, and 
password.

7 If you want to enter your password each 
time you access this account, do not 
check the Save password box. If you 
want your password entered 
automatically, check this box.

8 Press Next  (right action key).

9 Select the Account type list, and then 
select POP3 or IMAP.

10 Enter a name for this account, and then 
press Next  (right action key). For 
example, if this is your work email 

account, enter “Work” or your 
company’s name.

11 Enter the name of the Incoming mail 
and Outgoing mail servers.

NOTE Do not enter anything in Domain. It 
is not needed for POP3 or IMAP accounts.

12 (Optional) Select Options to select 
download settings for this account.

13 Press Finish  (right action key).

TIP If you are unable to send mail using your 
email provider’s or corporate mail system’s 
outgoing mail server, try using cwmx.com as 
the outgoing server name. This is Cingular’s 
default outgoing server.
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Sending and 
receiving messages

Creating and sending an email message

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Press Left  to cycle through your 
Inbox accounts until you see the right 
email account name in the title bar.

4 Press New  (left action key).

5 Enter the recipient’s email address. 
Here are some shortcuts:

• If the recipient’s name and email 
address are in your Contacts list, 
enter the first few letters of the 
recipient’s first or last name, and then 
select the recipient’s name.

• If the recipient’s name is in an online 
address book, you can find the name 
and add it. See Using an online 
address book.

6 Select Subject and enter a title for the 
message.

7 Press Down  to go to the body of the 
message. Enter your message, or press 
Menu  (right action key), select 
My Text, and then select a predefined 
phrase you want to insert.

8 (Optional) Press Menu  (right 
action key) and select Insert. Select the 
type of item you want to attach, and 
then select the file or record a voice 
note.

DID YOU KNOW? You can also access the Inbox 
application from the Start menu. DID YOU KNOW? When addressing a message, 

you can enter the contact’s first and last 
initials separated by a space.
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9 (Optional) Press Menu  (right 
action key) and do one or both of the 
following:

• Select Spell Check. When the spell 
check is complete, press OK .

• Select Message Options. Select the 
Priority list, select a setting for the 
message, and then press OK .

10 Press Send  (right action key).

Receiving email messages

How you receive email messages depends 
on the type of account you are using and 
how you synchronize:

• If you synchronize wirelessly with your 
Exchange Server using Microsoft 
Exchange ActiveSync, new email 
messages are sent to your Treo 750 
when they appear on the server, 
according to the schedule you set up 
(see Setting the synchronization 
schedule), or when you manually initiate 
a sync (see Initiating a wireless sync 
manually.

• If you use ActiveSync desktop software 
to synchronize your Treo 750 with your 
computer, messages in Outlook on your 
computer are transferred to your 
Treo 750 when you connect your 

TIP You can send an email message with a file 
attached from directly within other 
applications on your Treo 750; see Sending 
email messages from within another 
application.

TIP To save memory on your Treo 750, turn off 
the option to save sent messages in the 
Saved folder. In the Inbox, press Menu (right 
action key) and select Tools > Options. Select 
Message, and then uncheck the Keep copies 

of sent items in Sent folder box.

TIP If you sync email with Microsoft Exchange 
Server 2003, you can synchronize messages 
in subfolders you create. In the Inbox, press 
Menu (right action key) and select Tools > 
Manage Folders. Folders containing 
subfolders display a +. Select the + to view 
the subfolders. Check the box to the left of 
any subfolder you want to sync.
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computer and your Treo 750 (see 
Connecting your Treo 750 to your 
computer).

• For all other types of accounts, 
including Xpress Mail accounts, ISP 
accounts, and accounts you access 
using a VPN server connection (typically 
a work account), follow these steps to 
send and receive messages:

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Press Left  to cycle through your 
accounts until the name of the account 
you want to synchronize appears in 
the title bar.

4 Press Menu  (right action key) 
and select Send/Receive to 
synchronize your Treo 750 with your 
email server.

Receiving attachments

1 Scroll to the attachment name (below 
the subject) to highlight it and mark it 
for download.

2 Synchronize the email account that 
contains the message as described in 
the previous sections.

3 Scroll to and select the attachment 
name (below the subject) to open the 
attachment.

If you are synchronizing with Outlook on 
your computer and want to download 
attachments automatically, do the 
following: 

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right action key) 
and select Options. 

4 Select E-mail, and then select 
Settings.

5 Check the Include file attachments 
box. 

6 Press OK .

DID YOU KNOW? You can receive and open 
attachments in a number of different formats, 
including PDF. PDF file attachments open in 
Picsel PDF Viewer on your Treo 750.

TIP To store attachments on an expansion 
card, press Menu (right action key) and select 
Tools > Options. Select Storage and then 
check the Store attachments on a storage 

card box.
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To automatically download attachments 
from an IMAP4 email account (typically an 
ISP account) or an account that you access 
using a VPN server connection (typically a 
work account), do the following: 

1 Go to your Today screen.

2 Press E-mail  (left action key).

3 Close any open messages.

4 Press Menu  (right action key) 
and select Tools > Options.

5 On the Accounts tab, select the IMAP4 
account name. 

6 Press Next  (right action key) until 
you reach Server information, and then 
select Options. 

7 Press Next twice, and then select Get 

full copy of messages and When 

getting full copy, get attachments. 

Working with email 
messages

Adding an online address book

Many email servers, including servers 
running Exchange Server, can verify names 
with an online address book, also called a 
directory service or a Global Address List. 
After you create and enable an email 
account, the Inbox application checks your 
contacts list and then the directory service 
to verify names that you enter in the To, 
Cc, and Bcc fields.

BEFORE YOU BEGIN Do the following:

• Ask your system administrator for the 
name of the directory service and the 
server, and whether authentication is 
required for accessing an online address 
book.

• If your company is using an Exchange 
Server, you must first synchronize with 
the Exchange Server to enable the 
Global Address List to find a Contact.

DID YOU KNOW? Embedded images and objects 
cannot be received as attachments, unless 
you have an IMAP4 email account with TNEF 
disabled. Note that TNEF must be enabled to 
receive meeting requests.
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1 In the message list, press Menu  
(right action key) and select Tools > 
Options.

2 Select the Address tab. 

3 Select the address book you want to 
check for email addresses, and then 
select Add. 

4 Enter the name of the Directory service.

5 Enter the server name.

6 If your server requires authentication, 
check the box, and then enter your 
username and password.

7 (Optional) Check the Check name 

against this server box to enable this 
directory service.

8 Select OK.

Using an online address book

You can access contact information, such 
as an email address or phone number, from 
your organization’s online address book or 
Global Address List (GAL). To access a 

GAL, make sure you are accessing an 
Exchange Server 2003 upgraded to Service 
Pack 2. This feature is useful only if you 
know the exact name as it appears in the 
directory.

BEFORE YOU BEGIN Add an online 
address book to your Treo 750. See Adding 
an online address book.

1 In a new message, tap the To box. 

2 Press Menu  (right action key), 
and select Add Recipient.

3 Press Menu  (right action key), 
and select Find Online. 

4 Enter the contact name as it appears in 
the directory and tap Find. You must 
spell the contact name correctly.

TIP To delete a directory service, highlight it, 
press and hold Center on the 5-way, and then 
select Delete.

DID YOU KNOW? You can use the Global 
Address List to find a contact. In Contacts, 
press Menu (right action key), and then select 
Find Online. When sending a meeting 
request, select Attendees, press Menu (right 
action key), and then select Find Online. 
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Forwarding a message

1 Open the message you want to 
forward.

2 Press Menu  (right action key) 
and select Forward.

3 Address the message and enter any 
text you want to add.

4 Press Send  (left action key).

Adding a signature to your messages

You can use a different signature with each 
email account.

1 Press E-mail  (left action key).

2 Press Menu  (right action key) 
and select Tools > Options.

3 On the Accounts tab, select 
Signatures.

4 Select the account for which you want 
to create a signature.

5 Check the box to add this signature to 
new messages you create with this 
account.

6 (Optional) Check the box to add this 
signature to messages you reply to or 
forward with this account.

7 Select the default signature text and 
enter the signature text you want to 
use.

8 Press OK .

Customizing your email settings

When you customize settings for an email 
account, the options you choose apply to 
that account only.

TIP When you sync with Outlook on your 
computer, disable your online address books 
to avoid errors. Press Menu (right action key) 
and select Tools > Options. Select Address, 
select each online address book, and then 
uncheck the Check name against this server 
box. Be sure to turn this option back on if you 
synchronize other email accounts.
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1 Press E-mail  (left action key).

2 Press Left  to cycle through your 
accounts until the name of the account 
you want appears in the title bar.

3 Press Menu  (right action key) 
and select Tools > Options.

4 Select the Message tab and set any of 
the following options:

When replying to e-mail, include 

body: Indicates whether the body of a 
message you received appears in your 
response to that message.

Keep copies of sent items in Sent 

folder: Indicates whether messages 
you send are stored in the Sent folder.

After deleting or moving a message: 
Specifies what you want to see after 
you delete or move an email message.

5 Select the Address tab and set any of 
the following options:

In Contacts, get e-mail addresses 

from: Indicates whether you want to 
check Contacts in addition to any 
directory services for email addresses.

Verify names using these address 

books: Indicates which directory 
services you want to check for email 
addresses.

Add: Enables you to add directory 
services to the list of online address 
books.
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6 Select the Storage tab and set any of 
the following options:

Store attachments on storage card: 

Indicates whether you want to 
automatically store email attachments 
on an expansion card.

Empty deleted items: Indicates 
whether you want to automatically 
empty the Deleted folder, and when you 
want this to occur.

7 Press OK .

Sending email 
messages from 
within another 
application

You can send files such as pictures, videos, 
and ringtones as attachments to email 
messages; see Creating and sending an 
email message for instructions. 

You can send certain files as attachments 
from within the application where the file is 
created or stored. For example, if you take 
a picture with the built-in camera on your 
Treo 750 (camera models only), you can 
select an option to send the picture as an 
attachment to an email message. This 
feature can be used with videos and sound 
files as well. For details, see the chapter on 
the specific application.
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Your text and multimedia 
messages
If you need to get a short message to a friend or a co-worker 
fast, send a text message from your Palm® Treo™ 750 smart 
device to their mobile phone or email address.

If you need more than text to express yourself, use multimedia 
messaging to give your message extra impact by adding a 
photo, video, or sound file.

Benefits

• Enjoy quick communication

• Use text messaging to chat with 
friends

• Be as simple or as creative as you 
want
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Using the Messaging 
application

You can use the Messaging application to 
send and receive brief text messages 
(SMS) and multimedia messages (MMS). 
Before you use your Treo 750 to send or 
receive messages, consult Cingular for 
pricing and availability of text and 
multimedia messaging services.

Creating and sending a text message

Each text message can have up to 160 
characters. You can send a message of 
more than 160 characters, but the 
message will automatically be split into 
several messages. (If you send a text 
message to an email address, the email 
address is deducted from the 
160-character count.)

1 Press Start  and select Messaging.

2 Press New  (left action key).

3 Enter the recipient’s mobile phone 
number or email address. Here are 
some shortcuts:

• If the recipient’s name and mobile 
number are in your Contacts list, type 
the first few letters of the first or last 
name or simply enter the first initial, 
followed by a space, and then the last 
initial to find a name.

• Press Center  to view a list of 
recently used addresses, and select 
the recipient from the list. Select Add 

Recipient to add a recipient from your 
Contacts list.

DID YOU KNOW? You can send and receive text 
messages even while you are on a phone call. 
This is easiest when using a hands-free 
headset or the speakerphone.
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4 Enter your message, or tap  and 
then select a predefined phrase you 
want to insert.

5 (Optional) Tap  and then select an 
emoticon to add to your message.

6 Press Send  (left action key).

Creating and sending a multimedia 

message

Multimedia messages consist of pictures, 
videos, text, and sounds presented as one 
or more slides. Even if your Treo 750 does 
not include a camera, you can still send, 
receive, and view pictures and videos. You 
can include any of the following items: 

• Ringtones

• MIDI

• Sound clips

• AMR

• QCELP

• Pictures

• JPEG

• GIF

• WBMP

• Videos

• 3GPP

• 3GPP2

• MPEG4

Outgoing multimedia messages can be up 
to 300KB by default, but Cingular may 
change the maximum message size.

TIP To address a message to multiple 
recipients, separate the addresses by 
pressing Enter or entering a semicolon (;). You 
can send a message to up to 20 addresses.

TIP To send a message to a different number 
for a contact, select the contact in the To field, 
and then edit the number that appears in the 
box directly below the contact number. You 
can also select a number by pressing Center 
on the 5-way, and then edit it.

TIP You can also access predefined phrases 
and emoticons by pressing Menu (right action 
key) on the message compose screen.

TIP Some symbols can’t be used in text 
messages. Invalid characters are automatically 
replaced by the Messaging application.
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1 Press Start  and select Messaging.

2 Press Menu  (left action key) and 
select New MMS.

3 Enter the recipient’s mobile phone 
number or email address. Here are 
some shortcuts:

• If the recipient’s name and mobile 
number are in your Contacts list, type 
the first few letters of the first or last 
name or simply enter the first initial, 
followed by a space, and then the last 
initial to find a name.

• Press Center  to view a list of 
recently used addresses, and select 
the recipient from the list. Select Add 

Recipient to add a recipient from your 
Contacts list.

4 Select Subject and enter a title for the 
message.

5 Select  and select one of the 
following:

Add Picture: Enables you to insert a 
picture. You can take a new picture with 
the built-in camera (camera model only) 
or insert an existing picture.

Add Video: Enables you to insert a 
video. You can capture a new video with 
the built-in camera or insert an existing 
video clip. 

Add Sound: Enables you to record a 
message, such as a voice caption for a 
picture, or insert an existing sound, such 
as a ringtone. You can add one sound 
per slide; to send more than one sound 
in a message, add another slide to your 
message.

TIP You can add both a picture and a sound 
clip to the same slide in a message. To add a 
sound to a picture, select the picture 
thumbnail and select Add Sound. To add a 
picture to a sound, select the sound icon 
thumbnail and select Add Picture.
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6 (Optional) Select Add Text and enter a 
text caption or message for the slide 
you inserted. Tap  to insert a 
predefined phrase. Tap  to insert an 
emoticon.

7 (Optional) Select Add slide and repeat 
steps 5–6 to add another slide in this 
message.

8 (Optional) To add a vCard (contact file) 
to a message, press Menu  (left 
action key), select Add Media, and then 
select Add vCard.

9 Press Send  (left action key).

Setting message options

You can set options for individual text and 
multimedia messages you send.

1 On the message compose screen, 
press Menu .

2 Select Message Options.

3 Select any of the following options

Request Delivery/Read Receipt 

(multimedia messages only): 
Indicates whether you want to receive 
confirmation that the message has 
been delivered or has been read.

DID YOU KNOW? If you add more than one slide 
to a message, you can set the length of time 
each slide is displayed. Press Menu (right 
action key) and then select Slide Timing.

TIP To preview a multimedia message as the 
recipient will see it, press Menu (right action 
key) and then select Preview Message.

DID YOU KNOW? You can set general 
preferences that apply to all incoming and 
outgoing messages; see Customizing 
message settings. If you set options for an 
individual message, those options override 
your general preferences for that message 
only.
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Validity Period: Indicates how long the 
message remains available to be sent if 
the recipient’s phone or email address is 
not available when you originally send 
the message. For example, if a 
message contains information that will 
not be useful to the recipient after an 
hour, you can set the validity for one 
hour. 

Message Priority (multimedia 

messages only): Indicates the priority 
for this message.

4 Press OK .

Receiving text and multimedia messages

When your phone is on and you are in a 
wireless coverage area, you automatically 
receive new text messages. For 
multimedia messages, you can set your 
Treo 750 to automatically download new 
messages or to notify you that messages 
are ready to download. You can also 
set your Treo 750 to notify you when a new 
text or multimedia message arrives.

The new message notification may include 
any of the following options:

• Go To: Opens a text message so you 
can view its full contents.

• View: Opens a multimedia message 
and plays the included media.

• Download: Downloads the full content 
of a multimedia message.

• Dismiss: Closes the notification and 
puts the message into your Inbox.

DID YOU KNOW? Message notifications include 
the message text unless you have turned on 
privacy mode (see Customizing message 
settings). If privacy mode is on, the 
notification states only the type of incoming 
message.
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If you have multiple messages, the 
notification includes the number of 
messages and the type (text or 
multimedia). 

Viewing/playing a message

You can open a message from a 
notification or from the Inbox of the 
Messaging application. When you open a 
multimedia message, playback starts 
automatically.

1 Do one of the following to open the 
message:

• Press Start  and select 
Messaging. From the Inbox, select 
the message you want to view. 

• From a notification, select Go To (for 
text messages) or View (for 
multimedia messages).

2 Do any of the following:

Pause or resume playback 

(multimedia message only): 

Select Pause  (left action key). To 
resume playback, select Play  (left 
action key).

Save the item that is playing 

(multimedia message only): Press 
Menu  (right action key) and 
select Save.

See a summary of the message, 

including sender, date, and time: 

Press Menu  (right action key) 
and select Message Details.

Reply to the message: Press Menu 
 (right action key) and select 

Reply or Reply All.

NOTE If the message is a single picture 
with no audio, select Reply  (left 
action key) to reply to the message.
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Forward the message: Press Menu 
 (right action key) and select 

Forward.

Call the sender: Press Menu  
(right action key) and select Call 

Sender.

Add the sender’s information to your 

Contacts list: Press Menu  (right 
action key) and select Add to Contacts.

Save the message as a template for 

other messages: Press Menu  
(right action key) and select Save as 

Template.

3 Press OK .

Using Messaging to chat

When you exchange more than one 
message with a single contact, the 
messages you exchange with that person 

are grouped into a chat session. When you 
select a chat session from your message 
list, the upper part of the screen displays all 
messages you’ve exchanged with this 
contact, and the lower part provides a text 
entry area. 

1 Press Start  and select Messaging.

2 Do one of the following:

Start a new chat: Select a message 
and reply to it.

Continue an existing chat: Select a 
message with the Chat  icon.

3 Enter your message.

4 Press Send  (left action key).

DID YOU KNOW? When viewing a message 
containing multiple slides, you can press 
Right on the 5-way to move to the next slide, 
or press Left on the 5-way to move to the 
previous slide.
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5 In a received message, select  to 
open a media file, or click a link to 
download and open a new multimedia 
message.

Using links in messages

When you receive a text message that 
contains a telephone number, email 
address, or URL, you can dial the number, 
send an email message, or go to the web 
page immediately. Your Treo 750 
automatically opens the appropriate 
application from the link.

1 Open a message in the Inbox or another 
folder.

2 Select the phone number, email 
address, or URL (appears as underlined 
blue text).

Message status icons

The status icons that appear next to each 
message in the Inbox, Outbox, and Sent 
folders indicate the following:

TIP Only the last 50 messages in a chat 
session are displayed. Select View older 

messages near the top of the screen to see 
earlier messages.

 An unread text message.

 An unread message with pictures or 
videos. 

 An unread message with sound. 

 A read text message. 

 A read message with pictures or 
videos.

 A read message with sound.

 A message that was delivered with 
delivery confirmation turned on 
(Sent folder only). 

 Multiple messages exchanged with 
a single recipient (chat). 

 An urgent message. This icon 
appears below the message size on 
the right side of the screen.

TIP Unread messages appear in bold. 
Messages you’ve read appear in plain text. 
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Sorting your messages

You can sort the messages in any folder by 
date or by sender. 

1 Go to the Inbox or other folder you want 
to sort.

2 Press Menu  (right action key) 
and select Sort.

3 Select By Name or By Date.

Deleting a single message

1 Go to the Inbox or other folder 
containing the message you want to 
delete.

2 Highlight the message.

3 Press Menu  (right action key) 
and select Delete.

4 Select Yes to confirm the deletion.

Deleting multiple messages

1 Go to the Inbox or other folder 
containing the messages you want to 
delete.

2 Press Menu  (right action key) 
and select Purge.

3 Select the age of messages to be 
deleted, or select to delete all 
messages.

4 Select Purge  (left action key).

Customizing the 
Messaging 
application

Customizing message settings

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select Options.



Y O U R  T E X T  A N D  M U L T I M E D I A  M E S S A G E S

C U S T O M I Z I N G  T H E  M E S S A G I N G  A P P L I C A T I O N110

6
C

H
A

P
T

E
R

3 On the Messages tab, set any of the 
following options:

Confirm message deletions: Indicates 
whether you want deletion confirmation 
messages to appear.

Automatically download MMS 

messages: Indicates whether you want 
to automatically receive multimedia 
messages. Check the Even when 

roaming box to download multimedia 
messages both on your home network 
and while roaming.

NOTE You might incur additional charges if 
you download multimedia messages while 
roaming.

Message validity period: Indicates 
how long messages remain available to 
be sent if the recipient’s phone or email 
address is not available when you 
originally send the message. For 
example, if your messages generally 
contain information that will not be 
useful to recipients after an hour, you 
can set the validity for one hour.

Signature: Enables you to add a 
signature to outgoing messages. Select 
the button; then, on the Signature 
screen, check the Use signatures with 

new messages box, enter your 
signature text, and press OK .

4 Press OK . 

Customizing chat settings

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select Options.

DID YOU KNOW? Options you select for an 
individual message (see Setting message 
options) override the general preferences you 
set for messages.
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3 Select the Chat tab.

4 Select either of the following options:

Create chat from messages: Indicates 
the conditions under which a chat 
session starts.

Show time stamps of each message: 
Indicates whether you want chat 
session items to display a date and time 
indicator.

5 Press OK . 

Customizing notification settings

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select Options.

3 Select the Notification tab.

4 Select any of the following options:

Request MMS receipts: Indicates 
whether you want to receive a 
confirmation when a multimedia 
message is delivered or when it is read.
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Privacy mode: Indicates whether you 
want only the message type displayed 
on a notification for a single incoming 
message. If the box is unchecked, the 
notification displays the text of the 
message.

Acknowledge when messages are 

received/read: Indicates whether you 
want a confirmation sent to the sender 
when you receive or read a multimedia 
message.

5 Press OK . 

Customizing network settings

IMPORTANT Changing the network 
settings can cause the Messaging 
application to stop working correctly. We 
recommend that you keep the default 
network settings.

1 Press Start  and select Messaging.

2 Press Menu  (right action key) 
and select Options.

3 Select the Advanced tab.

4 Select Manual, and then select Edit.

5 Edit the network settings you want to 
change.

6 Press OK  twice.

TIP Select Automatic on the Advanced tab to 
restore the default settings.
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Using Pocket MSN

Pocket MSN provides quick access to the 
following:

• MSN Hotmail: Enables you to read, 
write, send, and delete email. You can 
also manage your Hotmail folders.

• MSN Messenger: Enables you to see 
who’s online and exchange instant 
messages (IM). Subscribe to status 
updates for selected contacts so you’re 
notified when they’re online.

• Options: Enables you to customize your 
Pocket MSN experience.

BEFORE YOU BEGIN You must subscribe 
to data services from Cingular. You must 
also have a Passport (IM) account or a 
Hotmail account. If you do not have either 
of these accounts, do the following:

• To create a Passport (IM) account, go to 
www.passport.com.

• To create a Hotmail account, go to 
www.hotmail.com.

Signing in to Pocket MSN

1 Press Start  and select Programs.

2 Select Pocket MSN.

3 Select MSN Mobile Home.

4 Select Sign in.

5 Enter the email address and password 
for your Passport account or your 
Hotmail account.

DID YOU KNOW? You can add Pocket MSN to 
your Today screen. See Selecting which items 
appear on your Today screen for details.

TIP When you set up a Pocket MSN Hotmail 
account, you can access that account in the 
Inbox application. To access your instant 
messages, use the MSN application or the 
MSN plug-in on the Today screen.
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CHAPTER

7

Your connections to the web 
and wireless devices
You use the web for so many things: finding driving directions, 
getting news, buying gifts, checking web-based email. Now, 
with the Cingular network and the built-in web browser, you 
can take the web with you almost anywhere you go.

The built-in Bluetooth® wireless technology helps on your 
Palm® Treo™ 750 smart device you easily set up wireless 
connections to a number of devices, so you can enjoy the 
convenience of cable-free connectivity. You can also use your 
Treo 750 to connect your computer to the Internet and to share 
contacts or your favorite photos with other people.

Benefits

• Carry the web with you

• Store web pages for offline 
viewing

• Connect to Bluetooth headsets 
and car kits

• Connect your computer to the 
Internet through your Treo 750
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Browsing the web

Internet Explorer Mobile provides quick and 
easy access to web pages. You can view 
most sites you use on your computer, 
including those with security and advanced 
features, such as JavaScript and frames. 

Internet Explorer Mobile supports 
JavaScript, Secure Sockets Layer (SSL), 
and cookies, but does not support plug-ins 
(Flash, Shockwave, and so on) or Java 
applets.

BEFORE YOU BEGIN Do the following:

• Be sure to subscribe to data services 
from Cingular. This is necessary for 
browsing the web.

• Make sure your phone is on (see 
Turning your Palm® Treo™ 750 smart 
device on/off).

Viewing a web page

By default, Internet Explorer Mobile scales 
web page content to fit your Treo 750 
screen so that you can view most of the 
information without scrolling left or right.

1 Press Start  and select Internet 

Explorer.

DID YOU KNOW? The security certificates and 
128-bit SSL strong encryption enables you to 
browse secure sites, such as online shopping, 
banking, and email. Remember, some secure 
sites also require a specific browser and may 
not work with Internet Explorer Mobile. Ask 
the organization for an alternate access point 
that is compatible with Internet Explorer 
Mobile.

DID YOU KNOW? You can also start a web 
search from your Today screen by selecting 
the Web search field, entering the item you 
want to find, and then pressing Center on the 
5-way. 
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2 Highlight the address line, enter the 
address of the web page you want to 
view, and then press Center . To 
return to a recently viewed page, select 
the address line list, and then select the 
web address.

3 Press Menu  (right action key), 
select View, and then select one of the 
following:

One Column: Arranges web pages into 
one column that is as wide as the 
screen, so that you don’t have to scroll 
horizontally. 

Default: Maintains a layout similar to 
what you see on a desktop computer, 
but it makes items smaller and arranges 
the content so that you can see most of 
it without scrolling horizontally. 

Desktop: Keeps the same layout and 
size as on a desktop computer, which 
requires both horizontal and vertical 
scrolling.

Full Screen: Hides the status and 
navigation areas and fills the entire 
screen with the web page. To exit full 
screen mode, press  (right action 
key), or tap and hold anywhere on the 
screen and uncheck Full Screen.

Show Pictures: Shows or hides 
pictures on web pages. Hiding pictures 
speeds up the time it takes to load 
pages. 

4 Here are some tips on viewing web 
pages and moving around in them:

• To view the previous page, press 
Back  (left action key) or 
Backspace .

• To refresh the page with the latest 
content from the Internet, press 
Menu  (right action key) and 
select Refresh.

• To scroll through the page in One 
Column View or Default View, press 
Up  or Down . In Desktop View, 
press Up , Down , Left , or 
Right  to scroll in all directions.

• To follow a link to another web page, 
press Up  or Down  to highlight 
the link, and then press Center  to 

DID YOU KNOW? If you browse to a secure web 
page, the Lock icon in the address line 
appears closed instead of open.
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go to the selected page. You can also 
tap the link on the screen with your 
stylus.

• To send email from a web page, 
select the address link. You need to 
configure an email application on your 
Treo 750 before you can use this 
feature. See Your email.

• To adjust the size of the text on web 
pages, press Menu  (right 
action key), select Zoom, and then 
select the size you want.

• To view a web page’s properties, 
press Menu  (right action key) 
and select Tools > Properties.

• To view each item in a list, select the 
list and scroll using Up  or Down 

.

• In a list, press Left  or Right  to 
cycle between items, and press 
Center  to accept the change.

• In a form, such as a browser search 
field, press Center  to interact 
with the form, and then press Center 

 to stop interacting with the form.

5 Press OK  to close Internet Explorer 
Mobile.

Creating a favorite

Favorites let you bookmark a web page so 
that you can instantly access it without 
entering the web address.

BEFORE YOU BEGIN Create the folders 
where you want to store your favorites 
first. Once you create a favorite, you can’t 
move it to another folder.

1 Go to the page you want to mark as 
a favorite.

TIP To send a link, press Menu and select 
Tools > Send Link via E-mail. Select the 
Messaging account you want to use to send 
the link.
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2 Press Menu  (right action key) 
and select Add to Favorites.

3 (Optional) Select Name and enter a 
different description.

4 (Optional) Select the folder where you 
want to create the favorite.

5 Select Add.

Viewing a favorite

1 Press Start  and select Internet 
Explorer.

2 Press Favorites  (left action key).

3 Select the page you want to view in the 
list.

Organizing your favorites

You can create folders to organize your 
favorites. For example, you can store travel 
links in one folder, stock links in another, 
and business links in a third folder.

1 Press Start  and select Internet 
Explorer.

2 Press Menu  (right action key) 
and select Favorites.

3 Select the Add/Delete tab.

4 Select New Folder.

5 Enter a name for this folder, and then 
select Add.

6 Press OK .

Downloading files and images from a web 

page

You can download files that are usable on 
your Treo 750, such as new applications, 
MIDI ringtones, or pictures that are 
specifically tagged for download.

1 Go to the page that contains the link to 
the file you want to download.

2 Press Left  or Right  to highlight the 
link to the file.

3 Press and hold Center , and then 
select Save As to download a file, or 

TIP To delete a favorite or folder, press Menu 
and select Favorites. Select the Add/Delete 
tab, highlight the item you want to delete, and 
then select Delete. Select Yes to confirm 
deletion, and then press OK.

DID YOU KNOW? You can select the Downloads 
favorite to access the Cingular downloads 
page.
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tap and hold, and then select Save 

Image to download an image.

4 Select Name and enter a new name for 
the file. 

5 Select the Folder list, and then select 
the folder where you want to save the 
file.

6 Select the Location list, and then select 
where you want to store the file: Main 

memory or Storage card. 

7 Press OK .

Copying text from a web page

You can copy text from a web page and 
paste it in other applications.

1 Use the stylus to highlight the text you 
want to copy.

2 Press Menu  (right action key) 
and select Edit > Copy.

3 Go to the application in which you want 
to paste, and then position the cursor 
where you want to paste the text.

4 Press Menu  (right action key) 
and select Edit > Paste.

Returning to recently viewed pages 

The History list stores the addresses of the 
pages you visited recently.

1 Press Menu  (right action key) 
and select History. 

2 (Optional) Select the Show list in the 
upper-left, and then select how you 
want to sort the History list.

3 Select the web page you want to view.

DID YOU KNOW? You can access specially 
formatted streaming content by pressing 
Menu (right action key), selecting Favorites, 
and then selecting WindowsMedia.com.

TIP You can copy the text from the entire web 
page. Tap and hold on the page, and tap 
Select All Text. Tap and hold on the page 
again, and tap Copy.

TIP If Internet Explorer Mobile does not 
recognize a Treo 750 number as dialable, you 
can copy the phone number (as text) and 
paste it into the Phone Dial Pad.
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Customizing your Internet Explorer 

Mobile settings

1 Press Menu  (right action key) 
and select Tools > Options.

2 On the General tab, set any of the 
following options:

Home Page: Sets the page that appears 
when you open Internet Explorer 
Mobile. To use the page you were on 
when you opened the menu, select Use 
Current. To select the original home 
page, select Use Default.

Encoding: Sets the character set for 
the web pages you view.

3 Select the Memory tab and set any of 
the following options:

Save links to pages visited in the 

past: Sets how many days of activity 
the History list stores.

Clear History: Empties the History list.

Delete Files: Removes web files that 
you synchronized with your computer.

4 Select the Security tab and set any of 
the following options:

Allow cookies: Sets whether your Treo 
750 accepts cookies (small files 
containing info about your identity and 
preferences). The page sends the file 
and stores it on your Treo 750.
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Clear Cookies: Deletes any cookies 
stored on your Treo 750.

Warn when changing to a page that 

is not secure: Sets whether a message 
appears when you switch from a secure 
page to one that is not secure.

Warn when page content is blocked 

due to security settings: Sets whether 
a message appears when you attempt 
to open a page that does not meet the 
security standards associated with your 
Treo 750.

5 Press OK .

Connecting to 
devices with 
Bluetooth® 
wireless technology

With the built-in Bluetooth® wireless 
technology on your Treo 750, you can 
connect to a number of Bluetooth devices 
such as a headset or hands-free car kit, as 
well as to other phones, handhelds, or 
piconets. When you connect to another 
device, you create a partnership (also 
referred to by terms such as trusted pair, 
trusted device, or pairing) with that device. 
If your computer is enabled with Bluetooth 
wireless technology, you can also 
synchronize wirelessly or use your phone 
as a wireless modem.

You can create a list of Bluetooth devices 
that you trust to communicate with your 
Treo 750. When communicating with 
trusted devices, your Treo 750 skips the 
discovery process and creates a secure link 
as long as the device is within range. 
Bluetooth range is up to 30 feet (10 meters) 
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in ideal conditions. Performance and range 
are affected by physical obstacles, radio 
interference from nearby electronic 
equipment, and other factors. 

When you configure a headset (see 
Connecting to a Bluetooth® hands-free 
device), the headset is automatically added 
to your trusted device list. Follow the steps 
in this section to add other devices to your 
trusted device list, such as your computer.

Entering basic Bluetooth settings

1 Go to your Today screen, and then tap 
Bluetooth .

2 Check the Turn on Bluetooth box to 
turn on the Bluetooth feature on your 
Treo 750.

3 Check or uncheck the Make the device 

discoverable to other devices box.

4 When this box is checked, this enables 
Bluetooth devices that are not on your 
Trusted Device list to request a 
connection with your device. Your 
device remains accessible to other 
devices until you uncheck the box.

Requesting a connection with another 

Bluetooth device

BEFORE YOU BEGIN To prepare your Treo 
750 to be able to accept a connection from 
a requesting device, enter the basic 
Bluetooth settings as described in Entering 
basic Bluetooth settings.

DID YOU KNOW? Check your battery level before 
establishing a Bluetooth connection. If the 
battery level is low, you can’t make a 
Bluetooth connection.

DID YOU KNOW? The Bluetooth icon on your 
Today screen indicates the status of the 
Bluetooth feature: 

Gray = Bluetooth off.

Blue = Bluetooth on.

White = Connected to a Bluetooth device.

Headset = Call in progress with a Bluetooth 
headset or car kit.
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IMPORTANT Some hands-free devices 
have a predefined passkey; if so, you can 
find the passkey in the documentation for 
that device. Other devices provide a screen 
where you enter a passkey that you make 
up. In either case, you must use the same 
passkey on both your Treo 750 and your 
hands-free device. We recommend that 
where possible, you make up a passkey of 
16 alphanumeric characters (letters and 
numerals only) to improve the security of 
your Treo 750. The longer the passkey, the 
more difficult it is for the passkey to be 
deciphered.

1 Go to your Today screen, and then tap 
Bluetooth .

2 Check the Turn on Bluetooth box to 
turn on the Bluetooth feature on your 
Treo 750.

3 Select the Devices tab, and then select 
New Partnership.

4 Wait for your Treo 750 to search for 
devices and to display the device list.

KEY TERM Partnership Two devices—for 
example, your Treo 750 and a hands-free 
device— that can connect because each 
device finds the same passkey on the other 
device. Once you form a partnership with a 
device, you don’t need to enter a passkey to 
connect with that device again. Partnership is 
also known as paired relationship, pairing, 
trusted device, and trusted pair.
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5 Select the device you want to connect 
with, and then press Next  (right 
action key).

6 Enter an alphanumeric passkey 
between 1 and 16 characters long, and 
then press Next  (right action 
key).

7 If the passkey is not built-in, enter the 
same passkey on the Treo 750 and the 
other Bluetooth device, and then press 
Finish  (right action key)

8 If you’re connecting to a headset or 
hands-free car kit, check the Hands 

Free box, and then press Finish  
(right action key). 

9 Press OK .

You can now communicate with this device 
whenever it is within range and the 
Bluetooth feature on your Treo 750 is 
turned on. The range varies greatly 
depending on environmental factors; 
maximum is about 10 meters or 30 feet.

Accepting a connection from another 

Bluetooth device 

BEFORE YOU BEGIN To prepare your Treo 
750 to be able to accept a connection from 
a requesting device, enter the basic 
Bluetooth settings as described in Entering 
basic Bluetooth settings.

1 Go to your Today screen, and then tap 
Bluetooth .

2 Check the Turn on Bluetooth box to 
turn on the Bluetooth feature on your 
Treo 750.

3 If you have already set up a partnership 
with the transmitting device, your Treo 
750 is ready to receive the info. 

If you haven’t set up a connection, 
check the Make this device 

discoverable to other devices box to 

TIP To delete the established partnership with 
a device, go to the Bluetooth Settings screen 
and select Devices. Highlight the connection 
you want to remove, press and hold Center 
on the 5-way, and then select Delete. The 
deleted device can no longer automatically 
connect with your Treo 750.
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let the device find your Treo 750 and 
request a connection. Enter the same 
passkey on your Treo 750 and on the 
Bluetooth device.

4 When your Treo 750 is receiving info, a 
notification tells you that a transmission 
is in progress. To stop the transmission, 
press Cancel  (left action key); to 
close the notification, press Dismiss 

 (right action key).

Using your device as 
a wireless modem 

Dial-up networking (DUN) is the feature 
that converts your Treo 750 into a modem 
so that you can access the Internet from 
your computer.

You can set up DUN in one of two ways:

• You can use ModemLink (USB).

• If your computer is enabled with 
Bluetooth wireless technology, you can 
set up your device as a wireless modem 
using the built-in Bluetooth technology.

Setting up Modem Link for a USB 

connection

1 Press Start  and select Programs.

2 Select Modem Link.

3 Select the Connection list and select 
USB.

4 Press Activate  (left action key) 
and follow the wizard to set up Modem 
Link.

Creating a DUN connection using 

Bluetooth technology

To configure DUN using Bluetooth 
technology, complete the following 
procedures:

• Create a partnership between your 
device and your computer as described 
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in Requesting a connection with 
another Bluetooth device.

• Setting up your computer for a 
Bluetooth DUN connection

• Accessing the Internet using a 
Bluetooth DUN connection

Setting up your computer for a Bluetooth 

DUN connection

Dial-up networking must be enabled or 
installed on your computer. Follow the 
instructions from the manufacturer of your 
Bluetooth adapter to enable DUN. Your 
wireless service provider may provide 
customized software programs that walk 
you through the DUN setup process. Check 
with your wireless service provider to see 
if such a program is available.

Accessing the Internet using a Bluetooth 

DUN connection

The steps for accessing the Internet on 
your computer may vary depending on your 
operating system and how Bluetooth 
wireless technology is set up on your 
computer—for example, if it is built in 
versus if you are using a wireless 
Bluetooth adapter. If the following 

procedure does not work with your 
computer, check your computer’s 
documentation for how to set up Bluetooth 
technology to access the Internet using a 
DUN connection.

BEFORE YOU BEGIN You may need to 
use a virtual private network (VPN) to 
access corporate email. Check with your 
system administrator for more information.

1 Open the Bluetooth screen on your 
computer and look for the option for 
paired devices. Check your computer’s 
documentation for how to open this 
screen and for the name of the paired 
devices option.

2 Double-click the icon or option 
representing your Treo 750. Your 
computer connects to your Treo 750 
and shows that DUN services are 
available.

3 Double-click the DUN icon.

4 Enter the following in the Dial field: 
*99# or *99***1#. You do not need to 
enter anything in the User Name or 
Password field.
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5 Click Dial. Once the connection is 
successfully established, you can 
browse the Internet on your computer 
or download your email.

6 You may be asked if you want to 
remember this dial text for this 
connection. We recommend that you 
choose to remember the dial text to 
avoid errors and the inconvenience of 
entering it for every session.

7 To verify that you are connected, look 
for a network connection icon in the 
taskbar at the bottom of your computer 
screen. To check the status of the 
connection, right-click the Bluetooth 

network icon.

Terminating a DUN Internet session

To terminate the DUN connection, 
right-click the icon or option representing 
your Treo 750 on your computer, and then 
click Disconnect.
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CHAPTER

8

Your photos, videos, and 
music
Do you have a wallet bulging with photos of friends, family, 
pets, and your most recent vacation?

Are you tired of carrying both your MP3 player and your phone? 

Your Palm® Treo™ 750 smart device solves both problems. You 
can keep your favorite photos right on your Treo 750—videos, 
too. And there's no need to carry an expensive MP3 player; you 
can play music on your Treo 750. Simply transfer songs onto 
your Treo 750 or an expansion card and then listen through 
your stereo headphones.

Benefits

• Never be far from your favorite 
people, places, and songs

• Arrange your photos, videos, and 
songs

• No separate photo viewer, MP3, 
CD, or mini-disc player required
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Camera

Your Treo 750 comes with an easy-to-use, 
built-in, 1.3-megapixel camera with 2x 
digital zoom (camera not included with all 
Treo 750 models). You can use the camera 
to take and view pictures and videos and 
send them to your friends and family. To 
add a personal touch to your Treo 750, use 
your pictures as your Today screen 
background, and as caller ID images, or use 
your videos to create video ringtones.

If your Treo 750 does not have a built-in 
camera, the Camera and Video options do 
not apply to you.

Even if your Treo 750 does not have a 
camera, you can still receive and view 
pictures and videos, and send pictures and 
videos as attachments or multimedia 
messages; see Pictures & Videos. You can 
also personalize your Treo 750 by using a 
picture as a background or by adding a 
picture to a contact; see Adding a contact 
for details. You can also move pictures and 
videos to a computer by synchronizing your 
Treo 750 with your computer. 

Taking a picture

By default, pictures are stored in the My 
Pictures folder on your Treo 750. If you 
want to store your pictures on an 
expansion card, see Customizing your 
Camera settings to change where pictures 
are stored. For information on accessing 
your pictures on your computer, see 
Viewing pictures and videos on your 
computer.

Pictures are captured and stored in 16-bit 
color, JPG format. Resolution settings 
range from 1280 x 1024 to 160 x 120 pixels; 
1.3-megapixels to QQVGA (160 x 120 
pixels). You can change the default setting. 
See Customizing your Camera settings for 
details. 

1 Press Start  and select the Camera 
 icon.
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2 Adjust the position of your Treo 750 
until you see the subject you want to 
photograph on the screen. Your Treo 
750 has a self-portrait mirror next to the 
camera lens on the back of your Treo 
750. Use the mirror when you’re taking 
a picture and you want to be in the 
picture too.

3 (Optional) Adjust any of the following:

Zoom: Press Up , to zoom in or 
Down  to zoom out.

Brightness: Press Right  to increase 
the brightness or Left  to decrease 
the brightness.

Resolution: Press Menu  (right 
action key) and select Resolution to 
change the image quality.

4 (Optional) Set a five-second timer: Press 
Menu  (right action key), select 
Mode, and then select Timer.

5 Press Center  to capture the picture 
or start the timer.

6 Hold your Treo 750 still until the picture 
renders, and then do one of the 
following:

• Press Camera  (left action key) 
to take another picture.

• Press OK  to return to Thumbnails 
View.

Taking pictures in burst mode

Burst mode takes five pictures in quick 
succession, with one button press.

1 Press Start  and select Pictures & 

Videos.

2 Press Camera  (left action key).

3 Press Menu  (right action key) 
and select Mode > Burst.

4 Press Center .

DID YOU KNOW? After three minutes of 
inactivity when previewing an image, the 
camera goes into standby mode. Press any 
key or tap the screen to return to the image 
preview. If the camera goes to standby while 
the recording is paused, the recording is 
stopped and the video clip is saved.



Y O U R  P H O T O S ,  V I D E O S ,  A N D  M U S I C

C A M E R A 135

8

C
H

A
P

T
E

R

Recording a video

Videos can be any length, provided you 
have enough storage space available. By 
default, videos are stored in the My 
Pictures folder on your Treo 750. If you 
want to store your videos on an expansion 
card, see Customizing your Camera 
settings to change where videos are 
stored. For information on accessing your 
videos on your computer, see Viewing 
pictures and videos on your computer.

1 Press Start  and select Pictures & 

Videos.

2 Select Camera .

3 Press Menu  (right action key) 
and select Video Mode.

4 Adjust the position of your Treo 750 
until you see the subject you want to 
record on the screen. Your Treo 750 has 
a self-portrait mirror next to the camera 
lens on the back of your Treo 750. Use 
the mirror when you’re taking a picture 

video and you want to be in the picture 
too.

5 (Optional) Adjust any of the following:

Brightness: Press Right  to increase 
the brightness or Left  to decrease 
the brightness.

Resolution: Press Menu  and 
select Quality to change the video 
resolution.

6 Press Center  to start recording.

7 When you’re finished recording, press 
Stop  (left action key) or Center 

 to stop recording.

8 (Optional) To review the video in 
Windows Media Player Mobile, press 
Thumbnails  (left action key), 
highlight the video, and then press 

TIP If you see a camcorder icon below the 
preview image, video mode is on. To turn on 
the still camera, press Menu and select Still 

Mode. 
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Center . Press OK  to return to 
Thumbnail View. 

Customizing your Camera settings

1 Press Start  and select Pictures & 

Videos.

2 Press Menu  (right action key) 
and select Options.

3 On the General tab, set any of the 
following options:

Use this picture size: Sets the size of 
pictures you send with the Messaging 
application.

When rotating a picture, rotate 90 

degrees: Sets the direction in which 
pictures rotate.

4 Select the Slide Show tab and set any 
of the following options:

During slide shows, optimize for 

viewing: Sets whether pictures are 
optimized for portrait or landscape 
format during slide shows.

Play screensaver when connected to 

my PC and idle for 2 minutes: Sets 
whether the pictures in your My 
Pictures folder are used as a 
screensaver when your Treo 750 is 
connected to your computer and 
ActiveSync® desktop software is not 
running.

TIP If you don’t like a video you recorded, 
delete it. See Deleting a picture or video for 
details.
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5 Select the Camera tab and set any of 
the following options:

Save files to: Specifies whether 
pictures and videos are stored on your 
Treo 750 or on an expansion card.

Type filename prefix: Assigns a name 
to a series of pictures to be captured, 
such as Seattle001, Seattle002, and so 
on.

Still image compression level: 
Sets the default size for newly 
captured pictures.

6 Select the Video tab and set any of the 
following options:

Include audio when recording video 

files: Turns the microphone on and off 
so that you can record videos with or 
without sound.

Time limit for videos: Limits the length 
of videos you record. You can also 
select the No limit option.

7 Press OK  to return to the 
Thumbnail View.

DID YOU KNOW? Videos are captured and 
stored in 3GP format. Video resolution 
settings range from 352 x 288 to 176 x 144 
pixels. 
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Pictures & Videos

Viewing a picture

In addition to viewing the pictures you 
capture with the built-in camera, you can 
view pictures captured on many popular 
digital cameras or downloaded from the 
Internet. Your Treo 750 supports the 
following picture formats:

• JPG 

• PNG

• BMP

• GIF

1 Press Start  and select Pictures & 

Videos.

2 Select the picture you want to view. 

3 Press OK  to return to Thumbnail 
View.

Viewing a video

In addition to viewing the videos you 
capture with the built-in camera, you can 
view videos captured on many popular 
digital cameras streamed from websites. 

Your Treo 750 supports and streams the 
following types of video files:

• MPEG-4

• 3GPP2

• 3GPP

• WMV, WMA, ASF

• RTSP

• SDP Streaming

1 Press Start  and select Pictures & 

Videos.

2 Select the video you want to view. For 
more info on viewing videos, see 
Playing media files on your Treo 750.

3 Press OK  to return to Thumbnail 
View.

Viewing a slide show

1 Press Start  and select Pictures & 

Videos.

2 Press Menu  (right action key) 
and select Play Slide Show. The slide 
show plays automatically.

TIP To view pictures or videos in a different 
folder, select the Show list in the upper-left, 
and then select the album you want to view. 
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3 Press Center  to display the slide 
show toolbar, which you can use to 
Rotate , Play , Pause , Reverse 

, Forward , and Stop  the slide 
show.

Sending a picture or video

You can send a picture or video to other 
picture-enabled mobile Treo 750 devices or 
to an email address as an attachment.

You cannot send copyrighted pictures or 
videos that appear with a Lock icon in 
Thumbnail View.

1 Press Start  and select Pictures & 

Videos.

2 Highlight the picture or video you want 
to send. 

3 Press Menu  (right action key) 
and select Send.

4 Select the email or MMS account you 
want to use to send the picture or 
video.

5 When the Messaging application opens, 
address and send the message. 
(See Creating and sending a multimedia 
message for details.)

Creating a video ringtone

You can save a video that you record as a 
ringtone.

1 Press Start  and select Pictures & 

Videos.

2 Highlight the video you want to use as a 
ringtone.

3 Press Menu  (right action key) 
and select Save to Contact Ring Tone.

4 Select the contact to whom you want to 
assign the ringtone.

Organizing pictures and videos

You can move or copy pictures and videos 
to other folders or between your Treo 750 
and an expansion card.

1 Press Start  and select Pictures & 

Videos.

2 Highlight the picture or video you want 
to move or copy.

3 Do one of the following:

• To move the picture or video to 
another location, press Menu  
(right action key) and select Edit > 
Cut.
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• To keep the picture or video in two 
locations, press Menu  (right 
action key) and select Edit > Copy.

4 Select the Show list in the upper-left, 
and select the location where you want 
to place the picture or video you 
selected in step 3.

5 Press Menu  (right action key) 
and select Edit > Paste.

You can also view a specific folder or 
expansion card and arrange the pictures 
and videos by name, date, or size.

1 Press Start  and select Pictures & 

Videos.

2 Select the Show list in the upper-left, 
and then select the folder you want to 
view.

3 Select the Sort By list in the upper-right, 
and then select the sort method: 
Name, Date, or Size.

Using a picture as the Today screen 

background

1 Press Start  and select Pictures & 

Videos.

2 Highlight the picture you want to use.

3 Press Menu  (right action key) 
and select Set as Today Background.

4 Select the Transparency level list and 
select the appropriate level. Use a 
higher percentage for a more 
transparent picture and a lower 
percentage for a more opaque picture.

5 Press OK  to return to Thumbnail 
View.

Editing a picture

For more extensive edits, just download 
your picture or video to your computer and 
edit it in your favorite graphics program. 
Then sync the picture or video back on your 
Treo 750.

1 Press Start  and select Pictures & 

Videos.

2 Highlight the picture you want to edit.

3 Press Menu  (right action key) 
and select Edit.

4 Do any of the following: 

• To rotate a picture 90 degrees 
counterclockwise, select Rotate.

• To crop a picture, press Menu  
(right action key) and select Crop. Tap 
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and drag the stylus to highlight the 
area to crop. Tap outside the box to 
stop cropping. 

• To adjust the brightness and contrast 
levels of a picture, press Menu  
(right action key) and select 
AutoCorrect. 

• To undo an edit, press Menu and 
select Undo.

• To cancel all unsaved edits you made 
to the picture, select Revert to 

Saved.

Deleting a picture or video

1 Press Start  and select Pictures & 

Videos.

2 Highlight the picture or video you want 
to delete.

3 Press Menu  (right action key) 
and select Delete.

4 Select Yes. 

Viewing pictures and videos on your 

computer

BEFORE YOU BEGIN You must install 
ActiveSync® desktop software from the 
Windows Getting Started Disc (see 

Installing the desktop synchronization 
software) and select the option to 
synchronize media (see Changing which 
applications sync).

When you synchronize your Treo 750, your 
pictures and videos are copied to your 
desktop computer. You can view the 
pictures and videos, and you can also send 
them to friends using your desktop email 
application.

To find all synchronized pictures and 
videos, look in C:\Documents and 
Settings\<Username>\My Documents\Treo 
My Documents.

IMPORTANT You must have QuickTime 
Player version 6.5 or later installed on your 
computer to play videos recorded by your 
Treo 750. You can download the videos 
from an expansion card or you can click the 
video thumbnail after synchronizing the 
files.

DID YOU KNOW? You can also download 
animated GIF files and view them in Internet 
Explorer Mobile. 
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Windows Media 
Player Mobile

Windows Media Player Mobile can play 
music, audio, and video files that are 
stored on your Treo 750 or on an expansion 
card (sold separately) in any of the 
following file formats:

• WMA 

• WMV 

• MP3

•  3GP

You can listen to these music, audio, and 
video files through the speaker on the back 
of your Treo 750 or through stereo 
headphones.

Transferring media files to your Treo 750

Use the Sync feature in the desktop 
version of Windows Media Player 10 to 
transfer digital music, audio, video, and 

playlist files from your computer to an 
expansion card or your Treo 750. Using 
Sync ensures that the files are transferred 
correctly.

BEFORE YOU BEGIN Do the following:

• Be sure you have Windows Media 
Player 10 or later installed on your 
computer. Windows Media Player 10 
must be installed on your computer 
before you install the ActiveSync 
desktop software. See My video and 
music files won’t sync.

• To sync media files with your computer, 
set the Media sync option on your Treo 
750. See Setting synchronization 
options.

1 On your computer, open Windows 
Media Player 10.

2 (Optional) Insert a 32MB or larger 
expansion card into your Treo 750.

3 Connect your Treo 750 to your 
computer with the USB sync cable.

4 When the Device Setup Wizard opens 
on your computer, click Automatic.

5 Check the Customize the playlists 

that will be synchronized box.

TIP For tips on using the desktop version of 
Windows Media Player, go to the Help menu 
in Windows Media Player on your computer.



Y O U R  P H O T O S ,  V I D E O S ,  A N D  M U S I C

W I N D O W S  M E D I A  P L A Y E R  M O B I L E 143

8

C
H

A
P

T
E

R

6 Select the playlists you want to sync.

7 Click Finish to begin the transfer. The 
next time you connect your Treo 750 to 
your computer while the desktop 
version of Windows Media Player 10 is 
running, synchronization starts 
automatically. Be patient; transferring 
media files to an expansion card can 
take several minutes.

Playing media files on your Treo 750

1 Press Start  and select Windows 

Media.

2 Press Menu  (right action key) 
and select Library. 

3 Select the Library list in the upper-left, 
and then select the library you want to 
use. If you can’t find a media file on your 
expansion card, update the library (see 
Working with libraries).

4 Select the item you want to play (such 
as a song, album, or artist name).

5 Press Play  (left action key). See 
the next page for playback controls.

6 Press Menu  (right action key) 
and select any of the following during 
playback:

Library: Displays the Library screen so 
you can select a different song to play.

Shuffle/Repeat > Shuffle: Plays the 
Now Playing playlist in random order. A 
check appears next to this command 
when it is on.

Shuffle/Repeat > Repeat: Plays the 
Now Playing playlist repeatedly. A check 
appears next to this command when it 
is on.

Stop: Ends playback.

Use any of the following onscreen controls 
during playback:

 or Center  plays the current file.

DID YOU KNOW? If you close the Windows 
Media Player Mobile window, your music 
continues to play in the background.

TIP  To play a file that is not in a library, go to 
the Library screen, press Menu, and select 
Open File.

TIP To repeat the current song, press Menu 
and select Repeat Song.
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 or Center  pauses the current file.

 or Left  skips to the beginning of the 
current file or to the previous file.

 or Right  skips to the next file.

 sets the point from which playback 
begins. Tap and drag the slider to 
change the current position.

 or Volume button increases the 
volume level.

 or Volume button decreases the 
volume level.

 turns the sound on or off.

 displays a video using the full 
screen.

 displays a website where you can 
find music and videos to play.

 indicates the rating of the current 
file. Select the star to change the rating.

Working with libraries

A library represents each of the storage 
locations available to Windows Media 
Player Mobile, so you should have two 
libraries: My Device and My Storage Card. 
Each library contains links to the media 
files in that location. Windows Media 
Player Mobile usually updates the My 
Device library automatically, but you must 
manually update the My Storage Card 
library.

DID YOU KNOW? You can play streaming files 
from the web. To play a MMS (Microsoft 
Media Streaming) file, press Menu on the 
Library screen, and then select Open URL. 
Select URL and enter the website address, or 
select History and select a site you’ve visited 
before. To play a RTSP or SDP streaming file, 
using the Streaming Media application. Press 
Start, select Programs, and then select 
Streaming Media. Select Connect and add 
the URL.

TIP If you don’t see a media file that you 
added, manually update the library.
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1 Press Start  and select Windows 

Media.

2 Press Menu  (right action key) 
and select Library.

3 Press Menu  (right action key) 
and select Update Library.

4 Wait for the files to be added, and then 
select Done.

Working with playlists

A playlist is a list of media files that play in 
a specific order. You can use playlists to 
group audio files together or video files 
together for convenient playback. For 
example, in the desktop Player, you can 
create a playlist of upbeat songs for when 
you exercise and a playlist of soothing 

songs for a long flight. When you 
synchronize, your favorite playlists are 
automatically copied to your Treo 750. Your 
playlists appear in your libraries (in the My 
Playlists category).

A temporary playlist, called Now Playing, 
appears on the Now Playing menu. It lists 
the currently playing file, as well as any 
files that are queued up to play next. You 
can add to, modify, or clear the files on the 
Now Playing playlist.

1 Go to the Now Playing screen:

• If you are on the Library screen, 
select the Now Playing category.

• If you are on the Playback screen, 
select Now Playing.

2 Do any of the following:

TIP To delete an item from a library: Highlight 
the item and then press and hold Center on 
the 5-way to open the shortcut menu. Then 
select Delete from Library. Select Yes to 
confirm the deletion.
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• To move a file up or down one slot, 
highlight the file, and then select 
Move Up  or Move Down .

• To add a file, select Add , press 
Menu  (right action key), and 
then select Queue Up.

• To delete a file from the playlist, 
highlight the file, and then select 
Remove .

• To view more info about a file, 
highlight the file and select 
Properties .

• To remove all items from the Now 
Playing playlist, press Menu  
(right action key) and select Clear 

Now Playing.

Customizing Windows Media Player 

Mobile

1 If necessary, go to the Playback screen 
by pressing OK  to close the current 
screen.

2 Press Menu  (right action key) 
and select Options.

3 On the Playback tab, set any of the 
following options:

Show time as: Sets whether the time 
remaining or time elapsed appears in 
the Playback screen.

TIP You can also move a file in the Now 
Playing playlist by tapping and dragging it to a 
new position.

DID YOU KNOW? If you move files between your 
Treo 750 and an expansion card, be sure to 
update your libraries, or you won’t be able to 
see the files in their new location.

DID YOU KNOW? You can also customize your 
Treo 750 so that pressing and holding the Side 
button on the side of your Treo 750 opens 
Windows Media Player Mobile. See 
Reassigning buttons for details.
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Pause playback while using another 

program: Sets whether playback 
continues if you switch to another 
application.

Resume playback after a phone call: 

Sets whether playback continues after 
you finish a phone call.

4 Select the Video tab and set any of the 
following options:

Play video in full screen: Sets whether 
videos automatically play in full screen 
format.

Scale to fit window: Sets whether 
videos are automatically scaled to fit the 
Playback screen.

5 Select the Network tab and set the 
following options:

Protocol: Enables and disables the 
available protocols. You must select at 
least one protocol. You can also set a 
UDP Port.

Internet Connection Speed: Specifies 
the speed of your network connection, 
and specifies whether you want the 
device to detect connection speed.

6 Select the Library tab and set whether 
you want to see the Library or Playback 
screen when you open Windows Media 
Player Mobile.

7 Select the Skins tab and select 
Previous or Next to set the player’s 
background.

8 Select the Buttons tab to change any of 
the available button settings:

• To assign a button, highlight the item 
you want to set, select Assign, and 
then press the button you want to use 
for that item.

• To restore an item’s factory setting, 
highlight the item and select Reset.

• To unassign an item, highlight the 
item and select None.

9 Press OK .
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Your personal information 
organizer
Say good-bye to paper calendars and throw away those 
scribbled to-do lists. Your Palm® Treo™ 750 smart device is all 
you need to organize your personal information and keep it with 
you wherever you go.

You never lose your information, even if your battery is 
completely drained. All your personal information is backed up 
each time you synchronize, and your information is kept private 
when you use the security features available on your Treo 750. 
Also, you can easily share info with others electronically.

Benefits

• Track current, future, and past 
appointments

• Make to-do lists that get done 

• Set reminders for appointments, 
birthdays, important tasks, and 
more
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Contacts

Adding a contact

1 Press Start  and select Contacts.

2 Press New  (left action key).

3 Use the 5-way navigator to move 
between fields as you enter 
information.

Here are some helpful tips for entering 
info:

• To enter complete name or address 
(work, home, or other) information, 
tap the arrow on the right side of the 
line and enter the information in the 
box that appears. When finished, tap 
outside the box to accept the 
information and close the box.

• To add a caller ID picture that displays 
when that person calls, select 
Picture, and then select Camera and 
take a picture (camera model only), or 
select an existing picture from 
Thumbnails view. 

TIP Take some time to scroll down through all 
the fields in a new contact. There are fields for 
multiple addresses, phone numbers, email 
addresses, and much more.

TIP Be sure to enter mobile numbers and 
email addresses in the correct fields so that 
Inbox and Messaging can find this info when 
you address a message and Calendar can find 
your contacts when you want to invite them 
to meetings.
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• To assign the entry to one or more 
categories, select Categories and 
then check the categories under 
which you want this entry to appear.

4 To add a note to an entry, select the 
Notes tab.

5 To assign a ringtone to the entry, select 
Ring tone and select a tone.

6 After you enter all the information, press 
OK . 

Viewing or changing contact information

1 In the Contacts list (viewed by name), 
begin entering one of the following for 
the contact you want to view or edit:

• First name

• Last name

• First initial and last initial separated by 
a space

• Phone number

2 Select the entry you want to open.

3 Press Menu  (right action key) 
and select Edit.

4 Make changes to the entry as 
necessary.

5 Press OK .

Deleting a contact

1 In the Contacts list, highlight the 
contact you want to delete.

2 Press Menu  (right action key) 
and select Delete Contact.

3 Select Yes.

DID YOU KNOW? You can find a contact by 
company name. Press Menu (right action key) 
and select View By > Company. Select a 
company name to see the contacts who work 
there.

TIP To view a particular group of contacts, 
press Menu (right action key), select Filter, 
and then select the category you want to 
view.
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Customizing Contacts

1 Go to the Contacts list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Show alphabetical index: Displays the 
alphabet at the top of the Contacts list. 
You can use this index to find a contact.

Show contact names only: Enables 
you to fit more names on the Contacts 
list by hiding everything but the 
contact’s name.

Area code: Specifies the default area 
code for new contact entries.

4 Press OK .

Finding a contact in an online address 

book

In addition to having contacts on your 
device, you can also access contact 
information from your organization’s online 
address book or Global Address List (GAL).

BEFORE YOU BEGIN Do the following:

• Make sure you are accessing an 
Exchange Server 2003 upgraded to 
Service Pack 2.

• Add access to the online address book 
to your Treo 750. See Adding an online 
address book.

• After adding the online address book, 
you must synchronize with the 
Exchange Server in order for the Find 
Online option to appear.

1 Press Start  and select Contacts.

2 Press Menu  (right action key) 
and select Find Online. 

Calendar

Displaying your calendar

1 Press Start  and select Calendar.

2 Press Menu  (right action key) 
and select View.
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3 Select one of the following views:

Agenda: Shows your daily schedule in 
list format. Upcoming appointments are 
bold; past appointments are dimmed.

Day: Shows your daily schedule in 
day-planner format.

Week: Shows your schedule for an 
entire week.

Month: Shows your schedule for a 
whole month. 

 A morning appointment

 An afternoon appointment

 Both morning and evening 
appointments 

 An all-day event

Year: Shows a calendar for a six-month 
period.

4 Use the 5-way to move to another day, 
week, month, or year (based on the 
current view).

Creating an appointment

1 Press Start  and select Calendar.

2 Press Menu  (right action key) 
and select New Appointment.

3 Enter a subject (description) and a 
location.

4 Select Starts and select the starting 
date and time.

5 Select Ends and select the ending date 
and time.

6 Press OK .

TIP Don’t confuse the view name displayed 
above the left action key with the current 
view. The left action key displays the name of 
the next view you see when you press the 
key.
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Adding an alarm reminder to an event

1 Create an event, and then select it.

2 Press Edit  (left action key).

3 Select Reminder, and then select 
Remind Me.

4 Enter the number of minutes, hours, 
days, or weeks before the event you 
would like to receive the alarm.

5 Press OK .

Creating an untimed event

An untimed event, such as a birthday, 
anniversary, or vacation, does not occur at 
a particular time. These events appear as 
banners at the top of your calendar; they 
don’t occupy blocks of time. For example, 
“Submit Final Draft” in the screenshot 
shown here is an untimed event.

1 Press Start  and select Calendar.

2 Press Menu  (right action key) 
and select New Appointment.

3 Enter a subject (description).

TIP To pencil in an appointment, open the 
appointment, select Status, and then select 
Tentative.

Type of time units

Number of time units

DID YOU KNOW? An untimed event can last 
longer than a day.
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4 Select the starting and ending dates.

5 Select All Day, and then select Yes.

6 Press OK .

Scheduling a repeating appointment

1 Create an appointment or untimed 
event, and then select it.

2 Press Edit  (left action key).

3 Select Occurs, and then select a repeat 
pattern. To create a repeat pattern, 
select Edit pattern and follow the 
onscreen instructions.

4 Press OK .

Sending a meeting request

You can email meeting invitations to 
contacts who use Microsoft Office 
Outlook® or Outlook Mobile.

BEFORE YOU BEGIN Create contact 
entries with email addresses for the people 
you want to invite to a meeting. You can’t 

access contact entries without email 
addresses from your calendar.

1 Create an event, and then select it.

2 Press Edit  (left action key).

3 Select Attendees, and then select the 
name of the contact you want to invite. 
To invite other attendees, select Add 
and select the names.

4  Press OK .

The next time you synchronize, the 
meeting request is sent to the attendees. 
When attendees accept your meeting 
request, the meeting is automatically 
added to their schedules. When you 
receive their response, your calendar is 
updated as well.

TIP To enter a birthday or an anniversary, 
create an untimed event that repeats every 
year.

DID YOU KNOW? If you are using an Exchange 
Server 2003 with Service Pack 2, you can use 
your corporate Global Address List to find 
contact information for an attendee. Select 
Attendees, press Menu (right action key), and 
then select Find Online. Enter the name of 
the attendee and select Find.
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Marking an event as sensitive

If other people have access to your 
Microsoft Office Outlook calendar on your 
computer and you don’t want them to see 
an appointment, you can mark that 
appointment as private to hide it from other 
Microsoft Office Outlook users.

1 Create an event, and then select it.

2 Press Edit  (left action key).

3 Select Sensitivity, and then select one 
of the following:

Private: Displays the event on your Treo 
750 and on your computer. Meeting 
attendees or recipients see “Please 
treat this as Private” near the top of an 
open appointment. If you sync with 
Exchange Server, other users who can 
access your folders can’t see your 
private events; they see private events 
as unavailable time slots.

Personal: Displays the event on your 
Treo 750 and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Personal” near the 
top of an open appointment.

Confidential: Displays the event on 
your Treo 750 and on your computer. 
Meeting attendees or recipients see 
“Please treat this as Confidential” near 
the top of an open appointment. 

4 Press OK .

Organizing your schedule

Use categories to view various types of 
events.

1 Create an event, and then select it.

TIP If you don’t see an option on the screen, 
press Down on the 5-way to scroll to other 
options. For example, when editing an event, 
you don’t see the Sensitivity option until you 
scroll toward the bottom of the entry.
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2 Press Edit  (left action key).

3 Select Category, and then check the 
categories that apply to this event. 
To add a new category, press 
New  (left action key), enter the 
category name, and then press OK .

4 Press OK  two more times.

5 After you assign events to categories, 
press Menu  (right action key) 
and select Filter.

6 Select the type of events you want to 
view.

Deleting an event

1 Highlight the event you want to delete.

2 Press Menu  (right action key) 
and select Delete Appointment.

3 Select Yes.

Customizing Calendar

1 Press Menu  (right action key) 
and select Options.

2 On the General tab, set any of the 
following options:

1st day of week: Specifies Sunday or 
Monday as the first day of the week for 
all Calendar views.

Week view: Specifies whether five, six, 
or seven days appear in Week View.

Show half hour slots: Specifies 
whether time slots appear in hour or 
half-hour increments in Day View and 
Week View.

Show week numbers: Specifies 
whether week numbers (1–52) appear 
in Week View.

TIP Wonder why you’re not seeing all the 
events in your day? Check to make sure that 
the filter is set to All Appointments.
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3 Select the Appointments tab and set 
any of the following options:

Set reminders for new items: 

Specifies whether a reminder is 
automatically added to new events and 
how long before the event the reminder 
appears. You can override this setting 
for individual events.

Show icons: Specifies which icons 
appear next to events. 

 The event has a reminder.

 The event repeats in a specified 
pattern.

 The event has a note attached.

 A location has been assigned to the 
event.

 The event is a meeting.

 The event is marked private.

Send meeting requests via: Specifies 
the messaging method used to send 
meeting requests: email, MMS, or 
SMS.

4 Press OK .

Tasks

You can use Tasks to remind you of tasks 
you need to complete and to keep a record 
of completed tasks.

Adding a task

1 Press Start  and select Programs.

2 Select Tasks .

3 Press New  (left action key).

TIP Not all icons appear in all Calendar views.

TIP You can also add a task by selecting the 
Tasks entry bar at the top of the task list 
screen.
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4 Enter a description of the task in the 
Subject field.

5 Set any of the following:

Priority: Specifies the priority level for 
this task. Later you can arrange your 
tasks based on the importance of each 
task.

Status: Indicates whether the task is 
now completed.

• Starts: Specifies when the task 
begins.

• Due: Specifies the due date for the 
task.

• Occurs: Indicates if the task repeats 
at regular intervals and how often it 
repeats.

• Reminder: Sets an alarm for this task 
and indicates when you want to be 
reminded.

• Categories: Assigns the task to one 
or more categories.

Sensitivity: Marks this task as Normal, 
Personal, Private, or Confidential.

Notes: Enables you to enter additional 
text for the task.

6 Press OK .

Checking off a task

1 Select the task you want to check off.

2 Press Edit  (left action key).

3 Select Status and select Completed.

4 Press OK .
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Organizing your tasks

1 In the Tasks list, press Menu  
(right action key) and select Filter.

2 Select which tasks you want to view: 
All Tasks, Recently Viewed, 
No Categories, Active Tasks, 
Completed Tasks, or a specific 
category, such as Business or Personal.

3 Press Menu  (right action key) 
and select Sort By.

4 Select the sort method: Status, 
Priority, Subject, Start Date, or 
Due Date.

Deleting a task

1 Highlight the task you want to delete.

2 Press Menu  (right action key) 
and select Delete Task.

3 Select Yes.

Customizing Tasks

1 Go to the Tasks list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Set reminders for new items: 

Automatically adds a reminder to new 
tasks. The default reminder is set to 
8:00 on the morning the task is due. You 
can override this setting for individual 
tasks.

Show start and due dates: Displays 
task start and due dates in the Tasks 
list.

Show Tasks entry bar: Displays the 
Tasks entry bar at the top of the Tasks 
list.

4 Press OK .

Notes

Notes are a great way to capture thoughts, 
questions, and meeting notes on your Palm 
Treo 750. You can also create a voice note 
or add a recording to an existing note.

TIP You can also mark a task complete by 
tapping the check box next to the task on the 
Tasks list.

DID YOU KNOW? Overdue tasks appear in red.
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BEFORE YOU BEGIN To take advantage of 
all the sync features available in the Notes 
application, install the desktop 
synchronization software from your 
Windows Mobile Getting Started Disc.

Creating a note

1 Press Start  and select Programs. 

2 Select Notes .

3 Press New  (left action key).

4 Do one of the following:

• Type the text with the keyboard.

• Write the text with the stylus.

• Draw a sketch with the stylus, 
crossing at least three ruled lines.

5 Press OK .

Creating a voice note

1 Press Start  and select Programs.

2 Select Notes .

3 To add a voice recording to an existing 
note, open the note to which you want 
to add the recording.

4 If the voice note controls are not visible 
at the bottom of the screen, press 
Menu  (right action key) and 
select View Recording Toolbar. 

5 Tap the Record  icon.

6 Speak into the microphone on your Treo 
750, or hold it close to another sound 
source.

7 When you have finished recording, tap 
the Stop  icon. A Recording icon  
appears in the note or note list, 

Voice 
note 
controls
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depending on where you recorded the 
note.

8 Press OK .

Creating a note from a template

1 Go to the Notes list.

2 Select the Show list in the upper-left, 
and then select Templates.

3 Open the template you want to use.

4 Enter the information.

5 Press OK .

6 Rename the note and move it to the 
appropriate folder. See Organizing your 
notes for details.

Organizing your notes

You can rename your notes, move notes to 
another folder, and move notes between 
your Treo 750 and an expansion (storage) 
card.

1 Go to the Notes list and highlight a note 
you want to move.

2 Press Menu  (right action key) 
and select Rename/Move.

3 Select Name, and then enter a new 
name for the note.

4 Select Folder, and then select the folder 
in which you want to store the note.

5 Select Location, and then select Main 

memory or Storage Card.

6 Press OK .

DID YOU KNOW? You can add several voice 
notes within a single note.

TIP To play a recording, select the voice note 
in the Notes list or open the note containing 
the recording and tap the Recording icon. Tap 
the controls at the bottom of the screen to 
control playback and volume.

TIP To create a new template, open the note 
you want to save as a template. Press Menu 
(right action key) and select Rename/Move. 
Select Name, and then enter a name for the 
template. Select the Show list, and then 
select Template. Press OK.
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Deleting a note

1 Go to the Notes list and highlight the 
note you want to delete.

2 Press Menu  (right action key) 
and select Delete.

3 Select Yes.

Customizing Notes

1 Go to the Notes list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Default mode: Makes the default entry 
mode either Writing or Typing. The 
default is Typing; if you change it to 
Writing, you can write notes directly on 
the screen using the stylus.

Default template: Specifies the default 
template for new notes.

Save to: Indicates the default location 
where new notes are stored.

Record button action: Specifies what 
happens when you press the Side 
button to record a voice note while in 
another application: whether the Notes 
application opens or whether you stay 
in the current application.

4 Press OK .

TIP To create a new folder, go to the Notes list, 
select the Show list in the upper-left, and then 
select Add/Delete. Select New, enter a name 
for the folder, and then press OK.
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Your Microsoft Office tools
Your Palm® Treo™ 750 smart device enables you to take your 
office with you—including your Microsoft Office files. With 
Microsoft Office, you can carry, create, view, and edit Microsoft 
Word and Excel files directly on your Treo 750. You can also 
view, carry, and manage PowerPoint files on your Treo 750. You 
can keep updated copies of the files on both your Treo 750 and 
your computer so that you can work on them in the most 
convenient location any time.

Benefits

• Manage Word, Excel, and 
PowerPoint files on your Treo 750

• Improve productivity by taking 
important docs, spreadsheets, and 
presentations with you
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Synchronizing your 
Microsoft Office files

You can edit files on your computer or on 
your Treo 750 and then synchronize your 
files with your computer. To synchronize 
Microsoft Office files with your computer, 
you must set the Files sync option; see 
Setting synchronization options. The files 
are stored in your Files folder on your 
computer.

To copy a file from your computer to your 
Treo 750, open My Computer or 
Windows Explorer on your computer, 
copy the file into the Mobile Device folder, 
and then sync.

Word Mobile

You can create and edit documents and 
templates and save them as DOC, RTF, 
TXT, and DOT files. You can also edit 
Microsoft Office Word documents and 
templates that you create on your 
computer. However, keep in mind that 

some of the information and formatting 
may be lost when you save the document 
on your Treo 750.

The following features are not supported in 
Word Mobile:

• Backgrounds.

• Bidirectional text.

• Document protection.

• Metafiles.

• Artistic page borders. Lined page 
borders are supported.

• Password-protected files. Remove 
password protection on your computer 
before opening the file on your Treo 
750.

• Shapes and text boxes.

• Smart tags.

DID YOU KNOW? If you have a PDF file (.pdf), 
you can view the file using Picsel PDF Viewer. 
Press Start, select Programs, and then select 
PDF Viewer.
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The following features are partially 
supported in Word Mobile:

• Picture bullets. Regular bullets are 
supported.

• Revision marks. Documents appear as 
though all revisions were accepted; if 
the document is saved, revision marks 
are lost.

• Table styles. Some or all of the 
formatting is lost if the document 
is saved.

• Underline styles. Unsupported styles 
are mapped to one of the four 
supported styles: regular, dotted, wavy, 
or thick/bold/wide.

• Legacy Pocket Word files. You can open 
PSW files, but if you edit a file, you 
need to save it in DOC, RTF, TXT, or DOT 
format.

The following features are not supported 
on your Treo 750, but they remain in the file 
so that when you open the file on your 
computer, they appear as expected: 

• Fonts and font sizes. Original fonts are 
listed on your Treo 750 and are mapped 
to the closest font available.

• Footnotes, endnotes, headers, and 
footers.

• Lists. Indented lists are mapped to the 
closest indentation level supported by 
Word Mobile.

• Page breaks. Although not displayed, all 
page breaks, except a break placed at 
the end of a document, are retained in 
the document.

Creating a document

1 Press Start  and select Programs.

2 Select Word Mobile .

3 Press New  (left action key).

4 Enter the text of the document.

5 Press OK  to save the file. When you 
save a new document, it is 
automatically named after the first 
several words in the file.

Opening an existing document

1 Press Start  and select Programs.

2 Select Word Mobile .

3 In the document list, select the 
document you want to open.
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Creating a document from a template

1 Go to the documents list.

2 Select the Show list in the upper-left, 
and then select Templates. If you don’t 
see Templates in the Show list, select 
More Folders to access this folder.

3 Open the template you want to use and 
enter the information.

4 Press OK .

5 Rename the document and move it to 
the appropriate folder. See Organizing 
your documents for details.

Finding or replacing text in a document

1 Open the document containing the text 
you want to find.

2 Press Menu  (right action key) 
and select Edit > Find/Replace.

3 Select Find what and enter the text you 
want to find.

4 (Optional) Check the Match case box to 
find text that matches the capitalization 
in the text you entered step 3.

5 (Optional) Check the Match whole 

words only box to find only full words 
that match the text you entered in 
step 3.

6 Select Find to locate the first instance 
of the text you entered in step 3, or 
select Replace and enter the 
replacement text.

7 Select Next to find the next instance of 
the text, or select Replace to replace it. 
To replace all instances of the text, 
select Replace All.

8 When you see a message that the 
search is done, press OK .

Moving or copying text

1 Open the document containing the text 
you want to move or copy.

2 Highlight the text you want to move or 
copy.

TIP To zoom in or out, press View, select 
Zoom, and then select the zoom level.

TIP To create a new template, open the 
document you want to save as a template. 
Press Menu and select Rename/Move. 
Select Name, and then enter a name for the 
template. Select the Show list, and then 
select Template. Press OK.
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3 Press Menu  (right action key) 
and select Copy to copy the text, or 
select Cut to move the text.

4 Open the document where you want to 
insert the text and position the insertion 
point where you want the text to 
appear.

5 Press Menu  (right action key) 
and select Paste.

Saving a copy of a document

NOTE If a document was previously saved 
on a computer, any unsupported formatting 
may be lost when you save the file.

1 Open the document you want to copy.

2 Press Menu  (right action key) 
and select File > Save As.

3 Select Name and enter a new name for 
the file.

4 Select the Folder list, and then select 
the folder where you want to save the 
file.

5 Select the Type list, and then select the 
format in which you want to save the 
file.

6 Select the Location list, and then select 
whether you want to store the file on 
your Treo 750 or an expansion card.

7 Select Save.

Formatting text

1 Open the document you want to 
format.

2 Highlight the text you want to format.

3 Press Menu  (right action key) 
and select Format > Font.

4 Set any of the following options for the 
highlighted text:

Font: Specifies the typeface.

Font color: Specifies the color.

Size: Specifies the point size. 

Bold: Indicates whether the text 
appears normal or thick. 

Italics: Indicates whether the text 
appears upright or slanted.

Underline: Indicates whether the text 
appears with an underscore.

Highlight: Indicates whether the text 
appears with a yellow highlight.
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Strikethrough: Indicates whether the 
text appears with a line through it.

5 Press OK  to return to the document.

Formatting paragraphs and lists

1 Open the document you want to 
format.

2 Position the insertion point in the 
paragraph you want to format.

3 Press Menu  (right action key) 
and select Format > Paragraph.

4 Set any of the following options:

Alignment: Aligns the text with the left, 
right, or center of the paragraph.

List: Creates a bulleted or numbered 
list.

Indentation: Changes the paragraph 
margins.

• Left: Sets the left margin for the 
entire paragraph.

• Right: Sets the right margin for the 
entire paragraph.

• Special: Lets you indent the first line 
or set a hanging indent.

• By: Sets the size of the Special 
indentation.

5 Press OK  to return to the document.

Checking spelling in a document

1 Open the document you want to check.

2 Press Menu  (right action key) and 
select Tools > Spelling. To check the 
spelling of specific text, highlight it 
before you select the Spelling 
command.

3 If an unknown or misspelled word is 
encountered, do one of the following:

• Select the correct word in the list if 
the word is spelled incorrectly.

• Select Ignore if the word is spelled 
correctly.

• Select Add to add a new word to the 
spelling dictionary.

TIP You can also use the Formatting toolbar to 
create a list and to align text. To indent text in 
lists, you must use the Formatting toolbar. 
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Organizing your documents

You can rename your documents, move 
your documents to another folder, and 
move your documents between your Treo 
750 and an expansion (storage) card.

1 Go to the documents list.

2 Highlight a file.

3 Press Menu  (right action key) 
and select Rename/Move.

4 Select Name, and then enter a new 
name for the document.

5 Select the Folder list, and then select 
the folder you want to move the 
document to.

6 Select the Location list, and then select 
Main memory or Storage card.

7 Press OK .

8 Select the Show list in the upper-left, 
and then select the folder you want to 
view.

9 Select the Sort By list in the upper-right, 
and then select the sort method.

Deleting a document

1 Go to the documents list.

2 Highlight the document you want to 
delete.

3 Press Menu  (right action key) 
and select Delete.

4 Select Yes.

Customizing Word Mobile

1 Go to the document list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Default template: Sets the default 
template for new documents.

Save to: Sets the default location 
where new documents are stored.

TIP To create a new folder, go to the 
documents list, select the Show list in the 
upper-left, and then select the Add/Delete 
tab. Select New, enter a name for the folder, 
and then press OK.

TIP When you go to a folder, you can easily 
search your documents by sorting by type.
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Display in list view: Sets the types of 
files that appear in the documents list.

4 Press OK .

PowerPoint Mobile

With PowerPoint Mobile, you can open and 
view slide show presentations created on 
your computer. Many presentation 
elements such as slide transitions, 
animations, and URL links are also 
supported. Microsoft® Office PowerPoint® 
features not supported on your Treo 750 
include the following: 

• Notes written for slides 

• Rearrangement or editing of slides

• Files created in PPT format earlier than 
Microsoft PowerPoint ‘97

• HTML files in HTM and MHT formats

Playing a presentation

NOTE If a presentation is set up as a timed 
slide show, the slides advance 
automatically. Presentations pause during 
zooming.

1 Press Start  and select Programs.

2 Select PowerPoint Mobile .

3 In the presentation list, highlight the 
presentation you want to play.

4 Press Center .

5 Do any of the following:

• Press Right  to advance to the next 
slide or Left  to view the previous 
slide.

• Press Menu  (right action key), 
select Go to Slide, and select the 
slide you want to view.

• Select Next or Previous to play 
animations.

• Press Menu  (right action key), 
select Zoom In, and then select  to 
zoom in or  to zoom out. To scroll 
within the current slide, tap and drag 
the slide. To return to the slide show, 
select .

TIP To copy a file from your computer to your 
Treo 750, open My Computer or Windows 
Explorer on your computer, copy the file into 
the Mobile Device folder, and then sync.
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• Press Menu  (right action key) 
and select End Show.

Setting presentation playback options

1 Open the presentation for which you 
want to change the settings.

2 Press Menu  (right action key) 
and select Show Options.

3 On the Orientation tab, select the 
orientation you want. To select the 
orientation that best fits your Treo 750 
screen, select Default.

4 Select the Playback tab, and check the 
Override playback options for all files 
box.

5 Set any of the following options:

Show without animation: Turns off 
builds and other animations.

Show without slide transition: Turns 
off transition effects between slides.

Use slide timings, if present: Enables 
the timings recorded with each slide in 
a presentation. If a presentation is set 
up as a timed slide show, the slides 
advance automatically. Presentations 
pause during zooming.

Loop continuously: Advances to the 
first slide after playing the last slide in a 
presentation.

6 Press OK .

Excel Mobile

With Excel Mobile you can create and edit 
workbooks and templates on your Treo 
750. You can also edit workbooks and 
templates that you create on your 
computer. However, keep in mind that you 
may lose some of the information and 
formatting when you save the workbook on 
your Treo 750.

Note the following formatting 
considerations:

• Alignment: Vertical text appears 
horizontal.

• Borders: Appear as a single line.

TIP To turn the presentation into a 
continuously looping slide show, check both 
the Use timings, if present, and the Loop 

continuously boxes.
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• Cell patterns: Patterns applied to cells 
are removed.

• Fonts and font sizes: The original font 
is listed on your Treo 750 and mapped 
to the closest font available. Original 
fonts reappear on your computer.

• Number formats: Microsoft® Office 
Excel® 97 conditional formatting is 
displayed in Number format.

• Formulas and functions: Unsupported 
functions are removed, and only the 
returned value of the function appears. 
Formulas containing the following are 
also converted to values:

• An array or array argument, for 
example, =SUM({1;2;3;4})

• External link references or an 
intersection range reference

• References past row 16384 are 
replaced with #REF!

• Protection settings: Most protection 
features are disabled but not removed. 
However, password protection is 
removed. You must remove the 
password protection in Microsoft Office 
Excel on your computer before opening 
the file on your Treo 750.

• Zoom settings: Worksheet-specific 
zoom settings are not retained. The 
zoom setting applies to the entire 
workbook.

• Worksheet names: Names that refer to 
other workbooks, arrays, array formulas, 
or intersection ranges are removed 
from the name list, causing those 
formulas to be resolved as “#NAME?” 
All hidden names are not hidden.

• AutoFilter Settings: AutoFilters that 
cause rows to be hidden are supported. 
Use the Unhide command to display 
hidden rows. Other AutoFilters are 
removed, but you can use the AutoFilter 
command in Excel Mobile to perform 
similar functions.

• Chart Formatting: All charts are saved 
as they appear in Excel Mobile. 
Unsupported chart types are changed to 
one of these supported types: Column, 
Bar, Line, Pie, Scatter, and Area. 
Background colors, gridlines, data 
labels, trend lines, shadows, 3D effects, 
secondary axes, and logarithmic scales 
are turned off.
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The following features aren’t supported in 
Excel Mobile and are removed or modified 
when you open a workbook on your Treo 
750:

•  Hidden, dialog, and macro sheets

• VBA modules

• Text boxes

• Drawing objects and pictures

• Lists

• Conditional formats and controls

• Pivot table data (converted to values)

Creating a workbook

1 Press Start  and select Programs.

2 Select Excel Mobile .

3 Press New  (left action key).

4 Highlight a cell where you want to enter 
text or other info.

5 Enter the info in the cell, and then press 
Enter .

6 Repeat steps 4 and 5 to enter the 
remaining info.

7 Press OK  to save the file. When you 
save a new workbook, it is automatically 
named and placed in the workbook list.

Creating a workbook from a template

1 Go to the workbook list.

2 Select the Show list in the upper-left, 
and then select Templates.

3 Open the template you want to use and 
enter the information you want to 
include in the template.

4 Press OK .

5 Rename the workbook and move it to 
the appropriate folder. See Organizing 
your documents for details.

DID YOU KNOW? If you have a PDF file (.pdf), 
you can view the file using Picsel PDF Viewer. 
Press Start, select Programs, and then select 
PDF Viewer.

TIP To create a new template, open the 
workbook you want to save as a template. 
Press Menu and select Rename/Move, and 
then enter a name for the template. Select 
Folder, and then select Template. Press OK.
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Viewing a workbook

1 Press Start  and select Programs.

2 Select Excel Mobile .

3 In the workbook list, select the 
workbook you want to view.

4 Press View  (left action key), and 
then select any of the following:

Full Screen: Shows as much data as 
possible on the screen. To return to the 
normal view, select Restore in the 
upper-right.

Zoom: Sets the magnification level so 
that you can easily read the worksheet.

Sheet: Lets you switch to a different 
worksheet.

Split: Divides the window into two 
scrollable areas. To move the split bar, 
tap and drag it. To remove the split bar, 
select View > Remove Split.

Freeze Panes: Locks rows and columns 
so they remain visible while you scroll. 
Highlight the cell at the juncture you 
want to lock before you select this 
command. To unlock the rows or 
columns, select View > Unfreeze 

Panes.

Toolbar: Indicates whether the toolbar 
appears onscreen.

Status Bar: Indicates whether the 
status bar appears onscreen.

Show: Indicates whether headings and 
scroll bars appear onscreen.

Calculating a sum

1 Press View  (left action key) and 
select Toolbar.

TIP To copy a file from your computer to your 
Treo 750, open My Computer or Windows 
Explorer on your computer, copy the file into 
the Mobile Device folder, and then sync.

DID YOU KNOW? You can also switch 
worksheets by selecting the sheet list at the 
bottom of the screen.

TIP To jump to a cell or region, press Menu 
and select Edit > Go To. Select Cell 

reference or name and enter the target cell 
info or select Current region. Select OK.
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2 Highlight the cell where you want to 
insert the sum.

3 Select . 

4 Tap and drag the stylus across the cells 
you want to add. 

5 Press Enter .

Entering a formula

1 Highlight the cell where you want to 
enter the formula.

2 Enter equals sign ( = ) followed by any 
values, cell references, name 
references, operators, and functions.

Examples:

• =(B4/25)+100

• =Revenue-Expenses

3 Press Enter . 

Inserting a function

1 Open the workbook where you want to 
insert the function.

2 Press Menu  (right action key) 
and select Insert > Function.

3 Select the Category list, and then 
select the type of function you want to 
insert.

4 Select the Function list, and then select 
the specific function you want to insert.

5 Select OK.

Entering a sequence automatically

1 Highlight both the cells containing the 
info you want to automate and the 
adjacent destination cells.

TIP For simple calculations, use the Calculator 
(see Calculator). 

TIP To insert a symbol, place the insertion 
point where you want the symbol. Press 
Menu and select Insert > Symbol. Highlight 
the symbol you want to insert, and then select 
Insert.
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2 Press Menu  (right action key) 
and select Edit > Fill.

3 Select the Direction list, and then 
select the direction you want to 
populate.

4 Select the Fill type list, and then 
select Series.

5 Select the Series type list, and then 
select the type of series you want. If 
you select Date or Number, enter a 
Step value increment.

6 Select OK.

Adding cells, rows, and columns

1 Open the workbook you want to add to.

2 Highlight the area where you want to 
insert elements.

3 Press Menu  (right action key) 
and select Insert > Cells.

4 Select how you want to insert the 
elements:

Shift cells right: Inserts a new cell. The 
highlighted cell and all cells on its right 
move one column to the right.

Shift cells down: Inserts a new cell. 
The highlighted cell and all cells below it 
move down one row.

Entire row: Inserts a new row. The 
entire row in which the highlighted cell 
is located and all rows below it move 
down one row.

Entire column: Inserts a new column. 
The entire column in which the 
highlighted cell is located and all 
columns to its right move one column 
to the right.

5 Select OK.

TIP Select Autofill as the series type to 
quickly fill cells with repetitive data such as 
numbers or repeated text. Autofill takes the 
content of the first cell in the highlighted row 
or column and copies it down or across the 
rest of the selection.

TIP To add a new worksheet, press Menu and 
select Format > Modify Sheets. Select 
Insert, enter a name for the worksheet, and 
then press OK. To change the order of the 
worksheets, highlight a worksheet you want 
to move, and then select Move Up or Move 

Down. Press OK to finish.
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Formatting cells

1 Open the workbook you want to format.

2 Highlight the cells you want to format.

3 Press Menu  (right action key) 
and select Format > Cells.

4 Select any of the following:

Size: Sets the row height and column 
width.

Number: Sets the type of information 
the cells contain.

Align: Sets whether text wraps within 
the highlighted cells, and sets horizontal 
and vertical alignment position.

Font: Sets the typeface, color, size, and 
style attributes.

Borders: Turns borders on and off for 
various cell edges, and sets the border 
and background colors.

5 Press OK .

Formatting rows and columns

1 Open the workbook you want to format.

2 Highlight the rows or columns you want 
to format.

3 Press Menu  (right action key), 
and then select Format > Row or 
Format > Column.

4 Select any of the following:

AutoFit: Adjusts the size of the 
highlighted rows or columns to their 
contents.

Hide: Hides the highlighted rows or 
columns.

Unhide: Displays hidden rows or 
columns in the highlighted area.

Renaming a worksheet

1 Open the workbook containing the 
worksheet you want to rename.

TIP To name the highlighted cell or range of 
cells, press Menu and select Insert > Define 

Name. Enter the name and select Add. Press 
OK.

DID YOU KNOW? You can adjust the column and 
row size by tapping and dragging the right 
edge of the column or the bottom edge of the 
row. To automatically fit rows and columns to 
their contents, double-tap the lower edge of 
the row heading or the right edge of the 
column heading.
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2 Press Menu  (right action key)) 
and select Format > Modify Sheets.

3 In the Sheets list, highlight the 
worksheet you want to rename.

4 Select Rename, enter a new name for 
the worksheet, and then press OK  
twice.

Sorting info in a worksheet

1 Highlight the cells you want to sort.

2 Press Menu  (right action key) 
and select Tools > Sort.

3 Select the Sort by list, and then select 
the primary sort column.

4 Check or uncheck the Ascending box to 
indicate if you want to sort in ascending 
or descending order.

5 (Optional) Select the Then by lists, and 
then select second- and third-level 
sorting options.

6 Check or uncheck the Exclude header 

row from sort box to indicate whether 
you want to sort the header row.

7 Select OK.

Filtering info in a worksheet

1 Highlight the cells that contain the info 
you want to filter.

2 Press Menu  (right action key) 
and select Tools > AutoFilter. A list 
appears at the top of each related 
column.

3 Select one of the new lists, and then 
select a filter. This hides all rows that do 
not include the selected filter.

4 (Optional) Do any of the following:

• Select the other lists, and then select 
other filters.

• To display all rows again, select the 
filter lists, and then select All. 

• To turn off filtering, press Menu and 
select Tools > AutoFilter again.

Creating a chart

1 Open the workbook you want to create 
a chart from.

2 Highlight the cells you want to include 
in the chart.

DID YOU KNOW? You can also create custom 
filters where you specify comparisons. Select 
the filter lists, and then select Custom.
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3 Press Menu  (right action key) 
and select Insert > Chart.

4 Select the type of chart, and then press 
Next  (right action key).

5 Confirm the area you want the chart to 
include, and then press Next  
(right action key).

6 Select the data layout, and then press 
Next  (right action key).

7 Check the boxes to indicate whether 
the first row and column represent 
labels.

8 Select whether you want the chart to 
appear as a separate worksheet within 
the current workbook, or as part of the 
current worksheet.

9 Press Finish  (right action key).

Formatting or changing a chart

1 Open the workbook that contains the 
chart you want to format.

2 Open the chart.

3 Press Menu  (right action key) 
and select Format > Chart.

4 Select any of the following:

Titles: Specifies the title of the chart 
and headings, whether a legend 
appears, and the placement of the 
legend.

Scale: Specifies the minimum and 
maximum scales for charts with x and y 
axes.

Type: Specifies the chart style. You can 
use this setting to convert your chart to 
a different format.

Series: Lets you add, modify, format, or 
delete related data points without 
affecting the info in your worksheet.

5 Press OK .

Finding or replacing info in a workbook

1 Open the workbook containing the info 
you want to find.

2 Press Menu  (right action key) 
and select Edit > Find/Replace.

3 Select Find what and enter the info you 
want to find.
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4 (Optional) Check the Match case box to 
find text that matches the capitalization 
in any text you entered in step 3.

5 (Optional) Check the Match whole 

words only box to find only full words 
that match any text you entered in 
step 3.

6 Select Find to locate the first instance 
of the info you entered in step 3, or 
select Replace and enter the 
replacement info.

7 Select Next to find the next instance of 
the info, or select Replace to replace it. 
To replace all instances of the info, 
select Replace All.

8 When you see a message that Excel 
Mobile is done searching, press OK .

Organizing your workbooks

You can rename your workbooks. You can 
also move them to another folder or move 
them between your Treo 750 and an 
expansion (storage) card.

1 Go to the workbook list.

2 Select a file.

3 Press Menu  (right action key) 
and select Rename/Move.

4 Select Name, and then enter a new 
name for the workbook.

5 Select the Folder list, and then select 
the folder you want to move the 
workbook to.

6 Select the Location list, and then select 
Main memory or Storage card.

7 Press OK .

8 Select the Show list in the upper-left, 
and then select the folder you want to 
view.

9 Select the Sort By list in the upper-right, 
and then select the sort method.

Deleting cells, rows, and columns

NOTE Excel Mobile adjusts formulas to 
reflect the new cell locations. However, a 
formula that refers to a deleted cell 
displays the #REF! error value.

TIP When you go to a folder, you can easily 
search your documents by sorting by type. 
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1 Open the workbook containing the 
elements you want to delete.

2 Highlight the area you want to delete.

3 Press Menu  (right action key) 
and select Edit > Delete Cells.

4 Select how you want to remove the 
elements:

Shift cells left: Deletes the highlighted 
cells and moves all cells on their right 
one column to the left.

Shift cells up: Deletes the highlighted 
cells and moves all cells below them up 
one row.

Entire row: Deletes the entire row in 
which the highlighted cells are located, 
and moves all rows below it up one row. 

Entire column: Deletes the entire 
column in which the highlighted cells 
are located, and moves all columns on 
their right one column to the left.

5 Select OK.

Customizing Excel Mobile

1 Go to the workbook list.

2 Press Menu  (right action key) 
and select Options.

3 Set any of the following options:

Template for new workbook: 
Specifies the default template for new 
workbooks.

Save new workbooks to: Specifies 
where new workbooks are stored.

Files to display in list view: Specifies 
which types of files appear in the 
workbook list.

4 Press OK .

TIP To delete a workbook, go to the workbook 
list and highlight the workbook you want to 
delete. Press Menu and select Delete. Select 
Yes to confirm.

TIP To delete a worksheet, press Menu and 
select Format > Modify Sheets. Highlight 
the worksheet you want to delete, and then 
select Delete. Select Yes, and then press OK 
to finish.
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Your application and info 
management tools
Your Palm® Treo™ 750 smart device comes equipped with a 
variety of tools for managing and organizing your information. 
Get the most out of your Treo 750: Install some of the 
thousands of business, education, or leisure-time applications 
available. After you use your Treo 750 to create or capture 
important business and personal information, use one of 
several options to share it with others. Insert expansion cards 
(sold separately) for a compact and limitless answer to the 
storage dilemma. And because there’s one on your Treo 750, 
you never need to carry a separate calculator.

Benefits

• Locate info in any application

• Install applications, games, and 
other software

• Keep others up-to-date with 
meaningful business and personal 
information

• Store, carry, and exchange info

• Always have a calculator with you
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Finding information

Quickly find who or what you’re looking for 
by using one of these search features:

• Lookup: Find and dial your contacts by 
name or phone number. See Dialing by 
contact name for details.

• Search: Look through the text in all the 
applications on your Treo 750.

• File Explorer: Browse through the files 
and folders on your Treo 750 or on an 
expansion card.

• Global Address List Lookup: Look up 
names in your online corporate address 
list.

Using Search

Search for files and other items stored in 
the My Documents folder on your Treo 750 
or on an expansion card. You can search by 
file name or by words located in the item. 
For example, you can search for words 

within notes, appointments, contacts, and 
tasks.
 

1 Press Start  and select Programs.

2 Select Search .

3 Select Search for, and then enter the 
file name, word, or other info you want 
to find.

TIP For information on opening and closing 
apps, see Opening and closing applications.

DID YOU KNOW? Contacts on your SIM card do 
not appear in the search results list.

DID YOU KNOW? You can also open Search by 
pressing Option + left Shift.
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4 Select the Type list, and then select the 
kind of information you want to find.

5 Press Search  (left action key).

6 Use the 5-way to select and view an 
item from the results of the search.

Exploring files and folders

You can use File Explorer to browse the 
contents of folders on your Treo 750. The 
root folder on your Treo 750 is named My 
Device. My Device is similar to My 
Computer on your computer.

1 Press Start  and select Programs.

2 Select File Explorer .

3 Select the folder you want to explore. If 
the folder you want is not displayed, tap 
the Show list in the upper-left and 
select My Device to view all folders.

 

4 Do any of the following:

• To open an item, select it.

• To quickly delete, rename, beam, or 
email an item, highlight the item, 
press and hold Center  to open 
the shortcut menu, and then select 
the appropriate command.

TIP If you’ve looked for an item before, select 
the Search for list, and then select the item in 
the list. 

DID YOU KNOW? When the items in a folder are 
displayed, you can sort them by name, date, 
size, or type. Select the Sort by list in the 
upper-right, and then select the sort method.

TIP The storage card symbol appears next to 
the names of files that are stored on an 
expansion card.

Show list
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• To move a file to another folder, 
highlight the item, press and hold 
Center  to open the shortcut 
menu, and then select Cut or Copy. 
Open the destination folder, press and 
hold Center  to open the shortcut 
menu, and then select Paste.

• To highlight multiple items, tap and 
drag the stylus.

IMPORTANT Do not delete any files that 
you cannot identify. These files may be 
required for your Treo 750 to function 
properly.

Installing applications

Your Treo 750 comes with several built-in 
and ready-to-use applications. You can also 
install any of the additional software 
included on the Windows Mobile Getting 
Started Disc as well as other third-party 
applications that are compatible with 
Windows Mobile® 5.0 devices, such as 
business software, games, and more. To 
learn more, go to www.palm.com/
mytreo750cingular.

Applications you download to your 
computer are likely to be in a compressed 
format such as ZIP. If the file is 
compressed, you need to use a 
decompression utility on your computer, 
such as WinZip, before you install 
applications on your Treo 750.

These instructions tell you how to install 
basic files onto your Treo 750. Some 
software uses an installer or wizard to 
guide you through the process. For details, 
consult the documentation that came with 
the software.

Installing bonus software from the CD

The Windows Mobile Getting Started Disc 
includes several bonus software 
applications that you can install on your 
Treo 750. You can install these applications 
when you install the desktop software, or 
you can install them later.

TIP If an application does not have a Microsoft 
Mobile to Market certificate, you see a 
message indicating that the application is 
untrusted. If this occurs, you can indicate 
whether you want to continue the installation.
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1 Insert the Windows Mobile Getting 
Started Disc into the CD drive on your 
computer.

2 Click Add Programs.

3 Click the name of the application you 
want to install.

4 Click Install (on the right side of the 
screen).

5 (Optional) Repeat steps 3 and 4 to 
install additional applications.

6 Synchronize your Treo 750 with your 
computer to install the application(s) on 
your Treo 750.

Installing third-party applications

When installing third-party applications, 
note the following:

• Install only apps that use Microsoft 
Windows Mobile 5.0 software for 
Pocket PC Phone Edition. The Microsoft 
Windows Mobile 5.0 software for 
Smartphone is not compatible with your 
Treo 750. Also, programs written for 
earlier versions do not support 5-way 
navigation or action keys and can have 
performance problems.

• Make sure that the third-party 
application supports 240x240 screen 
resolution. Some older applications 
have screen-size limitations.

• If you can try a free version of the 
software before purchasing it, you can 
test it first to make sure it works 
properly.

NOTE If you encounter a problem with a 
third-party application (such as an error 
message), contact the application’s vendor. 
For general troubleshooting of third-party 
applications, see Third-party applications.

Installing applications from the Internet

You can use Internet Explorer Mobile to 
install Windows Mobile apps in the CAB 
file format directly from the Internet. For 
files in any other format except CAB, you 
must first download the files to your 

DID YOU KNOW? You can purchase a third-party 
application that lets you run Palm OS® 
applications on your Treo 750.

TIP Before purchasing a third-party application, 
try the free version.
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computer and then install them to your 
Treo 750 by synchronizing.

1 Make sure your phone is on (see 
Turning your phone on).

2 Press Start  and select Internet 

Explorer.

3 Go to the page that contains the link to 
the application you want to download.

4 Press Left  or Right  to highlight the 
link to the file, and then press Center 

 to start the download process.

5 Press Start  and select Programs.

6 Select File Explorer .

7 Go to the My Documents folder in File 
Explorer.

8 Tap the file you downloaded to start the 
installation program.

Installing applications from your 

computer

BEFORE YOU BEGIN To install an 
application from your computer to your 
Treo 750, you must first install ActiveSync® 
desktop software on your computer 
(see Installing the desktop synchronization 
software).

1 Open My Computer or Windows 

Explorer on your computer.

2 Double-click Mobile Device .

3 Copy the application file(s) into the 
Mobile Device folder.

4 Connect your Treo 750 to your 
computer to synchronize and install the 
application(s) on your Treo 750.

Installing applications onto an expansion 

card

BEFORE YOU BEGIN To install an 
application from your computer to an 
expansion card, you must first install 
ActiveSync desktop software on 
your computer (see Installing the desktop 
synchronization software).

1 Insert the expansion card into the 
expansion card slot (see Inserting and 
removing expansion cards).

2 Connect your Treo 750 to your 
computer.

3 Open My Computer or Windows 

Explorer on your computer.

4 Double-click Mobile Device .
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5 Double-click My Windows 

Mobile-Based Device  to open the 
Mobile Device folder.

6 Copy the application file(s) into the 
Storage Card folder inside the Mobile 
Device folder.

Removing 
applications

To free up memory on your Treo 750, you 
can remove applications that you no longer 
use. You can remove only applications, 
patches, and extensions that you install; 
you cannot remove the built-in applications 
that reside in the ROM portion of your Treo 
750.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Remove Programs .

3 Highlight the application that you want 
to remove.

4 Select Remove.

5 Select Yes to confirm the deletion.

Sharing information

Your Treo 750 comes equipped 
with a variety of options for sharing 
information, so that you can choose the 
quickest, most convenient way to send 

DID YOU KNOW? Built-in applications that 
cannot be deleted are not listed in the 
Remove Programs list.
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your info or to receive info from another 
device.

• When you have a file open in a program 
such as Notes or PowerPoint Mobile, 
you can easily share a file by selecting 
the Menu, and then selecting Send via 

E-Mail or Beam File.

• In Microsoft Outlook®, you can insert a 
picture or attach a note or other file to 
an email. You can also receive pictures 
and attachments (see Your email).

• You can synchronize to share info 
between your Treo 750 and your 
computer or between your Treo 750 and 
Microsoft Exchange Server 2003 (see 
Synchronizing information).

• If you are near someone, you can beam 
files and applications between your Treo 
750 and your neighbor’s device using 
the IR port or Bluetooth® wireless 
technology (see Beaming information).

• You can also store files on an expansion 
card and share the expansion card (see 
Using expansion cards).

Beaming information

Your Treo 750 is equipped with an IR 
(infrared) port that enables you to beam 
information to another device with an IR 
port. The IR port is located on the side of 
your Treo 750 closest to the stylus, near 
the top. You can also beam using the 
built-in Bluetooth wireless technology on 
your Treo 750.

The normal range for beaming with IR is 
about 8 inches (20 centimeters). The 
maximum range for beaming with 
Bluetooth technology is about 30 feet 
(10 meters). Performance and range are 
affected by physical obstacles, radio 
interference from nearby electronic 
equipment, and other factors.

TIP For best results, the path between the 
two devices must be clear of obstacles, and 
both devices kept stationary. If you have 
difficulty beaming, shorten the distance and 
avoid bright sunlight.
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Beaming a record

1 Highlight the entry or file you want to 
beam.

2 Press Menu  (right action key) 
and select Beam… (the menu item 
changes names based on the type of 
item you highlighted).

3 Do one of the following:

Bluetooth: When the name of the 
receiving device appears, select Tap to 

send to begin the transfer. A blue icon 
indicates a Bluetooth connection.

IR: Point the IR port on your Treo 750 
directly at the IR port of the receiving 
device. A red icon indicates an IR 
connection.

4 Wait for Done to appear next to the 
name of the receiving device before you 
continue using your Treo 750.

Receiving beamed information

1 Turn on your screen.

DID YOU KNOW? The type of information you 
can beam depends on the type of device you 
are beaming to. Other Windows Mobile 
devices are always compatible with the Treo 
750.



Y O U R  A P P L I C A T I O N  A N D  I N F O  M A N A G E M E N T  T O O L S

U S I N G  E X P A N S I O N  C A R D S 195

11

C
H

A
P

T
E

R

2 Point the IR port on your Treo 750 
directly at the IR port of the transmitting 
device.

3 When the Receiving Data message 
appears, select Yes to receive the 
beam.

Using expansion 
cards

The expansion card slot on your Treo 750 
enables you to add miniSD cards to extend 
the storage capacity of your Treo 750. For 
example, miniSD expansion cards can 
store the following:

Expansion cards are sold separately.

Inserting and removing expansion cards

1 Open the expansion card slot door by 
sliding your fingernail or another thin 
object into the notch.

2 Hold your Treo 750 with the screen 
facing you and hold the card with the 
label facing you. The notch on the card 
should be toward the bottom of your 
Treo 750.

3 Insert the card into the expansion card 
slot until you feel it lock into place and 
you hear the confirmation tone.

TIP If you can’t receive beamed info, press 
Start and select Settings. Select the 
Connections tab, and then select Beam. 
Make sure the Receive all incoming beams 
box is checked. If you still can’t receive info, 
try a soft reset (see Resetting your Treo 750).

• Pictures 
• Videos
• MP3 audio files
• Email attachments

• Games
• eBooks
• Applications
• Databases

TIP We recommend that you purchase 
preformatted expansion cards. To format a 
card on your own, you need to connect a card 
reader (sold separately) to your computer.
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4 To remove an expansion card, press 
down and release the card.

5 After you feel the expansion card slot 
eject the card, remove the card 
from the slot.

Notch
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Opening applications on an expansion 

card

After you insert an expansion card into the 
expansion card slot, you can open any of 
the applications stored on the expansion 
card.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer.

4 Tap the Show list in the upper-left, and 
then select Storage Card.

5 Select the application you want to open.

Saving files to an expansion card

You can save space on your Treo 750 by 
saving files to an expansion card. For 
example, when you create new Word 
Mobile documents, notes, Excel Mobile 
workbooks, pictures, videos, and audio 
files, you can save them directly to an 
expansion card. Saving files to an 
expansion card also makes it easy to share 
those files with others. (Some applications 
may not support this feature.)

1 Insert an expansion card into the 
expansion card slot.

2 Open the application you want to save 
the info from.

3 Press Menu  (right action key) 
and select Options.

4 Select the Save to list, and then select 
Storage Card.

5 Press OK .

TIP To run an application on an expansion card, 
your Treo 750 must have enough free space in 
the internal memory to run the application.

Show list

TIP If you don’t see the Save to list on the 
Options screen, look on the other tabs (if 
present). If you still can’t find a Save to list, the 
application may not support this feature.
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Moving info between your Treo 750 and 

an expansion card

1 Insert an expansion card into the 
expansion card slot. 

2 Open the application from which you 
want to move the info.

3 Go to the list view.

4 Press Menu  (right action key) 
and select Rename/Move.

5 Select the Location list, and then select 
where you want to move the info: 
Storage Card or Main Memory.

6 Press OK .

Copying or moving applications and files 

between your Treo 750 and an expansion 

card

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer.

4 Select the file or application you want to 
copy or move (see Exploring files and 
folders).

5 Press Menu  (right action key) 
and select Edit > Copy or Edit > Cut.

6 Go to the folder where you want to 
place the selected item.

7 Press Menu  (right action key) 
and select Edit > Paste.

8 Press OK .

Viewing available expansion card 

memory

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Settings.

3 Select the System tab, and then select 
Memory .

4 Select the Storage Card tab.

5 Press OK .

Exploring files on an expansion card

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

TIP Your applications are usually located in the 
My Device/Program Files folder.
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3 Select File Explorer.

4 Tap the Show list in the upper-left, and 
then select Storage Card.

5 Select the folder or files you want to 
view.

6 Press OK .

Renaming an expansion card

If you change the contents of an expansion 
card, you may at some point want to 
rename the card to better match its 
contents.

1 Insert the expansion card into the 
expansion card slot.

2 Press Start  and select Programs.

3 Select File Explorer.

4 Tap the Show list in the upper-left, and 
then select My Device.

5 Highlight the current expansion card 
name (Storage Card by default).

6 Press Menu  (right action key) 
and select Rename.

7 Enter a new name for the card.

8 Press OK .

Calculator

You can use Calculator for basic arithmetic 
calculations, such as addition, subtraction, 
multiplication, and division.

Performing calculations

1 Press Start  and select Programs.

2 Select Calculator .

TIP Before copying information to or renaming 
the files or folders on an expansion card, or 
renaming the card itself, make sure the card is 
not write-protected. See the instructions that 
came with your card for details.
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3 Enter numbers and perform 
calculations, including the following:

 Clears the last digit in a multi-digit 
entry.

 Clears the current calculation or the 
displayed number.

 Calculates the reciprocal of a 
number.

 Calculates percentage.

 Calculates the square root of a 
number.

 Switches a number between 
negative and positive.

Using the Calculator memory

• To store a number, select the box to the 
left of the entry box. An M appears in 
the box. 

• To add the displayed number to the 
number stored in memory, select .

• To display the number stored in 
memory, select . 

• To clear the memory, select .

TIP You can paste numbers into Calculator as 
well as copy calculation results to be pasted 
into another app. Press Menu (right action 
key) and select Edit.

TIP For more advanced calculations, use Excel 
Mobile. See Excel Mobile for details.

DID YOU KNOW? When you store a number in 
memory, it replaces the number that is 
currently stored.
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Your personal settings
Customizing is optional. But why not personalize your Palm® 
Treo™ 750 smart device to make it match your lifestyle and 
work even harder for you?

You can easily customize the sounds, fonts, screen colors, and 
more on your Treo 750. Take advantage of various levels of 
security. Prevent making an accidental (and expensive) phone 
call by locking the keyboard. Some preference settings can help 
extend the life of your battery. There are lots of ways to make 
your Treo 750 work better for you.

Benefits

• Conserve power

• Secure your data

• Make your screen easy to read
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Today screen settings

Selecting your Today screen background

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 On the Appearance tab, check the Use 

this picture as the background box.

4 Select Browse.

5 Select the picture you want to use.

6 Press OK .

Selecting which items appear on your 

Today screen

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 Select the Items tab.

4 Check the boxes next to the items you 
want to appear on your Today screen, 
and uncheck any items you want to 
hide.

5 (Optional) Select Options (if available) 
to configure the settings for the current 
item. Press OK  to return to Today 
Settings.

6 Press OK .
TIP To change the color theme for your Treo 
750, select a new theme from the 
Appearance tab in Today Settings. 
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System sound 
settings 

When you’re in a meeting, at the movies, 
or anywhere that silence is required, you 
can immediately silence all sounds on your 
Treo 750, including Calendar notifications 
and system sounds. This does not mute 
the speaker during phone calls.

Silencing sounds

1 Slide the ringer switch to Sound Mode 

Off . The Treo 750 vibrates briefly.

2 To hear all sounds again, slide the ringer 
switch to Sound Mode On .

When you slide the ringer switch back to 
the Sound Mode On position, it restores 
the previous sound settings. For example, 
if the Treo 750 ring volume is set to the 
loudest setting and you slide the ringer 
switch to Sound Mode Off, you do not hear 
the Treo 750 ring. When you move the 
ringer switch back to Sound Mode On, the 
Treo 750 ring volume is still set to the 
loudest setting.

Selecting Sounds & Notifications

1 Press Start  and select Settings.

2 On the Personal tab, select Sounds & 

Notifications .

DID YOU KNOW? There are lots of third-party 
plug-ins available for your Today screen. For 
clocks, calculators, MP3 players, weather 
guides, and much more, visit www.palm.com/
mytreo750cingular.

TIP Can't get music to play out of the built-in 
MP3 player? Check the ringer switch. If it’s set 
to Sound Mode Off, you won’t be able to hear 
music. 

DID YOU KNOW? Your Treo 750 includes a silent 
alarm that can vibrate even when the ringer 
switch is set to Sound Mode Off. 

Sound 
Mode Off

Sound 
Mode On
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3 On the Sounds tab, set any of the 
following options:

Events: Turns sounds on/off for system 
warnings and error messages.

Programs: Turns sounds on/off in the 
applications on your Treo 750.

Notifications: Turns alarms and 
reminders on/off in the applications on 
your Treo 750.

Screen taps: Turns sounds associated 
with tapping the screen on/off, and sets 
the volume level when this sound is 
turned on.

Hardware buttons: Turns sounds 
associated with pressing buttons on/off, 

and sets the volume level when this 
sound is turned on.

4 Select the Notifications tab and set 
any of the following options:

Event: Specifies which action you want 
to change the settings for. The 
remaining options vary based on the 
action you select.

TIP To record, preview, delete, and send 
sounds, select the Manage tab. To record a 
sound, press Menu and select New Sound. 
To play a sound, select it and press Play. To 
delete a sound, highlight it and press 
Backspace. To send a sound, highlight it, 
press Menu, and select Send Sound.
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Play sound: Lets you turn the sound 
on/off for the selected event. To select a 
different sound select the list to the 
right of this setting, and then select a 
different sound. To preview the sound, 
select Play Sound, and then select Play.

Repeat: Indicates whether the sound 
plays more than once, if turned on.

Display message on screen: Indicates 
whether a notification message appears 
onscreen for the selected event.

Vibrate: Indicates whether your Treo 
750 vibrates to notify you about the 
selected event.

5 Press OK .

Display and 
appearance settings

Adjusting the brightness

1 Press Option , and then press . 

2 Press Left  and Right  to adjust the 
brightness.

3 Press OK .

Changing the text size and clarity

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 Select the Text Size tab.

4 Press Left  and Right  to adjust the 
text size.

5 Select the Clear Type tab.

6 To smooth the edges of screen fonts, 
check the Enable Clear Type box.

7 Press OK .

Setting display formats

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Regional Settings .
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3 On the Region tab, select a region from 
the list. The region selection sets the 
default format settings.

4 (Optional) Select any of the following 
tabs to customize the format settings:

Number: Sets the decimal symbol and 
number of decimal places, the digit 
grouping symbol and group size, list 
separators, negative number sign 
symbol and format, leading zero display, 
and measurement system (metric vs. 
U.S.).

Currency: Sets the currency symbol 
and position, the decimal symbol and 
position, digit grouping symbol and 
group size, and negative number 
format.

Time: Sets the time style, separators, 
and AM and PM symbols.

Date: Sets the short date style, 
separators, and long date style.

5 Press OK .

Aligning the screen to correct tapping 

problems

Occasionally, your screen may need to be 
readjusted. You know your screen needs 
adjustment when the wrong feature is 
activated when you tap the screen. To fix 
the problem, align the screen.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 On the General tab, select Align 

Screen. 

4 Tap the screen where indicated.

5 Press OK .

Changing the system color scheme

1 Press Start  and select Settings.

2 On the Personal tab, select Today .

3 On the Appearance tab, select a theme 
in the list.

4 Press OK .

TIP You can also set the background for your 
Today screen (see Selecting your Today 
screen background).
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Changing screen orientation

Landscape orientations are determined by 
which hand you would hold the stylus in.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Screen .

3 Select the General tab. 

4 Select an orientation:

• Portrait

• Landscape (right-handed)

• Landscape (left-handed)

5 Press OK .

Application settings

Arranging the Start menu

You can change the first seven applications 
listed on the Start menu. You can still 
access the remaining applications by 
selecting Programs from the Start menu, 
and then selecting the application’s icon.

1 Press Start  and select Settings.

2 On the Personal tab, select Menus 
.

3 Check the boxes next to the 
applications you want to see in the Start 
menu.

4 Press OK .

Reassigning buttons

Buttons Settings lets you select which 
applications are associated with many of 

TIP Don’t forget the six.icons across the top of 
the Start menu. They’re the apps you opened 
most recently, and it’s easy to get back to 
them: just use the 5-way to select one of the 
icons
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the buttons and key combinations on your 
Treo 750.

1 Press Start  and select Settings.

2 On the Personal tab, select Buttons 
.

3 On the Program Buttons tab, highlight 
the button or key combination you want 
to change in the Buttons list. The 
hardware buttons are mapped to the 
following items:

• Start  = Start menu.

• OK  = OK/Close.

• Option  + Phone/Send  = 
Messaging.

• Option  + Start  = Calendar.

• Option  + OK  = Task Manager.

• Hold Side button = Windows Media 
Player.

4 Select the Assign a program list, and 
then select the application you want to 
assign to the button or key combination 
you selected in step 3.

5 Press OK .

Setting up voice commands

IMPORTANT The Voice Command 
application is available only for English, 
French, and German. Spanish is not 
available.

Voice commands enable you to use speech 
to execute some commands on the Start 
menu and the Programs menu.
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1 Assign the Hold Side button to Voice 
Command. See Reassigning buttons for 
details.

2 Press Start  and select Settings.

3 On the Personal tab, select Voice 

Command.

4 Select Enabled.

5 Select the items you want to enable. If 
an item is highlighted and the Options 
box is active, select the Options box to 
choose the features you want enabled 
for the highlighted item.

Using voice commands

The Voice Command application is available 
only for English, French, and German. 
Spanish is not available.

IMPORTANT Do not use voice commands 
in your car until you read the End user 
notice about this kind of usage; see End 
user notice.

1 Set the ringer switch at the top of your 
Treo 750 to On.

2 Hold your device about nine inches 
(230mm) away from your mouth, and 
then press and release the assigned 
Voice Command button (see Setting up 
voice commands). A tone plays and a 
microphone icon appears at the top of 
your screen.

3 In a clear voice say the command. For 
example:

• To access Help, say,“Help.” After 
Voice Command finishes speaking, a 
microphone icon appears at the top of 
your screen. Say your answer. For 
example, say, “General” to access 
general Help topics.

• To access your Calendar, say, “Start 
Calendar.”

• To access your music, say, “Start 
Windows Media.” After Voice 
Command finishes speaking, a 
microphone icon appears at the top of 
your screen. Say your answer.

DID YOU KNOW? If you have questions about 
the types of commands that can be used with 
Voice Command, you can go to the on-device 
Help by pressing Start and selecting Help.
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Setting input options

1 Press Start  and select Settings.

2 On the Personal tab, select Input .

3 Select the Word Completion tab and 
set any of the following options:

Suggest words when entering text: 
Indicates whether word suggestions 
appear as you enter text. You can also 
specify how many letters you want to 
enter before a suggestion appears, how 
many suggestions you want to see, and 
whether a space appears after you 
insert a suggested word.

Replace text as you type: Indicates 
whether the text you type adds to 
existing text or replaces it. This is similar 
to the Insert function on a computer 
keyboard.

4 Select the Options tab and set any of 
the following options:

Voice recording format: Specifies the 
format in which you save voice notes.

TIP You can move quickly through voice 
commands by stopping the voice command 
response before it finishes. When Voice 
Command responds, you can press the Voice 

Command button before it completes the 
question. Once the microphone icon is visible, 
you may say your answer.

TIP To enter a suggested word, press Down 
to highlight the suggestion, and then press 
Center to accept it. 
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Default zoom level for writing: 
Specifies the initial size of text entered 
from onscreen writing methods.

Default zoom level for typing: 
Specifies the initial size of text entered 
using the keyboard.

Capitalize first letter of sentence: 
Specifies whether the first letter of a 
sentence automatically appears in 
uppercase, without requiring you to 
press a Shift key.

Scroll upon reaching the last line: 
Specifies whether the display 
automatically scrolls when you select 
the last line of visible info.

5 Press OK .

Locking your Treo 
750 and info

Your Treo 750 includes several features that 
help you protect your Treo 750 from 
inadvertent use and keep your information 
private. The built-in security software lets 
you use your Treo 750 for emergency calls, 
such as dialing the 911 emergency number, 
even if it is locked.

• Keyguard: Manually disables all buttons 
and the screen’s touch-sensitive feature 
to prevent accidental presses in your 
briefcase or pocket.

• Auto-Keyguard and touchscreen 

lockout: Automatically enables 
Keyguard after a period of inactivity and 
lets you disable the screen’s 
touch-sensitive feature during an active 
call.

• Phone Lock: Requires a PIN to make 
and receive calls.

• System password lock: Requires a 
password to see any information on 
your Treo 750.
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Locking your keyboard (Keyguard)

By default, your keyboard locks so that you 
don’t accidentally press buttons or activate 
screen items while your Treo 750 is in a 
pocket or bag.

• To dismiss Keyguard, press Center .

• To manually turn on Keyguard when 
your Treo 750 screen is on, press 
Option  and Power/End .

Auto-Keyguard enables you configure the 
Keyguard feature.

1 Press Start  and select Settings.

2 On the Personal tab, select 
Keyguard .

3 Select the Auto-Keyguard list and then 
disable the auto-keyguard feature or set 
the period of inactivity that passes 
before the keyboard automatically locks.

4 Press OK .

Locking your screen

1 Press Start  and select Settings.

2 On the Personal tab, select 
Keyguard .

3 Check or uncheck the Disable 

touchscreen box to determine whether 
the screen’s touch-sensitive feature is 
enabled during a call.

4 Press OK .

TIP To avoid accidentally pressing onscreen 
buttons while you’re holding your Treo 750 up 
to your ear to speak, you can disable the 
screen’s touch-sensitive feature during active 
calls. When the screen’s touch-sensitive 
feature is disabled, you must use the 5-way 
navigator to access items on the screen.

TIP If you’re using a headset or hands-free 
device and your Treo 750 is in a pocket or bag, 
you can manually turn on Keyguard during a 
call to prevent accidental key presses.
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Locking the SIM card

You can lock your SIM (Subscriber Identity 
Module) card to prevent unauthorized use 
of your mobile account. When your SIM 
card is locked, you must enter the PIN to 
power on your phone to make or receive 
calls, except for emergency numbers. The 
SIM card remains locked even if you move 
the card to another phone.

When your SIM card is locked, you can 
unlock your SIM card by trying to turn on 
the phone. A dial pad appears for you to 
enter your PIN.

BEFORE YOU BEGIN You need the 
following:

• Make sure your phone is on and that 
you’re inside a coverage area (see 
Turning your Palm® Treo™ 750 smart 
device on/off).

• Get your default PIN from Cingular

1 Press Start  and select Settings.

2 On the Personal tab, select Phone .

3 Select the Security tab.

4 Check the Require PIN when phone is 

used box.

5 Enter the PIN and press Done  
(left action key).

6 Press OK  to finish.

7 Turn your phone off to activate the 
phone lock feature.

Your SIM card locks when you turn off your 
phone and turn it back on. When your SIM 
card is locked, you can unlock your SIM 
card entering your PIN.
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NOTE You need your PIN number to edit 
your PIN number or remove the locking 
feature. If you enter an incorrect PIN more 
times than allowed by Cingular, the SIM 
card locks. Once the SIM card locks, you 
need the PUK (PIN Unlock Key) to unlock 
the SIM card. Contact Cingular for more 
information and the PUK.

Locking your Treo 750

To protect your personal information, you 
can lock the system so that you need to 
enter your password to access any of your 
information or use other features of 
your Treo 750.

IMPORTANT If you lock your system, you 
must enter the exact password to unlock it. 
If you enter an incorrect password, you are 
given another chance. Each time an 
incorrect password is entered, you are 

given progressively longer time periods 
between your chances to enter the 
password. If you forget the password, you 
need to perform a hard reset to resume 
using your Treo 750. Performing a hard 
reset deletes all the entries in your Treo 
750. However, you can restore all 
previously synchronized info the next time 
you sync (see Defining speed-dial buttons.

1 Press Start  and select Settings.

2 On the Personal tab, select Lock .

3 On the Password tab, check the 
Prompt if device unused for box to 
turn on the password feature.

4 Select the first list, and then select how 
long a period of inactivity must pass 
before you are prompted to enter a 
password to unlock the system.

5 Select the Password type list, and then 
select a format for your password.

6 Select Password, tap the onscreen 

keyboard  icon, and enter your 
password. Then tap the onscreen 

keyboard icon.

DID YOU KNOW? You can permanently unlock 
your SIM card. Select Menu, Preferences, 
and then Phone Settings. Select the 
Security tab and uncheck the Require PIN 

when phone is used box.
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7 Select Confirm, tap the onscreen 

keyboard  icon, and enter the 
password again. Then tap the onscreen 

keyboard icon.

8 (Optional) Select the Hint tab and enter 
a hint to help you recall your password.

9 Press OK .

Entering owner information

You can enter personal information that you 
want to associate with your Treo 750, such 
as your name, company name, and phone 
number. You can also set whether you 
want this information to appear when you 
turn on your Treo 750. If you lose your Treo 
750, this feature can help the person who 
finds it return it to you.

1 Press Start  and select Settings.

2 On the Personal tab, select Owner 

Information .

3 On the Identification tab, enter any of 
the contact information you want to 
include.

4 Select the Notes tab and then enter any 
additional text you want to include.

5 Select the Options tab and check the 
boxes to indicate which info (if any) you 
want to appear on the screen when you 
turn on your Treo 750.

6 Press OK .

System settings

Setting the date and time

Clock & Alarms Settings lets you set the 
time zone, time, and date for your home 
location and a location that you visit.

TIP You can also display your Owner 
Information on your Today screen. See 
Selecting which items appear on your 
Today screen for details.
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To set the display format for the date and 
time, see Setting display formats.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 On the Time tab, select Home.

4 Select the first list, and then select the 
time zone for your home location.

5 Select the hour, and then press Up  
or Down  to increase or decrease the 
hour setting. Repeat this process for the 
minute, seconds, and AM/PM settings.

6 (Optional) Select Visiting and set the 
info for a location that you visit often.

7 Press OK .

8 If prompted, select Yes to accept your 
changes.

Synchronizing the date, time, and time 

zone with the network

By default your Treo 750 synchronizes the 
date, time, and time zone with the Cingular 
network whenever your phone is on and 
you are inside a coverage area. 

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the More tab.

4 To disable this option, uncheck the 
Enable local network time box. 

5 If you want to keep your Treo 750 date 
and time set for your selected location, 
uncheck the Use network time zone 

box.

Setting system alarms

System alarms let you set alarms that are 
not associated with a task or appointment. 
For example, you can use your Treo 750 as 
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an alarm clock when you travel, or set 
alarms to remind you when it’s time to take 
medication or pick up the kids. 

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Clock & Alarms .

3 Select the Alarms tab.

4 Check a box to turn on that alarm.

5 Select the description next to the box 
you checked and enter a description for 
the alarm.

6 Select the days of the week you want 
the alarm to go off. You can select 
multiple days for each alarm.

7 Select the time you want the alarm to 
go off, and then press OK .

8 Select , check the boxes to select 
how you want the alarm to go off, and 
then press OK .

9 Press OK  to finish.

10 If prompted, select Yes to accept your 
changes.

Managing identity certificates

Your Treo 750 may include preinstalled 
certificates. Certificates are digital 
documents that are used to authenticate 
and exchange information on networks. 
Certificates can be issued for a user, a 
device, or a service.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Certificates .

3 Select any of the following:

Personal: Displays certificates that 
establish your identity when you log in 
to a secured network, such as a 
corporate network.

TIP To change the alarm sound, select the 
alarm sound icon, select the Play Sound list, 
and then select the alarm sound you want to 
use.
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Root: Displays certificates that identify 
the computers, such as servers, that 
you connect to. These certificates help 
prevent unauthorized users from 
accessing your Treo 750 and 
information.

4 Press OK  to finish.

Enabling error reporting

Error Reporting sends info that helps 
diagnose application errors for devices 
running Windows Mobile software. When 
an error is detected, a text file is created. 
You can review the file and choose 
whether you want it delivered to technical 
support. The information is used by 
programming groups at Microsoft for 
quality control and is not used for tracking 
individual users or installations for any 
marketing purpose. The info that is 
collected is technical info about the state of 
your system when the error occurred. No 
documents (or any info contained in them) 

are intentionally sent with the report. To 
ensure further security, the report is 
transmitted via a secure connection and is 
kept confidential and anonymous in a 
limited-access database.

Your Treo 750 must be connected to your 
computer when you send the error 
report—provided your computer is 
connected to the Internet.

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Error Reporting .

3 Select whether you want to enable or 
disable error reporting.

4 Press OK  to finish.

TIP To delete a certificate, tap and hold the 
certificate in the list, and then select Delete 

from the shortcut menu.

DID YOU KNOW? This error reporting method 
meets the privacy regulations of the European 
Union (EU) as well as the Fair Information 
Practice Principles of the Federal Trade 
Commission. To view the Fair Information 
Practice Principles, visit the Federal Trade 
Commission website at www.ftc.gov/reports/
privacy3/fairinfo.htm.
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How much storage space do I have left?

1 Press and hold OK .

2 Select any of the following tabs:

Main: Displays the amount of memory 
assigned to your applications and info, 
as well as the amount of memory in use 
versus the available memory.

Storage Card: Displays the amount of 
memory available on an expansion card 
that is inserted in the expansion slot on 
your Treo 750.

Running Programs: Lists the 
applications that are in use on your Treo 
750. To switch to an application, 
highlight it and select Activate. To close 

an application, highlight it and select 
Stop. To close all open applications, 
select Stop All.

3 Press OK  to finish.

Optimizing power settings

1 Press Start  and select Settings.

2 Select the System tab, and then select 
Power .

TIP An easy way to check the battery level is 
by tapping the Battery icon in the title bar.
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3 On the Battery tab, view the power 
remaining in your battery.

4 Select the Advanced tab and set 
whether your Treo 750 screen turns off 
automatically after a specified period of 
inactivity. You can assign different 
intervals for battery power and external 
power.

5 Press OK  to finish.

Turning wireless services on/off 

1 From the Today screen, press Menu 
 (right action key) and select 

Wireless Manager.

TIP To conserve additional battery power, 
adjust the display backlight setting. Press 
Start and select Settings. Select the System 
tab, and then select Backlight. On the 
Battery Power tab, set whether the display 
backlight turns off automatically after a period 
of inactivity.
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2 Turn the wireless features on your Treo 
750 on/off. Select All to turn all wireless 
features on/off.

3 Press OK  to finish.

You can also turn wireless services on and 
off by tapping the signal-strength  icon 
at the top of the screen, and then selecting 
Wireless Manager. 

Connection settings

Managing ISP settings

Your Treo 750 is already set up to connect 
to the Internet using a high-speed data 
connection on the Cingular network. To 
connect to the Internet, simply start 
Internet Explorer Mobile.

For special situations, such as connecting 
to your internet service provider (ISP) or to 
a remote access server (RAS), you can set 
up another connection.

BEFORE YOU BEGIN Obtain the following 
information from your ISP or system 
administrator:

• ISP server phone number or access 
point

• Username

• Password

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections .

3 On the Tasks tab, select Manage 

existing connections.

TIP To change the settings for one of the 
displayed wireless features, select Menu and 
select the wireless feature you want to 
change.
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4 Select the Modem tab. 

5 Highlight the connection you want to 
view or change, and then select Edit, or 
to create a new connection, select 
New.

6 Follow the onscreen instructions to edit 
or create the connection.

Connecting to a VPN (virtual private 

network)

If you want to use your Treo 750 to access 
your corporate email account or other files 
on your corporate server, you may need to 
set up a VPN. A VPN enables you to log in 
to your corporate server through the 
company’s firewall (security layer).

Check with your company’s system 
administrator to see if a VPN is required to 
access the corporate network. If you need 
a VPN, you must purchase and install a 
third-party VPN client to use this feature. 
Go to www.palm.com/mytreo750cingular 
for more information.

Before you begin setting up a VPN, ask 
your system administrator for the following 
information:

• Your username and password

• Your server’s domain name

• Your server’s TCP/IP settings 

• Your server’s host name or IP address

1 Install your third-party VPN client (see 
Installing applications).

2 Press Start  and select Settings.

3 Select the Connections tab, and then 
select Connections .

4 On the Tasks tab, select Add a new 

VPN server connection.

5 Follow the onscreen instructions to 
enter the settings provided by your 
corporate system administrator.

Setting up a proxy server

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections 

TIP To manually start a data connection on the 
Cingular network or another network, go to 
Connections Settings, and on the Tasks tab, 
select Manage existing connections. Tap 
and hold the connection you want to start, and 
then select Connect from the shortcut menu. 
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3 On the Tasks tab, select Set up my 

proxy server.

4 Check both boxes near the top of the 
screen.

5 Select Proxy server and enter the proxy 
server name.

6 Press OK .

Ending a data connection

If your service plan includes 
minutes-of-use fees for data connections, 
you can reduce costs by ending the data 
connection when you’ve finished browsing 
the web.

1 Use the stylus to tap the data 
connection icons  or  on the title 
bar.

2 Select Disconnect from the shortcut 
menu.

TIP To change settings such as the port 
number, proxy server type, or credentials, 
select Advanced.
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Common questions
Transferring info from 
another device

For information on transferring your info 
from a previous Windows Mobile® device 
or from a Palm OS® device to your new 
Palm® Treo™ 750 smart device, visit 
www.palm.com/us/support/treo/
treo750cingular for instructions.

IMPORTANT Do not use a backup utility to 
transfer your info from another device to 
your new Treo 750. This can cause your 
Treo 750 to malfunction.

DID YOU KNOW? You can purchase a third-party 
application that lets you run Palm OS® 
applications on your Treo 750.

DID YOU KNOW? If you have questions about 
Windows Mobile, you can go to the Microsoft 
Windows Mobile website. Search for Palm 
devices or Pocket PCs for information.
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Reinstalling the 
desktop software

If you have problems synchronizing using 
ActiveSync® desktop software, you may 
need to reinstall the software.

BEFORE YOU BEGIN Make sure your 
computer profile includes administrator 
rights to install software. In large 
organizations, these are usually granted 
by the system administrator.

1 Shut down your computer, and then 
turn it on again.

2 On your computer, click Start > Control 

Panel > Add or Remove Programs.

3 Remove Microsoft ActiveSync if it is on 
your computer.

4 Quit any active applications, including 
virus scanners and Internet security 
applications.

5 Insert the Windows Mobile Getting 
Started Disc into your computer’s CD 
drive and follow the onscreen 
instructions.

You must install the version of 
ActiveSync desktop software that came 
with your Treo 750 on the Windows 
Mobile Getting Started Disc. Other 
versions may not work with this Treo 
750.

Resetting your Treo 
750

Performing a soft reset

Performing a soft reset is similar to 
restarting a computer. If your Treo 750 is 
not responding or you have trouble 
synchronizing with your computer, a soft 
reset may help.

DID YOU KNOW? The Windows Mobile Getting 
Started Disc installs the software and drivers 
that let you synchronize with Microsoft Office 
Outlook®. If you want to synchronize with a 
different personal information manager (PIM), 
you must install a third-party solution. Contact 
the PIM’s vendor to learn if software 
is available for your Treo 750.
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1 Open the expansion card slot door on 
the side of your Treo 750.

2 Use the stylus tip to gently press the 
reset button next to the expansion card 
slot.

3 Wait for the progress bar on the Treo 
logo screen to fill before continuing to 
use your Treo 750.

Performing a hard reset

A hard reset erases all personal 
information, such as appointments, 
contacts, and tasks, as well as programs 
you have added, such as third-party 
software on your Treo 750. Never do a hard 
reset without first trying a soft reset. 
You can restore previously synchronized 
information the next time you sync.

IMPORTANT Synchronize to restore your 
Outlook data, such as Outlook email, 
Calendar, Contacts, Notes, and Tasks. You 
can use a backup and restore solution 
(make sure it’s an application that’s 
approved by Palm, such as the one 
included on the Windows Mobile Getting 
Started Disc) to restore configurations and 
preferences such as speed-dials, SMS 
entries, call log information, and personal 
settings.

TIP You can also do a soft reset by removing 
the battery and reinserting it.

DID YOU KNOW? If the phone or the Bluetooth® 
wireless technology feature was on before a 
reset, these automatically turn on after the 
reset.
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A hard reset can tell you whether a 
problem stems from your Treo 750 or from 
an application installed on it. If you do not 
experience the problem after you perform a 
hard reset, the problem may be related to 
software you installed. See Third-party 
applications for suggestions on diagnosing 
third-party software issues.

1 Open the expansion card slot door on 
the side of your Treo 750.

2 If the screen is off, press Power/End 

 to wake up the screen.

3 While pressing and holding Power/End 
, use the tip of the stylus to gently 

press and hold the reset button next to 
the expansion card slot.

4 Continue pressing and holding both 
buttons until the “Erase all data?” 
prompt appears. 

5 Press Up  to confirm the hard reset.

6 Wait for the progress bar on the Treo 
logo screen to fill before continuing to 
use your Treo 750.

7 (Optional) Synchronize to restore your 
previously synchronized info. If you use 
a backup utility, you may also need to 
restore a backup to recover additional 
info and settings.

Replacing the battery

Your Treo 750 comes with a replaceable 
battery. Be sure to use a replacement 
battery from Palm that is compatible with 
Palm Treo 750 models. Do not use a 
battery from any earlier model of Treo 750.

TIP Some third-party applications do not 
create a backup on your computer when you 
synchronize. If you do a hard reset, you may 
lose info in these applications and you need to 
reinstall the application on your Treo 750 after 
the hard reset. Please contact the developer 
to find out if your info is backed up during 
synchronization.

DID YOU KNOW? When you synchronize after a 
hard reset, the source folder in My 
Documents changes from Treo My 
Documents to WM_your name.
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1 Press Power/End  to turn off the 
screen.

2 Use one hand to press the battery door 
release and use the other hand to slide 
the battery door downward to remove it 
from your Treo 750.

3 Place a finger in the notch between the 
stylus and the battery, and lift the 
battery at a 45-degree angle.

4 Align the battery contacts with the 
phone contacts inside the battery 
compartment.

5 Insert the battery into the compartment 
at a 45-degree angle, pressing it into 
place. Slide the battery door onto the 

back of the Treo 750 until it clicks into 
place.

6 Wait for the screen to turn on.

TIP Be sure to dispose of your old battery in an 
evironmentally responsible and legal way. In 
some areas, disposal in household or 
business trash is prohibited. Visit 
www.Palm.com/environment for more 
information.

DID YOU KNOW? Your Treo 750 stores all your 
info even when you remove the battery.

Battery door 
release

Notch

Phone 
contacts

Battery 
contacts
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Performance

The applications are running slower than 

usual

1 Press Start  and select Settings.

2 Select System, and then select 
Memory .

3 Select Running Programs. 

4 Select Stop All to close all your open 
applications.

5 Press OK .

If the previous steps don’t fix the problem, 
try doing a soft reset (see Performing a soft 
reset). If the problem persists, follow these 
steps to turn off the Voice Command 
setting, if it is enabled:

1 Press Start  and select Settings.

2 Select Personal, and then select Voice 

Command .

3 Uncheck the Enabled box.

4 Press OK .

My battery seems to drain quickly

If you have a push email solution (such as 
GoodLink™ wireless messaging) or if you 
have set up a schedule for wireless 
synchronization, check with your email 
provider or system administrator to make 
sure that the server is set up properly to 
work with your Treo 750. Incorrect server 
setup can cause excessive drain on your 
battery.

For more tips on conversing battery life, 
see Maximizing battery life).

TIP Be sure that third-party applications are 
compatible with Windows Mobile version 5 or 
later. Applications written for earlier versions 
can have performance problems. 

Also make sure to install only apps that use 
Microsoft Windows Mobile 5.0 software for 
Pocket PC Phone Edition. If you can try a free 
version of the software before purchasing it, 
you can test it first to make sure it works 
properly.
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Screen

The screen appears blank

1 If you’re on a call, when the time period 
specified in Backlight Settings expires, 
the screen dims; one minute later, the 
screen automatically turns off. 
Press any key except Power/End to 
wake up the screen. Pressing Power/
End hangs up the call.

2 Look closely at the screen. If you can 
see a dim image, try adjusting the 
screen brightness (see Adjusting the 
brightness).

3 If that doesn’t work, perform a soft 
reset (see Performing a soft reset).

4 If that doesn’t work, connect your Treo 
750 to the AC charger (see Charging the 
battery) and perform a soft reset again.

5 If that doesn’t work, perform a hard 
reset (see Performing a hard reset).

The screen doesn’t respond accurately to 

taps or activates wrong features

1 Make sure there is no debris trapped 
under the edges of the screen.

2 Press Start  and select Settings. 

3 Select the System tab, and then select 
Screen .

4 On the General tab, select Align 

Screen.

5 Follow the onscreen instructions to 
align the screen.

6 Press OK .

Network connection

Signal strength is weak

1 If you’re standing, move about 10 feet (3 
meters) in any direction.

2 If you’re in a building, move near a 
window. Open any metal blinds.

TIP If you are using a third-party application, 
make sure that the application supports 
240x240 screen resolution. Some older 
applications have screen-size limits. 

TIP To find carrying cases that protect the 
screen and other useful accessories, visit 
www.palm.com/mytreo750cingular
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3 If you’re in a building, move outdoors or 
to a more open area.

4 If you’re outdoors, move away from 
large buildings, trees, or electrical wires.

5 If you’re in a vehicle, move your Treo 
750 so that it’s level with a window.

My Treo 750 won’t connect to the mobile 

network

1 Try the suggestions above for weak 
signals.

2 Turn off your phone and turn it on again 
(see Turning your Palm® Treo™ 750 
smart device on/off).

3 Perform a soft reset (see Performing a 
soft reset).

My phone seems to turn off by itself

If a system error and reset occur, the 
phone automatically turns on if it was on 
before the reset. However, if your Treo 750 
can’t determine if your phone was on 
before the reset, it does not automatically 

turn on the phone (see Turning your Palm® 
Treo™ 750 smart device on/off).

I can’t tell if data services are available 

The following icons appear in the title bar 
to indicate whether data services are 
available:

TIP Become familiar with low coverage areas 
where you live, commute, work, and play, so 
you know when to expect signal strength 
issues.

You are in an area that supports 
UMTS services.

Your phone is on and a UMTS data 
connection is active. You can make 
and receive calls and transmit data 
simultaneously.

Your phone is connected to a GPRS 
(EDGE if available) network, but you 
are not actively transmitting data. 
You can still make or receive calls.

Your phone is on and a GPRS 
(EDGE if available) data connection 
is active. Your incoming calls may 
not go through when you are 
actively transmitting data. If you 
make a call, the data transmission 
is automatically interrupted, and 
you must manually resume the 
data connection when you end the 
call.
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My Treo 750 won’t connect to the Internet

Your Treo 750 supports GPRS or UMTS 
wireless data networks. To connect to the 
Internet, you must subscribe to data 
services with Cingular.

• Contact Cingular to verify that your 
subscription plan includes data services 
and that these services have been 
correctly activated. Cingular should also 
be able to tell you if there are any 
outages in your location.

• Press and hold Power/End  to turn 
off your phone. Then press and hold the 
same button to turn it back on.

• Perform a soft reset (see Performing a 
soft reset).

• Confirm that data services are correctly 
configured on your Treo 750 by doing 
the following:

1 Press Start  and select Settings.

2 Select the Connections tab, and then 
select Connections . 

3 On the Tasks tab, select Manage 

existing connections.

4 If Cingular appears in the list, press OK 
. If not, contact Cingular for 

assistance.

I can’t send or receive text or multimedia 

messages

• Make sure your phone is on (see 
Turning your Palm® Treo™ 750 smart 
device on/off).

• Contact Cingular to verify that your plan 
includes messaging services, that these 
services have been correctly activated, 
and that they are available at your 
location. (Cingular should be able to tell 

Your phone is connected to a 
UMTS network, but you are not 
actively transmitting data. You can 
still make or receive calls.

KEY TERM UMTS (Universal Mobile 

Telecommunications System) A 
third-generation (3G) wireless technology that 
is designed for high-speed data transfer with 
rates up to 384 Kbps.

KEY TERM EDGE (Enhanced Data Rates for 

GSM Evolution) A wireless technology that 
can provide fast data transfer and Internet 
access with rates up to 236.8 Kbps.
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you if messaging services have been 
experiencing transmission delays.)

• If possible, contact the recipient or 
sender of the message, and make sure 
the receiving device can handle the type 
of message you’re sending.

• If a text message arrives but does not 
display a notification, perform a soft 
reset (see Performing a soft reset).

I can’t make or receive calls using a 

hands-free device with Bluetooth
®
 

wireless technology

Verify all of the following:

• The Turn on Bluetooth box is checked 
in Bluetooth Settings.

• Your Bluetooth device is charged and 
turned on.

• Your Treo 750 is within range of the 
hands-free device. Bluetooth range is 
up to 30 feet (10 meters) in optimum 
environmental conditions, which include 
the absence of the following: obstacles, 
radio interference from nearby 
electronic equipment, and other factors.

• The Bluetooth Settings screen is closed.

• You are away from other devices using 
the 2.4 GHz radio frequency, such as 
cordless phones, microwaves, and 
Wi-Fi equipment. If this is impossible, 
move the phone closer to the 
hands-free device.

• The device specifications are 
compatible with your Treo 750.

I lost the connection between my Treo 750 

and my Bluetooth headset

1 Press Start , and then select 
Settings.

2 Select the Connections tab, and then 
select Bluetooth.

3 Select Devices tab.

4 Select your headset name from the list.

5 In Partnership Settings, make sure the 
Hands Free option box is checked.

6 Select Save.

7 Highlight the headset name.

8 Press and hold Center  to open the 
shortcut menu, and then select Set as 

Hands-Free.

9 Test your headset by making or 
receiving a call.
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If the headset still doesn’t work, delete the 
existing partnership and create a new one. 
To delete the partnership:

1 Press Start , and then select 
Settings.

2 Select the Connections tab, and then 
select Bluetooth.

3 Highlight the headset device name.

4 Press and hold Center  to open the 
shortcut menu, and then select Delete.

5 Create a new partnership (see 
Connecting to devices with Bluetooth® 
wireless technology.

Synchronization

Synchronization enables you to back up the 
information on your Treo 750 onto your 
computer or your server. If you ever need 
to perform a hard reset or otherwise erase 
all your information on your Treo 750, you 
can synchronize your Treo 750 with your 
computer to restore the info. To make sure 

you always have an up-to-date backup of 
your info, synchronize frequently.

You can synchronize email and other 
information directly with Microsoft 
Exchange Server 2003 with Service Pack 2 
using Microsoft Exchange ActiveSync®, or 
you can synchronize your Treo 750 with 
your computer, using the ActiveSync 
desktop synchronization software from the 
Windows Mobile Getting Started Disc.

ActiveSync desktop software

This section covers issues with 
synchronizing using ActiveSync desktop 
software. See Exchange ActiveSync 
(wireless synchronization) for help with 
direct wireless synchronization with an 
Exchange Server.

DID YOU KNOW? You can go to the Windows 
website for more information at 
www.windowsmobile.com. 

DID YOU KNOW? A common cause of sync 
problems is the presence of protective 
software, such as VPNs or firewalls, on your 
computer or network.
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ActiveSync desktop software does not 

respond to sync attempt

As you complete the following steps, 
synchronize after each step. If the 
synchronization is successful, you do not 
need to complete the remaining steps.

1 Verify that the USB sync cable is 
securely connected at all points (see 
Setting up your computer for 
synchronization).

2 Look for the ActiveSync icon  at the 
top of your Treo 750 screen and the 
ActiveSync icon  in the taskbar on 
your computer to make sure ActiveSync 
desktop software is running on your 
computer. If one or both icons if not 
displayed, do the following:

Treo 750: Press Start , select 
Programs, and then select ActiveSync. 
Select Menu  (right action key), 
and then select Connections. Make 
sure the Synchronize all PCs using 

this connection box is checked, and 
that USB is selected from the list.

Computer: Click Start, navigate to 
Programs, and then select Microsoft 

ActiveSync.

3 Double-click the ActiveSync icon  in 
your taskbar. From the File menu, select 
Connection Settings. Make sure the 
Allow USB connections box is 
checked, and then click Connect.

4 Perform a soft reset (see Performing a 
soft reset).

5 Restart your computer and make sure 
ActiveSync desktop software is running.

6 If problems persist and you’re 
synchronizing through a USB hub, try 
connecting the sync cable to a different 
USB port or directly to your computer’s 
built-in USB port.

7 If you’re already synchronizing through a 
built-in USB port on the front of your 
computer, move the sync cable to a 
USB on the back of your computer (if 
your computer has USB ports in both 
places).

8 Uninstall the desktop software that 
came with your Treo 750, and then 
insert the Windows Mobile Getting 
Started Disc, which came with your 
Treo 750, and repeat the installation 
process (see Reinstalling the desktop 
software).
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9 Delete the existing partnership 
between your Treo 750 and your 
computer and create a new one by 
doing the following:

• Disconnect your Treo 750 and your 
computer from the sync cable.

• Right-click the gray ActiveSync icon 

 in the taskbar in the lower-right 
corner of your computer screen, and 
then select Open Microsoft 

ActiveSync.

• Click File, and then click Delete 

Mobile Device. When asked to 
confirm, click Yes.

• Connect your Treo 750 and your 
computer to the sync cable.

• When the Synchronization Setup 
Wizard appears, follow the steps to 
establish a sync relationship between 
your Treo 750 and your computer.

10 If your organization uses a firewall or a 
VPN connection, synchronizing with 
ActiveSync may not work. Go to 
www.microsoft.com and search for the 

following topics to help with specific 
firewall setup situations:

• ActiveSync USB Connection 
Troubleshooting Guide

• ActiveSync with Sygate Personal 
Firewall

• ActiveSync with TrendMicro PC-cillin 
Internet Security

• ActiveSync with Norton Personal 
Firewall

• ActiveSync with Zone Alarm Security 
Suite

• ActiveSync with McAfee Personal 
Firewall

• ActiveSync with Windows Firewall

11 Verify with your computer hardware 
vendor that your operating system 
supports your internal USB controller.

Synchronization finishes but info doesn’t 

appear where it should

• With the included software, your Treo 
750 can synchronize with the root 
folders of Contacts, Calendar, Tasks, 
and Notes. If you want to synchronize 
with a global Exchange Address Book, 
you must copy the addresses to your 
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local Contacts list in Microsoft Office 
Outlook (right-click the addresses and 
select Add to Personal Address Book).

• Microsoft Office Outlook subfolders and 
public folders are not accessible with 
the included software. You may want to 
use a third-party solution instead.

• If you’re trying to sync offline, be sure 
to set your Microsoft Office Outlook 
Calendar, Contacts, Notes, and Tasks to 
be available offline.

• If you’re still having problems, try the 
following:

1 Make sure you’re synchronizing with 
the intended desktop personal 
information manager (PIM). The 
Windows Mobile Getting Started Disc 
lets you synchronize with Microsoft 
Office Outlook for Windows. If you use 
a different PIM, you need to install 
third-party software to synchronize. For 
more information, consult the company 
that makes the PIM.

2 Open ActiveSync desktop software on 
your computer, and make sure the 
necessary synchronization settings are 
set to synchronize the files.

3 Uninstall ActiveSync desktop software, 
reboot your computer, and then insert 
the Windows Mobile Getting Started 
Disc, which came with your Treo 750, 
and repeat the installation process (see 
Reinstalling the desktop software).

Synchronization starts but doesn’t finish

Make sure that you installed the desktop 
software that came with your Treo 750. If 
you’re not sure whether this software is 
installed, reinstall it (see Reinstalling the 
desktop software).

My video and music files won’t sync

1 Make sure you have Windows Media 
Player 10 installed on your computer.

2 Reinstall your synchronization software 
from the Windows Mobile Getting 
Started Disc, which came with your 
Treo 750 (see Reinstalling the desktop 
software). Media file synchronization 
fails if you installed the synchronization 
software before you installed Windows 
Media Player 10.
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My appointments show up in the wrong 

time slot after I sync

1 Make sure that you installed the 
desktop software that came with 
your Treo 750. If you’re not sure 
whether this software is installed, 
reinstall it (see Reinstalling the desktop 
software).

2 Open Microsoft Office Outlook and 
correct the wrong entries.

3 Manually enter any information you 
added to your Treo 750 since the last 
time you synchronized.

4 Synchronize your phone and your 
computer.

You should now be able to assign time 
zones to your events without encountering 
this problem.

My scheduled sync doesn’t work

By default, a scheduled sync does not work 
while you are roaming. This is to prevent 
roaming charges on your account. If 
roaming charges are not a concern, follow 
these steps to continue your sync schedule 
while roaming:

1 Press Start  and select Programs.

2 Select ActiveSync .

3 Press Menu  (right action key) 
and select Schedule.

4 Check the Use above setting when 

roaming box.

5 Press OK .

An alert tells me that ActiveSync 

encountered a problem on the server

There is a temporary problem with the 
server or the server may be temporarily 
overloaded. Try again later, and if the 
problem persists, contact your system 
administrator.

An alert tells me that there is not enough 

free memory to sync my info

ActiveSync ran out of storage space. Try 
the following:

1 Go to Memory Settings and close all 
running programs. See Closing 
applications for details.

2 If the problem persists, see Making 
room on your Treo 750 for suggestions 
on other ways to free up space on your 
Treo 750.
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An alert tells me that ActiveSync 

encountered a problem with [item type] 

[item name]

An error occurred during the sync of a 
single item. This error can usually be 
corrected only by removing the item that 
caused the error. If you sync again to see if 
the error persists, be aware that items 
causing this type of error are skipped and 
do not show up again.

My Today screen settings are not restored 

after a hard reset

Settings such as the background image and 
plug-in choices are not backed up during 
synchronization, so they can’t be restored 
after a hard reset. If you use a backup 
utility, you may be able to restore a backup 
to recover your Today screen setting and 
other additional info.

Exchange ActiveSync (wireless 

synchronization)

This section covers issues with direct 
wireless synchronization with an Exchange 
Server. See ActiveSync desktop software 
for help with synchronizing using 
ActiveSync desktop software.

An alert tells me that the server could not 

be reached

Your Treo 750 had to wait too long to 
connect to the Exchange Server. The 
connection may have been lost, the server 
may be temporarily overloaded, or the 
server may have encountered an internal 
error. Check your Exchange Server name 
and proxy server settings (see Setting up 
wireless synchronization), and try 
again later.

An alert tells me that my account 

information could not be detected

When you set up the Exchange Server 
sync options, the credentials page was left 
blank. Correct the credentials (see Setting 
up wireless synchronization), or set up your 
Treo 750 to sync only with a computer, and 
try to sync again.

TIP If you are synchronizing with an Exchange 
Server and you’re unable to change your lock 
settings, check with your system 
administrator to find out if a systemwide 
locking policy is in place.
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An alert tells me the device timed out 

while waiting for credentials

The Exchange Server credentials screen 
was left open too long. Re-enter the 
Exchange Server credentials, and try to 
sync again.

Email

NOTE For troubleshooting info on Xpress 
Mail, go to:
https://xpressmail.cingular.com/subscriber

I have problems using my account

Occasionally you may experience problems 
using an email account after you set it up. If 
you followed the account setup procedure 
and are experiencing problems in using the 
account, verify that the account complies 
with your email provider’s requirements by 
following these steps:

• Verify both your password and your 
username for your email account.

• Some email service providers require 
you to be on their network to use your 
email account. If this is the case, be 

sure to use your provider’s network as 
the connection type for the account.

• Some email service providers have 
other requirements specific to their 
service. For example, Yahoo! requires 
you to set up POP mail forwarding for 
your Yahoo! account to download email 
messages to your Treo 750. Check with 
your service provider to see if any 
provider-specific requirements exist.

• Service provider settings frequently 
change. If your email account was 
working but you are currently 
experiencing problems, check with your 
service provider to see if any of the 
account settings have changed.

I have problems sending and receiving 

email

Short periods of time when email is 
unavailable are common due to server 
problems or poor wireless coverage. If you 
have problems sending or receiving mail 
for an extended period of time, check with 
your ISP or email service provider to verify 
that the service is working properly.
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Scheduled email synchronization is not 

working

If email synchronization is occurring and 
you turn your Treo 750 off or the 
connection to your email service provider is 
disconnected, the synchronization fails.

• Check the synchronization schedule to 
make sure that email sync is set to 
occur at the expected day and time. See 
Setting the synchronization schedule for 
details.

• Press Start , select Programs, and 
then select ActiveSync . Press 
Menu  (right action key) and 
select Configure Server. Make sure the 
verify password setting is on. This is 
required for over-the-air synchronization.

I have problems sending email

If you are able to receive email messages 
but cannot send them, try these steps, 
in turn:

• Make sure your ISP or email provider 
allows you to access email on a Treo 
750. Some providers do not offer this 
option at all; other providers require an 

upgrade for accessing email on a Treo 
750.

• Turn on ESMTP. Many services require 
authenticated access, or ESMTP, to use 
their SMTP servers. 

• Press Start , select Programs, and 
then select ActiveSync . Press 
Menu  (right action key) and 
select Configure Server. Make sure the 
SSL box is checked.

• Enter the name of a different outgoing 
mail server for sending mail. Many ISPs, 
such as cable companies, require that 
you have an Internet connection to their 
network to send email through their 
servers. In this case, you can almost 
always receive email from these 
accounts, but if you want to send email, 
you must send it through another 
server.

My vCard or vCal email attachment isn’t 

forwarding correctly

Microsoft Office Outlook provides several 
features that work with email client 
software on a Windows computer. For 
these features to work correctly, the email 
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client software must be properly set up. 
Follow these steps to check the settings:

1 Click Start on your computer, and then 
select Settings.

2 Select Control Panel.

3 Select Internet Options, and then click 
the Programs tab.

4 Make sure that the email field is set to 
the correct email client software. 

5 Click OK.

6 Start the email client software and 
make sure it is configured as the default 
MAPI client. Consult the documentation 
for your desktop email application for 
more information.

When I sync with my Exchange Server my 

info is not downloading to my Treo 750

Check with your system administrator to 
obtain the name of the mail server that 
offers you wireless access to the corporate 
mail system. If you cannot obtain the name 
of this server (some companies do not give 
it out, because they do not want wireless 
access to their servers), you cannot use 
Exchange ActiveSync to synchronize with 

the Exchange Server. You can also check 
the following setting:

1 Press Start  and select Programs. 

2 Select ActiveSync . 

3 Press Menu  (right action key) 
and select Configure Server. 

4 Make sure the SSL box is checked.

Web

I can’t access a page

First, make sure you have Internet access: 
Open Internet Explorer Mobile and try to 
view a web page you’ve loaded before. To 
ensure that you’re viewing the page 
directly from the Internet, press Menu 

 (right action key) and select Refresh. 
After confirming your Internet connection, 
try to view the page in question again. If it 
comes up blank, press Menu  (right 
action key) and select Refresh.

If you’re still having trouble, the page may 
contain elements that are not supported by 
Internet Explorer Mobile, such as Flash, 
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Shockwave, VBScript, WML script, and 
other plug-ins.

Some websites use a redirector to their 
true home page (for example, if you enter 
the address http://www.Palm.com/support 
it may resolve to http://www.Palm.com/us/
support). If Internet Explorer Mobile can’t 
follow the redirect, try using a desktop 
browser to see the landing page of the 
redirector, and enter that address in 
Internet Explorer Mobile.

An image or map is too small on my Treo 

750 screen

Internet Explorer Mobile has several 
viewing modes: One Column, Default, 
Desktop, and Full Screen. Switch to 
Desktop to see the full-size image (see 
Viewing a web page).

A secure site refuses to permit a 

transaction

Some websites don’t support certain 
browsers for transactions. Please contact 
the site’s webmaster to make sure the site 
allows transactions using Internet Explorer 
Mobile.

Camera

If your Treo 750 does not have a built-in 
camera, the information in this section 
about taking pictures does not apply to 
you. 

Here are some tips for taking good pictures 
with the built-in camera:

TIP Your Treo 750 can open your email 
application when you select an email address 
on a web page. If nothing happens when you 
select the link, try setting up your email 
application first.

DID YOU KNOW? Pictures are 16-bit color. 
Resolution settings range from 1280 x 1024 to 
160 x 120 pixels (1.3 megapixels to VGA). 
Video resolution settings range from 352 x 
288 to 176 x 144 pixels. You can change the 
resolution setting by pressing Menu (right 
action key) and selecting Resolution (still 
images) or Quality (video).
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• Clean the camera’s lens with a soft, 
lint-free cloth.

• Take pictures in bright lighting 
conditions. Low-light images may be 
grainy, due to the sensitivity of the 
camera.

• Hold the camera as still as possible. Try 
supporting your picture-taking arm 
against your body or a stationary object 
(such as a wall).

• Keep the subject of the pictures still. 
Exposure time is longer with lower light 
levels, so you may see a blur.

• For best results, verify that you have the 
brightest light source coming from 
behind you, lighting the subject’s face. 
Avoid taking indoor pictures with the 
subject in front of a window or light.

• Make sure the subject is at least 
18 inches (0.5 meters) away from the 
camera to ensure good focus.

Remember that when you synchronize, 
your Camera images are stored in the 
C:\Documents and 
Settings\<Username>\My Documents\Treo 
My Documents folder on your hard drive 
(see Camera).

The Camera preview image looks strange

Some third-party applications overwrite the 
color settings on your Treo 750 with their 
own 8-bit color settings. This can affect the 
Camera Preview Mode. Delete third-party 
applications one by one until the preview 
image improves.

Third-party 
applications

Sometimes third-party applications can 
cause conflicts on your Treo 750. 
Third-party applications that modify 
wireless features may affect the 
performance of your Treo 750 and may 
require extra troubleshooting. Use caution 
when installing the following types of 
applications:

• Ringtone managers

• Caller ID applications

• Instant messaging

• Applications that modify when your 
phone or data connections turn on or off 
and how your phone behaves



C O M M O N  Q U E S T I O N S

M A K I N G  R O O M  O N  Y O U R  T R E O  7 5 0246

13
C

H
A

P
T

E
R

If you recently installed an application and 
your Treo 750 seems to be stuck, try the 
following:

1 Perform a soft reset (see Performing a 
soft reset).

2 Make sure the third-party application is 
compatible with the Windows Mobile 
version 5.2 operating system on your 
Treo 750.

3 Delete the most recently installed 
application from your Treo 750 (see 
Removing applications).

4 If the problem persists, perform another 
soft reset.

5 If possible, synchronize or use a backup 
utility to back up your most recent info.

6 Perform a hard reset (see Performing a 
hard reset).

7 Synchronize or restore your backup to 
restore the info in your built-in 
applications.

8 If the problem is resolved, begin 
reinstalling your third-party applications 
one at a time.

9 If the problem recurs, delete the last 
application you installed and report the 
problem to its developer.

Getting more help

Contact the vendor of any third-party 
software if you require further assistance. 

Making room on your 
Treo 750

If you store a large number of records, or 
install many third-party applications, the 
internal memory on your Treo 750 may fill 
up. Here are some common ways to clear 
space on your Treo 750:

• Camera: Large images or videos take 
up a lot of memory. Move images to an 

TIP Remember that not all third-party 
applications were written with the Treo 750 
Treo 750 keyboard and 5-way navigator in 
mind. You may encounter strange behavior or 
errors in these applications if you use the 
keyboard and the 5-way navigator.
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expansion card or delete images from 
your Treo 750 (see Pictures & Videos).

• Messaging: Multimedia content and 
email attachments can consume 
excessive memory. Move multimedia 
content and attachments to an 
expansion card, or delete large files 
from your Treo 750 (see Message 
status icons). You may also want to 
empty the deleted items folder.

• Internet: If you save links to pages 
you’ve visited in Internet Explorer 
Mobile, you may want to clear all recent 
pages (see Customizing your Internet 
Explorer Mobile settings).

• Third-party applications: You can 
delete infrequently used applications or 
move them to an expansion card (see 
Copying or moving applications and files 
between your Treo 750 and an 
expansion card).

Also, remember that your Treo 750 
includes an expansion card slot, and that 
you can store applications and information 
on expansion cards. However, you still 
need free memory on the Treo 750 itself 
to run applications from an expansion card.

Voice quality

Is the other person hearing an echo?

• Try decreasing the volume on your Treo 
750 to avoid coupling or feedback on 
the other person’s end. This applies to 
both the speakerphone and to the 
handset earpiece.

• Position the Treo 750 closer to your ear 
to prevent sound leaking back to the 
microphone. Keep your hand away from 
the microphone hole, which is on the 
lower-right side of your Treo 750.

• If you’re using Speakerphone mode 
with your Treo 750 lying on a flat 
surface, try turning the Treo 750 “face 
down” (screen facing the surface).

Are you hearing your own voice echo?

Ask the other person to turn down their 
volume or to hold the Treo 750 closer to 
their ear.
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Is your voice too quiet on the other end?

Be sure to hold the bottom of the Treo 750, 
or the hands-free microphone, close to 
your mouth.

Check the signal strength indicator. If the 
signal is weak, try to find an area with 
better coverage.
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Where to learn more

For a quick introduction

• Quick Tour: The Quick Tour introduces 
you to many of your Palm® Treo™ 750 
smart device’s features. It is already 
installed on your Treo 750, and you can 
open it any time. Press Start , select 
Programs, and then select Quick Tour 

.

While using your Treo 750

• On-device User Guide: A copy of this 
guide is included on your Treo 750. The 
on-device guide is specially formatted 
for your Treo 750 screen. To view the 
on-device guide, press Start  and 
select Help.

• Online support from Palm: For 
up-to-date downloads, troubleshooting, 
and support information, go to

www.palm.com/us/support/treo/
treo750cingular.

If you need more information

• Books: Many books on Windows 
Mobile® devices are available in local or 
online book retailers (look in the 
computers section), or visit 
www.palm.com/mytreo750cingular.

• Online forums: Consult online Treo 750 
device user discussion groups to swap 
information and learn about topics you 
may find nowhere else. Visit 
www.palm.com/us/support/treo/
treo750cingular for details.

• Customer service from Cingular: For 
questions about your mobile account or 
features, contact Cingular customer 
care at 1-866-CINGULAR 
(1-866-246-4852) or dial 611 from your 
Treo 750.
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Terms

ActiveSync®

The technology that exchanges and 
updates the information on your Palm® 
Treo™ 750 smart device with the 
information on your computer. To open 
ActiveSync on your computer, double-click 
the ActiveSync icon in the taskbar in the 
lower-right corner of your screen. If the 
icon does not appear, click Start, click All 
Programs (or navigate to the Programs 
group), and then select Microsoft 
ActiveSync. See Installing the desktop 
synchronization software.

Alt (alternative) 

The key that you use to enter accented 
characters and symbols that do not appear 
on your keyboard. Press Alt , and then 
press a key on the keyboard to view the 
alternative characters available for that key. 
See Entering other symbols and accented 
characters.

auto-off interval

The time of inactivity that passes before 
the screen on your Treo 750 turns off. The 

wireless features on your Treo 750 are 
unaffected by this setting. See Optimizing 
power settings.

beam

The process of sending or receiving an 
entry or application using the infrared port 
on your Treo 750 or using Bluetooth® 
wireless technology. See Beaming 
information.

Bluetooth® wireless technology

Technology that enables devices such as 
smart devices, mobile phones, and 
computers to connect wirelessly to each 
other so that they can exchange 
information over short distances. For more 
info, visit www.bluetooth.com. See 
Connecting to devices with Bluetooth® 
wireless technology.

desktop software

A PIM application for computers, such as 
Microsoft Outlook®, that helps you 
manage your personal information and 
keep it synchronized with your Treo 750. 
See Installing the desktop synchronization 
software.
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dialog box

A set of options and command buttons that 
is enclosed by a border and that enables 
you to carry out a specific task.

EDGE (Enhanced Data rates for GSM 

Evolution)

An enhanced version of GPRS that delivers 
data speeds that are up to three times 
faster than standard GPRS connections, 
with rates up to 236.8 Kbps. (Additional 
charges may apply.) See What are all those 
icons?

GPRS (General Packet Radio Service)

A mobile Internet connectivity technology 
that allows persistent data connections. 
(Additional charges may apply.) See What 
are all those icons?

infrared (IR)

A way of transmitting information using 
light waves. You use the IR port on 
your Treo 750 to transfer information 
between other IR devices within a 
short radius. See Beaming information.

Lithium Ion (Li-Ion)

The rechargeable battery technology used 
in your Treo 750. See Charging the battery.

Microsoft Exchange ActiveSync®

Technology that allows your Treo 750 to 
synchronize email, contacts, calendar 
events, and tasks wirelessly with Microsoft 
Exchange Server 2003. See Setting up 
wireless synchronization.

MMS (Multimedia Messaging System)

An enhanced messaging system that 
enables you to send pictures, animations, 
and ringtones almost instantly. See 
Creating and sending a multimedia 
message.

Mobile Device

The component on your Windows 
computer that enables you to install 
applications and other information on your 
Treo 750. To access it, open Windows 
Explorer or My Computer and look for the 
Mobile Device  entry. See Installing 
applications from your computer.

Option 

Press this key and then a second key to 
enter the character or to access the feature 
displayed above the letter on the second 
key. See Entering numbers, punctuation, 
and symbols.
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partnership

The connection that you make between 
two devices by means of Bluetooth 
wireless technology. The devices recognize 
each other because each device finds the 
same passkey on the other device. After 
you create a partnership between the 
devices, you no longer need to enter the 
passkey. Partnership is also known as 
paired relationship, pairing, trusted device, 
and trusted pair on some devices. See 
Connecting to devices with Bluetooth® 
wireless technology.

Phone Off

Appearing on the Today screen, this 
indicates that your Treo 750 is not 
connected to any network, and you cannot 
make calls except those to emergency 
numbers. You can still use the organizer 
features, however. To turn the phone on/
off, go to the Wireless Manager. See 
Turning your phone on.

Phone/Send 

The button on your Treo 750 that provides 
quick access to your Today screen and dials 
once you’ve entered a phone number. See 
Making calls from the Today screen.

PIM (personal information manager)

A genre of software that includes 
applications such as Microsoft Outlook, 
Palm® Desktop software, Lotus Notes, 
and ACT!. PIMs generally store contacts, 
schedules, tasks, and memos. 

PIN (personal identification number)

The password assigned to your SIM card 
by Cingular. Turning on the PIN lock 
secures your wireless account. See also 
PUK. See Locking the SIM card.

PIN2 (personal identification number 2)

A code that protects certain network 
settings such as fixed dialing. 

PUK (PIN unlock key)

A special extended password assigned to 
your SIM card. If you enter the wrong PIN 
more than the allowed number of times, 
your SIM is blocked and you must call 
Cingular for the PUK. See Locking the SIM 
card.

SIM (Subscriber Identity Module) card

The smartcard, inserted into your Treo 750, 
that contains your mobile account 
information, such as your phone number 
and the services to which you subscribe. 
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Addresses and phone numbers and SMS 
messages can also be stored on the SIM 
card. See Inserting the SIM card and 
battery.

SMS (Short Messaging Service)

The service that exchanges short text 
messages almost instantly between 
mobile devices. Your Treo 750 can send 
and receive text messages while you are 
on a call. See Creating and sending a text 
message.

Start 

The menu on your Treo 750 from which you 
can open all applications. See Opening 
applications.

streaming

Technology that enables you to access 
media content—for example, watch video 
or listen to an audio program—directly 
from the Internet on your Treo 750 without 
needing to download a file to save on your 
Treo 750. See Viewing a video.

synchronization

The process in which information that is 
entered or updated on your Treo 750, your 
computer, or a server is instantly updated 

in one of the other locations either 
wirelessly or by means of a cable 
connection. See Synchronizing information.

UMTS (Universal Mobile 

Telecommunications System)

One of the third-generation (3G) mobile 
phone technologies that is designed for 
high-speed data transfer with rates up to 
384 Kbps. It uses W-CDMA as the 
underlying technology. See What are all 
those icons?

username

The name associated with your Treo 750 
that distinguishes it from other Windows 
Mobile® devices. If you install 
ActiveSync® desktop software, you are 
asked to give your Treo 750 a username. If 
you only synchronize wirelessly using 
Microsoft Exchange ActiveSync, you do not 
need to give your Treo 750 a username. 
See Installing the desktop synchronization 
software.

Windows Mobile

The operating system of your Treo 750 Treo 
750. Your Treo 750 uses Windows Mobile® 
5.2. When installing third-party applications 
to your Treo 750, be sure to install only 
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apps that use Microsoft Windows Mobile 
5.0 software for Pocket PC Phone Edition. 
The Microsoft Windows Mobile 5.0 

software for Smartphone is not compatible 
with your Treo 750. See Installing 
third-party applications.
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Regulatory 
information
FCC Statement 

This equipment has been tested and found to comply with the limits 
for a Class B computer peripheral, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different 
from that to which the receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

This device complies with part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) This device may not cause 
harmful interference, and (2) this device must accept any interference 
received, including interference that may cause undesired operation.

RF Safety Exposure 

To Radio Frequency Energy (SAR) Radio transmitting devices radiate 
Radio Frequency (RF) energy during its operation. RF energy can be 
absorbed into the human body and potentially can cause adverse 
health effects if excessive levels are absorbed. The unit of 
measurement for human exposure to RF energy is “Specific 
Absorption Rate” (SAR). 

The Federal Communications Commission (FCC), Industrie Canada 
(IC), and other agencies around the world have established limits that 
incorporate a substantial safety margin designed to assure the safety 
of all persons using this equipment. 

In order to certify this unit for sale in the US, Canada and Europe this 
unit has been tested for RF exposure compliance at a qualified test 
laboratory and found to comply with the regulations regarding 
exposure to RF Energy. 

SAR was measured with the unit transmitting at its maximum 
certified RF power. Often, however, during normal operation the unit 
will transmit much less than maximum power. Transmit power is 
controlled automatically and, in general is reduced as you get closer 
to a cellular base station. This reduction in transmit power will result 
in a lower RF energy exposure and resulting SAR value. 

FCC RF Safety Statement 

In order to comply with FCC RF exposure safety guidelines, users 
MUST use one of the following types of bodyworn accessories. 

• A Palm® brand body-worn accessory that has been tested for 
SAR compliance and is intended for use with this product. 

• An accessory that contains NO metal (snaps, clips, etc) and 
provides AT LEAST 1.5 cm of separation between the users body 
and the unit. 

Do NOT use the device in a manner such that it is in direct 
contact with the body (i.e. on the lap or in a breast pocket). Such use 
will likely exceed FCC RF safety exposure limits. See 
www.fcc.gov/oet/rfsafety/ for more information on RF exposure 
safety.

Responsible party

(North America) (Europe)
Palm Inc. Roy Bedlow
950 W. Maude Ave. Buckhurst Court 
Sunnyvale, CA 94085 London Road
USA Wokingham, Berkshire RG40 1PA,
www.Palm.com UK
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Antenna Care/Unauthorized Modifications 

Use only the supplied integral antenna. Unauthorized antenna 
modifications or attachments could damage the unit and may violate 
FCC regulations. Any changes or modifications not expressly 
approved by the party responsible for compliance could void the 
user’s authority to operate the equipment.

Potentially Unsafe Areas 

Potentially explosive atmospheres: Turn off your Treo 750 when you 
are in any areas with a potentially explosive atmosphere, such as 
fueling areas (gas or petrol stations) or storage facilities for fuel or 
chemicals.

Declaration of Conformity

Treo 750

Palm declares that the above model of Treo 750 is compliant with the 
regulations below. The declaration applies to the Treo 750 and its 
associated accessories (power supply, headset, and USB cable) 
where applicable. 

To view the highest reported (FCC) SAR values of the Treo™
750, visit www.palm.com/38057.

FCC OET Bulletin 65 Supplement C

Safety: EN 60950: 2000 (Jan-2000)

Radiated Emissions: EN 55022

FCC ID: O8F-KITT

IC ID: 3905A-KITT
Operational Warnings

IMPORTANT INFORMATION ON SAFE AND EFFICIENT 
OPERATION. Read this information before using your integrated 
multi-service portable radio. 

For the safe and efficient operation of your radio, observe these 
guidelines:

Potentially Unsafe Areas/Potentially explosive 

atmospheres Obey all signs and instructions regarding turning off 
your Treo 750. In particular, turn off your Treo 750 when you are in any 
areas with a potentially explosive atmosphere, such as fueling areas 

Using TTY 

A TTY (also known as TDD or text telephone) is a 
telecommunications device that allows people who are deaf or 
hard of hearing, or who have speech or language disabilities, to 
communicate by telephone.

Your Palm Treo 750 is compatible with select TTY devices. You can 
connect a TTY/TDD machine to your Treo 750 through the headset 
jack, but you cannot use your headset jack with a headset or 
hands-free kit while this mode is enabled. Please check with the 
manufacturer of your TTY device for connectivity information and 
to ensure that the TTY device supports digital wireless 
transmission.

To use TTY, you may need to make additional arrangements with 
Cingular. Please contact Cingular’s customer service department 
for more information.

1 Press the Start button and select Settings.

2 Select Personal, and then select Phone.

3 Select Phone.

4 Select the TTY/TDD list, and then select either Default mode, 
VCO mode, or HCO mode.

5 Press OK. A keyboard icon appears at the top of your Today 
screen whenever TTY is enabled.

To disable TTY, repeat steps 1 and 2.
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(gas or petrol stations, below deck on boats), storage facilities for fuel 
or chemicals, blasting areas and areas near electrical blasting caps, 
and areas where there are chemicals or particles (such as metal 
powders, grains, and dust) in the air.

Interference to Medical and Personal Electronic Devices Most 
but not all electronic equipment is shielded from RF signals and 
certain electronic equipment may not be shielded against the RF 
signals from your Treo 750.

Pacemakers The Health Industry Manufacturers Association 
recommends that a minimum separation of six inches (6") be 
maintained between a Treo 750 and a pacemaker to avoid potential 
interference with the pacemaker. These recommendations are 
consistent with the independent research by the recommendations 
of Wireless Technology Research.

Persons with pacemakers should:

• ALWAYS keep the Treo 750 more than six inches from their 
pacemaker when the Treo 750 is turned ON. 

• Not carry the Treo 750 in a breast pocket.

• Use the ear opposite the pacemaker to minimize the potential for 
interference.

• Turn the Treo 750 OFF immediately if you have any reason to 
suspect that interference is taking place.

Audio Safety Some hearing aids may be affected by some digital 
Treo 750 models. You may want to consult your doctor in the event of 
you experience interference with your hearing aid while using your 
Treo 750. When using the speakerphone feature, it is recommended 
that you place your Treo 750 at a safe distance from your ear. 

Other Medical Devices If you use any other personal medical 
device, consult the manufacturer of your device to determine if it is 
adequately shielded from external RF energy. Your physician may be 
able to assist you in obtaining this information.

Turn your Treo 750 OFF in health care facilities when any regulations 
posted in these areas instruct you to do so. Hospitals or health care 
facilities may be using equipment that could be sensitive to external 
RF energy.

Interference to Other Electronic Devices RF energy may affect 
improperly installed or inadequately shielded electronic operating and 
entertainment systems in motor vehicles. Check with the 
manufacturer or representative to determine if these systems are 
adequately shielded from external RF energy. Also check with the 
manufacturer of any equipment that has been added to the vehicle.

Repetitive Motion Injuries When using the keyboard or playing 
games on your Treo 750, you may experience discomfort in your 
neck, shoulders, hands, arms, of other parts of the body. To avoid any 
injury, such as tendonitis, carpal tunnel syndrome, or other 
musculoskeletal disorder, make sure to take necessary breaks from 
use, take longer rests (such as several hours) if discomfort or tiring 
begins, and see a doctor if discomfort persists.

Blackouts and Seizures Blinking lights, such as those experienced 
with television or playing video games, may cause some people to 
experience blackout or seizure, even if never experienced before. In 
the event a Treo 750 user should experience any disorientation, loss 
of awareness, convulsion, eye or muscle twitching or other 
involuntary movements, stop use immediately and consult a doctor. 
Individuals with personal or family history of such events should 
consult a doctor before using the device. To limit the possibility of 
such symptoms, wherever possible every hour take a minimum of 15 
minutes, use in a well lighted area, view the screen from the farthest 
distance and avoid exposure to blinking lights if you are tired. 

Aircraft While in aircraft, follow all instructions regarding the 
operation of your Treo 750. Use of your Treo 750 while on board on 
aircraft must be done in accordance in compliance with airline 
instructions and regulations.

Vehicles with Air Bags Your Treo 750 should not be placed in a 
position that would affect the operation of air bag deployment or in a 
position that, should the air bag inflate, could propel the Treo 750. Air 
bags will inflate with great force and care should be taken to protect 
within a vehicle that has air bags.

Battery Your Treo 750 includes an internal lithium ion battery. 
Please note that use of certain data applications can result in heavy 
battery use and may require frequent battery charging. Any disposal 
of the Treo 750 must comply with laws and regulations pertaining to 
lithium ion batteries. 
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Driving Safety Tips Overview

Always obey all laws and regulations on the use of the Treo 750 in 
your driving area.

Safety — Your most important call. The Wireless Industry reminds 
you to use your Treo 750 safely when driving.

1 Get to know your Treo 750 and its features, such as speed-dial 
and redial.

2 When available, use a hands-free device.

3 Position your Treo 750 within easy reach.

4 Let the person you are speaking to know you are driving; if 
necessary, suspend the call in heavy traffic or hazardous weather 
conditions.

5 Do not take notes or look up phone numbers while driving.

6 Dial sensibly and assess the traffic; if possible, place calls when 
you are not moving or before pulling into traffic.

7 Do not engage in stressful or emotional conversations that may 
divert your attention from the road.

8 Dial 9-1-1 to report serious emergencies -it’s free from your Treo 
750!

9 Use your Treo 750 to help others in emergencies.

10 Call roadside assistance or a special non-emergency wireless 
number when necessary.

Driving Safety Tips Details

1 Get to know your Treo 750 and its features such as speed-dial and 
redial. Carefully read your instruction manual and learn to take 
advantage of valuable features most Treo 750 models offer 
including, automatic redial and memory dial-most Treo 750 
models can store up to 99 numbers in memory dial. Also, work to 
memorize the Treo 750 keypad so you can use the speed-dial 
function without taking your attention off the road.

2 When available, use a hands-free device. A number of hands-free 
Treo 750 accessories are readily available today. Whether you 
choose an installed mounted device for your Treo 750 or a 

speaker phone accessory, take advantage of these devices if 
available to you.

3 Position your Treo 750 within easy reach. Make sure you place 
your Treo 750 within easy reach and where you can grab it 
without removing your eyes from the road. If you get an incoming 
call at an inconvenient time, let your voice mail answer it for you.

4 Suspend conversations during hazardous driving conditions or 
situations. Let the person you are speaking to know you are 
driving; if necessary, suspend the call in heavy traffic or 
hazardous weather conditions. Rain, sleet, snow and ice can be 
hazardous, but so is heavy traffic. As a driver, your first 
responsibility is to pay attention to the road.

5 Do not take notes or look up phone numbers while driving. If you 
are reading an address book or business card while driving a car, 
or writing a “to do” list, then you are not watching where you are 
going. It’s common sense. Don’t get caught in a dangerous 
situation because you are reading or writing and not paying 
attention to the road or nearby vehicles.

6 Dial sensibly and assess the traffic; if possible, place calls when 
you are not moving or before pulling into traffic. Try to plan your 
calls before you begin your trip, or attempt to coincide your calls 
with times you may be stopped at a stop sign, red light or 
otherwise stationary. But if you need to dial while driving, follow 
this simple tip-dial only a few numbers, check the road and your 
mirrors, then continue.

7 Do not engage in stressful or emotional conversations that may 
be distracting. Stressful or emotional conversations and driving 
do not mix-they are distracting and even dangerous when you are 
behind the wheel. Make people you are talking with aware you 
are driving and if necessary, suspend phone conversations which 
have the potential to divert your attention from the road.

8 Use your Treo 750 to call for help. Your Treo 750 is one of the 
greatest tools you can own to protect yourself and your family in 
dangerous situations-with your Treo 750 at your side, help is only 
three numbers away. Dial 9-1-1 in the case of fire, traffic accident, 
road hazard, or medical emergencies. Remember, 9-1-1is a free 
call on your Treo 750!
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9 Use your Treo 750 to help others in emergencies. Your Treo 750 
provides you a perfect opportunity to be a “good Samaritan” in 
your community. If you see an auto accident, crime in progress, 
or other serious emergency where lives are in danger, call 9-1-1, 
as you would want others to do for you.

10 Call roadside assistance or a special wireless non-emergency 
assistance number when necessary. Certain situations you 
encounter while driving may require attention, but are not urgent 
enough to merit a call to 9-1-1. But you can still use your Treo 750 
to lend a hand. If you see a broken-down vehicle posing no 
serious hazard, a broken traffic signal, a minor traffic accident 
where no one appears injured, or a vehicle you know to be 
stolen, call roadside assistance or other special non-emergency 
wireless number.

NOTICE FOR CONSUMERS WITH HEARING 

DISABILITIES

Digital Wireless Phones to be Compatible with Hearing Aids On 
July 10, 2003, the Federal Communications Commission (FCC) 
modified the exemption for wireless phones under the Hearing Aid 
Compatibility Act of 1988. This means that wireless phone 
manufacturers and service providers must make digital wireless 
phones accessible to individuals who use hearing aids.

For more information, please go to the FCC’s Consumer Alert on 
accessibility of digital wireless phones at http://www.fcc.gov/cgb/
consumerfacts/accessiblewireless.html.

Wireless telephones are hand-held phones with built-in antennas, 
often called cell, mobile, or PCS phones. These phones are popular 
with callers because they can be carried easily from place to place.

Wireless telephones are two-way radios. When you talk into a 
wireless telephone, it picks up your voice and converts the sound to 
radio frequency energy (or radio waves). The radio waves travel 
through the air until they reach a receiver at a nearby base station. 
The base station then sends your call through the telephone network 
until it reaches the person you are calling.

When you receive a call on your wireless telephone, the message 
travels through the telephone network until it reaches a base station 
close to your wireless phone. Then the base station sends out radio 
waves that are detected by a receiver in your telephone, where the 
signals are changed back into the sound of a voice.

The Federal Communications Commission (FCC) and the Food and 
Drug Administration (FDA) each regulate wireless telephones. FCC 
ensures that all wireless phones sold in the United States follow 
safety guidelines that limit radio frequency (RF) energy. FDA monitors 
the health effects of wireless telephones. Each agency has the 
authority to take action if a wireless phone produces hazardous levels 
of RF energy.

FDA derives its authority to regulate wireless telephones from the 
Radiation Control provisions of the Federal Food, Drug, and Cosmetic 
Act (originally enacted as the Radiation Control for Health and Safety 
Act of 1968). [http://www.fda.gov/cdrh/comp/eprc.html].

FCC derives its authority to regulate wireless telephones from the 
National Environmental Policy Act of 1969 (NEPA) and the 
Telecommunications Act of 1996 
http://www.fcc.gov/telecom.html]. Updated 7/16/2003

Hands-Free Capability All CTIA Certified portable products provide 
the consumer with a toll-free number for the purchase of a 
compatible hands-free device. 1-800-881-7256

STATIC ELECTRICITY, ESD, AND YOUR PALM DEVICE

Electrostatic discharge (ESD) can cause damage to electronic devices 
if discharged into the device, so you should take steps to avoid such 
an occurrence.
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Description of ESD Static electricity is an electrical charge caused 
by the buildup of excess electrons on the surface of a material. To 
most people, static electricity and ESD are nothing more than 
annoyances. For example, after walking over a carpet while scuffing 
your feet, building up electrons on your body, you may get a shock—
the discharge event—when you touch a metal doorknob. This little 
shock discharges the built-up static electricity.

ESD-susceptible equipment Even a small amount of ESD can 
harm circuitry, so when working with electronic devices, take 
measures to help protect your electronic devices, including your 

Palm® device, from ESD harm. While Palm has built protections 
against ESD into its products, ESD unfortunately exists and, unless 
neutralized, could build up to levels that could harm your equipment. 
Any electronic device that contains an external entry point for 
plugging in anything from cables to docking stations is susceptible to 
entry of ESD. Devices that you carry with you, such as your Palm 
device, build up ESD in a unique way because the static electricity 
that may have built up on your body is automatically passed to the 
device. Then, when the device is connected to another device such 
as a docking station, a discharge event can occur. 

Precautions against ESD Make sure to discharge any built-up 

static electricity from yourself and your electronic devices before 
touching an electronic device or connecting one device to another. 
The recommendation from Palm is that you take this precaution 
before connecting your Palm device to your computer, placing the 
device in a cradle, or connecting it to any other device. You can do 
this in many ways, including the following: 

• Ground yourself when you’re holding your device by 
simultaneously touching a metal surface that is at earth ground. 
For example, if your computer has a metal case and is plugged 
into a standard three-prong grounded outlet, touching the case 
should discharge the ESD on your body.

• Increase the relative humidity of your environment.

• Install ESD-specific prevention items, such as grounding mats.

Conditions that enhance ESD occurrences Conditions that can 
contribute to the buildup of static electricity in the environment 
include the following:

• Low relative humidity.

• Material type (The type of material gathering the charge. For 
example, synthetics are more prone to static buildup than natural 
fibers like cotton.)

• The rapidity with which you touch, connect, or disconnect 
electronic devices.

While you should always take appropriate precautions to discharge 
0ectricity, if you are in an environment where you notice ESD events, 
you may want to take extra precautions to protect your electronic 
equipment against ESD.

Precaution against hearing loss Protect your hearing. Listening to this 
device at full volume for a long period of time can damage your 
hearing. 

A pleine puissance, l'écoute prolongée du baladeur peut 
endommager l'oreille de l'utilisateur. Consultez notre site web 
www.palm.com/fr pour plus d'informations.

Waste disposal Please recycle appropriately. For appropriate recycling 
and disposal instructions please visit: www.palm.com/environment.
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Specifications

Radio • Dual mode GSM/UMTS phone

• GSM 850/900/1800/1900 quad band 

• UMTS 850/1900/2100 tri-band

• GPRS Multi-slot Class 10, Class B

• EDGE up to 59kbps per time-slot 

• UMTS PS data up to 384kbps DL

Phone features • Personal speakerphone

• Hands-free headset jack (2.5 mm, 3-barrel connector)

• Microphone mute option

• TTY compatible 

Processor technology • Samsung processor—300MHz 

Expansion • miniSD card slot

Battery • Rechargeable Lithium Ion

• 1200mAh power

• Removable for replacement

• 3 hours full charge time

Operating system • Windows Mobile Edition 5.2. (Phone Edition)

Camera (not included 
on all Treo 750 models)

• Still image capture resolution:1280 x 1024, 1.3 megapixel

• 2x digital zoom
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Size • 14.44 in. x 2.34 in. x 0.84 in. 
(112.9mm x 59.3mm x 21.3mm)

Weight • 5.4 ounces (154 grams)

Connectivity • Infrared (1.0 compliant)

• Bluetooth® wireless technology (1.2 compliant)

Display • Touch-sensitive LCD screen (includes stylus)

• 65,536 colors (16-bit color)

• Resolution: 240 x 240 

• User-adjustable brightness

Keyboard • Built-in QWERTY keyboard plus 5-way navigator

• Backlight for low lighting conditions
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Included software • Today/Phone (includes 
Speed Dial and Dial Pad)

• Messaging (text, 
multimedia, and email)

• Internet Explorer Mobile 
(web browser)

• Camera

• Pictures & Videos

• Windows Media Player 
Mobile

• File Explorer

• Contacts

• Calendar

• Tasks

• Notes

• Calculator

• ActiveSync®

• Excel Mobile

• Word Mobile

• PowerPoint Mobile

• Voice Command

• Quick Tour

• Search

• Terminal Services

• Picsel PDF Viewer

• Bluetooth Plug-in

System requirements • Windows 2000 or XP (later versions may also be 
supported

• 32MB of available memory (RAM)

• 170MB of free hard disk space

• Available USB port

Operating and storage 
temperature range

• 32°F to 104°F (0°C to 40°C)

• 5% to 90% RH 
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Index

SYMBOLS

! on battery icon 10

NUMERICS

112 calls 35, 212
1st day of week option 158
3GP files 142
3GPP files 102, 138
3GPP2 files 102, 138
5-way navigator 5, 17, 19, 

246
911 calls 35, 212

A

AC charger 9
accented characters 26, 27
accessing

ActiveSync 72
alternate characters 26
applications 28, 208
calculator 199
Calendar application 153
Contacts application 151
Dial Pad 38
File Explorer 188
information 29, 219

instant messages 113
Internet Explorer 117
menu items 20, 21, 22
Messaging app 101
Notes application 162
on-device documentation 

249
online address books 95
online forums 249
options in lists 22
Outlook folders 238
Palm online support 249
PDF Viewer 167
Phone Settings screen 13
Pictures & Videos 

application 138
Quick Tour 249
remote files 223
speed-dial buttons 35
spreadsheet templates 

176
Streaming Media 

application 144
Tasks application 159
Tasks entry bar 161
the Internet 222, 233
Today screen 12, 29
web pages 117, 119, 121, 

243

Wireless Manager 33
accessories 6
accounts

conference calls and 45
customer service support 

for 249
missing phone numbers 

and 14
preventing unauthorized 

use of 212, 219
removing email 89
setting up email 89
setting up instant 

messaging 113
troubleshooting 240, 241

Accounts tab 89, 94, 96
action keys 5, 20
actions 20, 205
activating items on screen 20
active call info 41
active calls. See phone calls
ActiveSync

defined 251
installing 68
opening 72
receiving email and 92
synchronizing with 67, 68, 

72, 226, 235
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troubleshooting 226, 
235–240

ActiveSync icon 72, 75, 251
ActiveSync Plug-in for 

Bluetooth 80
Add a new VPN server 

connection option 223
Add Contact prompt 43
Add Favorite dialog box 120
Add Media command 104
Add Picture command 103
Add Recipient command 101
Add Server Source command 

76
Add Sound command 103
Add to Contacts command 

107
Add to Favorites command 

120
Add to Personal Address 

Book command 238
adding

a second call 44
applications 208
appointments 154, 156
attachments to email 91, 

98, 188
bookmarks 119

bulleted or numbered lists 
171

caller ID pictures 151
connections 223
contacts 43, 56, 151
document templates 169
expansion cards 195
files to playlists 146
folders 172
notes 152, 162, 163
online address book 

94–95
passkeys 125, 126
signatures 96, 110
speed-dial buttons 47
spreadsheets 174
tasks 159
untimed events 155, 156

address book 94, 95, 97, 
153, 237

Address List Lookup 187
address messaging options 

97
Address tab 95, 97
addresses

adding 151
checking for 97
copying 238
entering email 91, 97

entering web 30, 118
looking up corporate 187
multiple recipients and 

102
selecting 20, 244
synchronizing 237

adjusting screen brightness 
206

Advanced tab (Power 
Settings) 221

advancing slides 173, 174
After calls from numbers… 

option 57
Agenda View (calendar) 154
alarm clock 217
alarm sounds 218
alarms

adding 155, 160
setting 206, 217
turning on and off 205

Alarms tab 218
albums 138
alert tones. See alarms; 

ringtones
aligning the screen 207
alignment settings

documents 171
spreadsheets 174

Allow cookies check box 122
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Allow USB connections 
check box 236

Alt key 24, 251
alternate characters 26, 27
alternate characters list 26, 

27
AMR files 102
animation 141, 173, 174
anniversaries 156
Answer button 39
answering the phone 39, 44
antenna 258
Appearance tab 203, 207
application icons 28, 208
applications

See also third-party 
applications

associating with buttons 
208

battery life and 11
caution for hard resets and 

227
choosing menu items in 

21, 22
closing 28, 220
copying 198
customizing 208–212
deleting 192, 247
displaying 28, 220

downloading 189, 190
error reporting for 219
included with device 265
installing 189–190, 245, 

246
losing information in 228
moving through 18, 19
moving to expansion cards 

198
opening 28, 197, 208
phone calls and 42, 43
reinstalling 226, 228
running from expansion 

cards 197, 247
running multiple 28
selecting 28
storing 247
synchronizing information 

in 69, 82
troubleshooting 228, 230
turning sounds on or off 

for 205
viewing memory usage for 

220
Appointment tab 154
appointments

adding 154
appearing in wrong time 

slots 239

deleting 158
hiding 157
marking as private 157
reminders for 155
scheduling repeating 156
viewing 154

Appointments tab 159
Area code option 153
arrow icons 17
ascending sort order 181
ASF files 138
Assign a program list 209
attachments

adding 91, 98, 188
downloading 93, 94
embedded objects in 94
internal memory and 247
opening 93
storing 93, 98
troubleshooting 242

Attendees option 156
audio 39, 137, 142, 259
auto-completion options 211
AutoCorrect command 141
Autofill option 179
AutoFilter command 181
AutoFilter settings 

(spreadsheets) 175



I N D E X270

auto-keyguard feature 212, 
213

Auto-Keyguard list 213
Automatically download 

MMS messages check 
box 110

auto-off interval 251
available memory 220
available storage space 220

B

back view (device) 6
backgrounds 133, 140, 147, 

203
backing up information 65, 

225, 228
backlight (keyboard) 24, 221
backlight shut-off interval 25
Backspace key 20, 24, 26
backup and restore 

application 75
backup utilities 225, 228, 

240
backups, restoring 228, 240
battery

Bluetooth connections 
and 124

charging 9–10
conserving power for 221

disposing of 229, 259
inserting 8
maximizing life of 11–12
purchasing 9
removing 227, 229
replacing 228–229
specifications for 263
viewing remaining power 

for 221
viewing status of 62

battery door 7
battery door release 6
battery icon 10
Battery Power tab 25
battery status icons 62
Battery tab 221
Beam File command 193
Beam tab 195
Beam… command 194
beaming 12, 188, 193–195, 

251
birthdays 156
blank screens 231
Block incoming calls list 57
Block outgoing calls list 57
blocking phone calls 57
Bluetooth connections

battery level and 124
battery life and 11

checking status of 53
communicating over 51
hands-free devices and 

51, 52, 53
overview 123
synchronizing over 80

Bluetooth devices
beaming to 194
connecting to 51–53, 

123–126
creating partnerships for 

125
discovery setting for 126
phone calls and 53
receiving information over 

124, 126
sending information over 

124, 126
troubleshooting 234

Bluetooth icon 53, 63, 124
Bluetooth Plug-in 124, 128
Bluetooth Settings screen 

124–127
Bluetooth wireless 

technology 115, 193, 251
BMP files 138
Bold option 170
bookmarks 119

See also favorites
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border highlight 19
borders 174
brightness, adjusting 134, 

135, 206
browsing files and folders 

188, 198
browsing the web. See web 

browsing
built-in applications 192, 265
built-in camera. See camera
bulleted lists 171
bullets 168
Burst mode 134
button settings 147
buttons

assigning to media files 
147

assigning voice 
commands to 209

associating with 
applications 208

creating speed-dial 47
disabling 213
editing speed-dial 49
opening menus and 20
reassigning 208–209
selecting or activating 19
showing voicemail 48

turning sounds on or off 
for 205

Buttons icon 209
Buttons list 209
Buttons screen 208
Buttons tab (Options) 147

C

CAB files 190
calculations 177, 178, 199
Calculator application 199
calculator buttons 200
Calculator icon 199
calendar

adding items to 155, 156
displaying 153
removing events 158
setting alarms for 155
setting options for 158
unavailable slots on 157

Calendar application
adding contacts and 151
customizing 158–159
managing schedules with 

154–158
selecting views 154
starting 153
untimed events in 155

calendar options 158–159

Calendar views 154, 158, 
159

call forwarding 46
call forwarding icon 46
Call Log 38
Call Sender command 107
call waiting 44
call-barring password 57
caller ID applications 245
caller ID blocking 43
caller ID pictures 133, 151
caller IDs 58
call-waiting notifications 58
camcorder icon 135
camera

battery life and 11
capturing videos with 

135–136
specifications for 263
taking pictures 133–134
troubleshooting 244

Camera icon 133
camera lens 6
Camera Preview Mode 245
camera settings 136–137
Camera tab 137
Cancel Bluetooth command 

53
Cancel Mute command 42
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capitalization 25, 212
Capitalize first letter of 

sentence check box 212
Caps Lock icon 25
Caps Lock mode 25
captions 103, 104
carrying cases 6
cascading menus 22
case-sensitive searching 

169, 183
categories

contacts 152
events 157
playlists 145
tasks 160, 161

cell patterns (spreadsheets) 
175

cell phones. See wireless 
phones

certificates 117, 218
Certificates icon 218
Certificates screen 218
changes, undoing 141
changing

alarm sounds 218
color themes 203, 207
connections 223
contacts 152
date and time settings 216

email accounts 89
information 70, 182
picture or video resolution 

134, 135, 244
PIN numbers 215
speed-dial buttons 49
text 169
text size 206

character entry 27
character sets 122
characters

capitalizing 25, 212
entering 24, 25, 178, 211
phone calls and 48
scrolling 18
text messages and 101, 

102
typing alternate 26

charge indicator 5, 10
charger cable 9
charging

device 9, 11
device battery 9–10

charging status 10
Chart command 182
chart options 182
charts 175, 181, 182
Chat icon 107
chat sessions 107, 110

Chat tab 111
check boxes 19
chronological list of calls 38
Cingular

call forwarding and 46
conference calls and 45
customer support services 

for 249
TTY devices and 258

Clear Cookies button 123
Clear History button 122
Clear Now Playing command 

146
Clear Type tab 206
clearing web links 122
Clock & Alarms icon 217
Clock & Alarms Settings 

screen 216, 218
closing

applications 28, 220
menus 22
notification messages 105
screens 19

color settings 245
color themes 203, 207
command button 210, 211
commands 20, 210

See also menus; voice 
commands
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company lists 33
company names 38, 152
comparisons 181
completed tasks 160
compliancy statement 258
components (Treo device) 1
compressed files 189
computers

connecting to 70, 73
enabling dial-up 

networking for 128
installing from 191
reinstalling desktop 

software on 226
synchronizing with 70, 81, 

82
system requirements 71
viewing videos and 

pictures on 141
Conference button 45
conference calls 45
confidential events 157
Confidential option 157
configurations

restoring 227
troubleshooting 233

Configure Server command 
243

configuring

data services 233
mail servers 243
TTY devices 56

Confirm message deletions 
check box 110

confirmation messages 111, 
112

Connect command 223
Connect via Bluetooth 

command 80
Connect via IR command 81
connecting

charger cable 9
device to PCs 73
headsets 50
to a headset 126
to Bluetooth devices 

51–53, 123–126
to hands-free car kits 51, 

126
to mobile networks 232
to service providers 222
to the Internet 128, 222, 

233
to TTY devices 56
to VPNs 223
to web sites 117, 127

connection icons 224

Connection Settings 
command 236

connections
adding 223
changing 223
displaying 223
ending 224
losing 234
manually starting 223
precautions for 262
removing Bluetooth 126
setting up 222–224
setting up wireless 

127–129
timing out 240
troubleshooting 231–235, 

243
trusted devices and 126

Connections icon 222
Connections screen 222, 

223, 233, 234
Connections tab 195, 222
connectivity specs 264
conserving battery power 

221
contact categories 152
contacts

adding 43, 56, 151
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addressing messages to 
91, 97, 101, 103

assigning ringtones to 48, 
55, 139, 152

changing 152
displaying 152
linking speed-dial buttons 

to 47
looking up 30, 36, 153
making calls to 36
personalizing 55
removing 152
saving information for 43
selecting communication 

method for 37
sending messages to 102, 

156
viewing details list for 37

Contacts application 
151–153

Contacts list 37, 44, 101, 
107, 153

context-sensitive menus 22
continuous playback (slides) 

174
cookies 117
Copy command 121, 140, 

170, 198
copying

addresses 238
applications 198
items in folders 189
phone numbers 37, 39, 

121
pictures and videos 139
text 121, 169

copyrighted items 139
corporate mail systems 223, 

243
corporate networks 218
corporate servers 223, 243
coupling 247
coverage area 12, 33, 232
Create chat from messages 

option 111
creating

appointments 154, 156
bookmarks 119
bulleted or numbered lists 

171
caller ID pictures 151
connections 223
contacts 43, 56, 151
documents 167, 168, 169
email messages 91
folders 172
multimedia messages 102
notes 162, 163

online address book 
94–95

partnerships 125
passkeys 125, 126
playlists 145
signatures 96, 110
speed-dial buttons 47
spreadsheets 174
tasks 159
templates 107, 169, 176
text messages 101
untimed events 155, 156
video ringtones 139
workbooks 176

credentials 224, 241
cropping pictures 140
currency symbols 207
Currency tab 207
customer assistance 249
Customize the playlists… 

check box 142
customizing

applications 208–212
Calendar 158–159
camera 136–137
chat settings 110
Contacts application 153
dates and time 216
email settings 96
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Excel Mobile 184
format settings 207
Internet Explorer Mobile 

122–123
Media Player Mobile 146
Messaging application 

109–112
network settings 112
Notes application 164
phone 54–61
system settings 216–222
system sounds 204
tasks 161
Today screen 203
voicemail system 48, 54
Word Mobile 172

Cut command 139, 170
cutting. See deleting

D

daily schedules 154
data 227

See also information
data connection icons 224
data filters 158, 181
data formats 206
data service icons 232
data service providers 222, 

233, 242

data services 1, 232, 233
data transmission speeds 1
date format settings 207
Date tab 207
dates 179, 207, 216

See also calendar
Day View 154, 158
day-planner formats 154
decimal places 207
decimal symbols 207
decompression utility 189
default document template 

172
default format settings 207
Default mode option 164
Default option 118
default PINs 214
Default template option 164
Default zoom level options 

212
defined names 

(spreadsheets) 180
delays 34, 234
Delete Appointment 

command 158
Delete Cells command 184
Delete command 109, 172, 

184

Delete Contact command 
152

Delete Files button 122
Delete Task command 161
Deleted folder 98, 247
deleting

applications 192, 247
Bluetooth connections 

126
certificates 219
contacts 152
directory services 95
documents 172
email accounts 89
events 158
favorites 120
files 189, 247
items from libraries 145
items from playlists 146
items in folders 188
messages 97, 109, 110
notes 164
partnerships 126, 235
pictures 141
speed-dial buttons 49
tasks 161
text 20
web files 122
workbooks 184
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worksheets 184
descending sort order 181
Desktop option 118
desktop software 226, 251

See also applications; 
software

device
additional information for 

249
caution for electrostatic 

discharge and 262
caution for resetting 227
caution for storing 6
charging 9, 11
compatibility with 

third-party vendors 71
compatible hands-free 

devices for 51
compliancy statement for 

258
components of 1, 5–7
connecting to PCs 73
disabling touch-sensitivity 

for 213
disposing of 259
features described 1
freeing space on 192, 246
getting help with 225, 249

getting phone number for 
13

locking 215
losing 75, 216
low lighting conditions and 

24
management tools for 185
moving around on 15
not responding 226, 232, 

246
personalizing 201
required items for 2
resetting 215, 226–228, 

232
setting up 7–14
specifications for 263
system requirements for 

265
third-party applications and 

245
troubleshooting 249
turning on and off 33, 258
unlocking 215
updating information on 

65, 70
usage guidelines for 257, 

260
device names. See 

usernames

Device Setup Wizard 142
devices

See also Bluetooth 
devices; device

battery life and 11
beaming to 193
compliancy for 258
configuring TTY/TTD 56
discovering trusted 123, 

124, 126
physically-impaired 

disabilities and 56
radio frequency emissions 

and 257, 259
transferring information 

from 225
troubleshooting 234

Devices tab 125, 234
diagnostic information 219
Dial Lookup list 13
Dial Pad 37, 38, 39
dialing 12, 34–37, 38, 48
dialog boxes 252
dial-up networking 127, 128
digit grouping 207
digital cameras 138

See also camera
digital certificates 117, 218
dimmed images 231
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Direct Push Technology 76
directory service 94, 95, 97
Disable touchscreen check 

box 213
Disconnect Bluetooth 

command 81
Disconnect command 224
discoverable setting 126
discovering trusted devices 

123, 124, 126
discussion groups 249
disk space 265

See also memory
Dismiss button 41
display formats 206
Display message on screen 

check box 206
display options (web) 118
display settings 206–208

See also screen
displaying

alternate characters 26
animated images 141
applications on device 28
appointments 154
calendar 153
contacts 37, 152
current connection 223
daily schedules 154

events 155, 157
folder contents 188
items in folders 172, 183
memory usage 220
multimedia messages 107
notifications 55, 206
on-device documentation 

249
PDF files 167
pictures 133, 138, 141
power settings 220
Quick Tour documentation 

249
running applications 220
space on expansion cards 

198, 220
tasks 161
videos 133, 138, 141
web pages 117, 118
wireless settings 221

DOC files 167
document file types 167, 173
documentation 2, 249
documents

See also Word Mobile 
application

creating 167, 168, 169
deleting 172

finding and replacing text 
in 169

moving or copying text in 
169

opening 168
organizing 172
saving 167, 168, 170, 172
sending 83
setting margins for 171
spell-checking 171
supported features for 168
unsupported features for 

167
documents list 173
DOT files 167
downloading

applications 189, 190
attachments 93, 94
email 78, 92, 93
files 120
images 121, 141
multimedia messages 

105, 110
Palm-specific information 

and updates 249
pictures 138
ringtones 54
videos 141, 142

Downloads favorite 120



I N D E X278

downward-pointing arrows 
22

drained battery 11
drawing 162
drivers 226
driving safety tips 260
Drop and Answer command 

45
drop-down lists

accessing 22
exiting 23
highlighting in 18, 23
scrolling through 18
selecting items in 20, 23

drop-down menus 22
DUN connections 127–129

See also dial-up 
networking

E

earpiece 5, 247
eBooks 11
echoes 247
EDGE connections 252
Edit command 140, 152
Edit Server Settings screen 

77
Edit Speed Dial command 49
editing. See changing

electrostatic discharge 261
email

adding address book for 
94–95

adding attachments to 91, 
98, 188

addressing 91, 97
creating 91
deleting 97, 98
dialing from 39
downloading 78, 92, 93
entering contacts and 151, 

156
forwarding 96
getting from corporate 

servers 223, 243
getting from Exchange 

Servers 92
internal memory and 247
priority settings for 92
receiving attachments 

with 93
reply options for 97
requirements for 1
selecting addresses 20
sending 92, 93, 98, 119, 

241
synchronizing 11, 92, 235, 

242, 243

troubleshooting 241–243
email accounts

changing 89
deleting 89
setting up 89
troubleshooting 241
Xpress Mail servers and 

87
email applications 244
E-mail button 93
email client software 242
email message icons 108
embedded images 94
emergency calls 35, 212
emoticons 102
Enable Clear Type check box 

206
Enable fixed dialing check 

box 60
Enable local network time 

check box 217
encoding options 122
encryption 117
End Show command 174
End User License 

Agreement 2
ending

active calls 42
data connections 224
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playback 143
wireless connections 129

endnotes 168
entering

alternate characters 26, 27
data in spreadsheets 176, 

178
information 24, 25–26
numbers 24, 25
owner information 216
passkeys 52, 125, 126
passwords 77, 90, 215
phone numbers 12, 34, 

37, 38
PINs 214
text 211, 212
web addresses 30, 118

Entire column option 184
Entire row option 184
entry fields

deleting text in 20
highlighting in 18, 20
moving to 18
opening drop-down lists in 

23
scrolling through 18

Erase all data? prompt 228
erasing. See deleting
error messages 205, 240

error reporting 219
Error Reporting icon 219
Error Reporting screen 219
errors 219, 232, 240
ESD (electrostatic discharge) 

261
ESMTP option 242
Even when roaming check 

box 110
event categories 157
event icons 159
Event list 205
events

creating 155, 156
deleting 158
filtering 158
hiding 157
marking as sensitive 157
reminders for 155
selecting sounds for 206
setting notification 

preferences for 205
Events check box 205
Excel files 165

See also Excel Mobile; 
spreadsheets

Excel Mobile application
customizing 184
display settings for 177

overview 174
searching in 182
starting 176
supported features 174
unsupported features 176

Excel Mobile icon 176
Exchange ActiveSync 243, 

252, 254
Exchange Address Book 237
Exchange Server credentials 

screen 241
Exchange Server sync 

options 78, 240
Exchange Servers

accessing 153
getting email from 92
setting up accounts for 

76–78
synchronizing with 11, 68, 

81, 240
troubleshooting 240, 243

exiting applications 28, 220
expanding lists in fields 23
expansion card slot 6, 195, 

263
expansion cards

as storage medium 247
browsing on 198
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displaying available space 
on 198, 220

inserting 195–196
installing apps on 191
moving apps to 198
moving information to 

172, 183, 198
opening items on 197
removing 196
renaming 199
searching on 187, 188
storing attachments on 

93, 98
transferring files to 142, 

146, 197, 198
types supported 195

extensions (phone) 48
external power sources 221
External Power tab 25
Extra Digits button 41, 48
Extra Digits text box 48
Extract command 46

F

factory settings 147
factory-installed applications 

192, 265
favorites 119–120

See also web pages

Favorites button 120
Favorites command 120
FCC Statement 257
features 1
Federal Trade Commission 

website 219
feedback 247
fields. See entry fields
File Explorer 187, 188–189, 

199
File Explorer icon 188
file names 170, 172, 187
file types

displaying 173
documents 167
Media Player 142
multimedia 102
pictures 138
videos 138

files
accessing from corporate 

accounts 223
browsing 188
decompressing 189
deleting 189, 247
downloading 120
moving 172, 189
saving 197
searching for 187, 188

selecting multiple 189
transferring to expansion 

cards 142, 146, 197, 
198

Files folder 167
Files sync option 167
fill series (spreadsheets) 178
Filter command 152, 158
Filter option 161
filtering

events 158
information 152, 181
tasks 161

filters 158, 181
Find Online command 95, 

153
Find/Replace command 169, 

182
finding

contacts 30, 36, 153
information 182
text 169

firewalls 235
5-way navigator 5, 17, 19, 

246
fixed dialing 60
folder names 172
folders

accessing Outlook 238
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adding documents to 170
arranging pictures and 

videos in 140
browsing 188, 198
creating 120, 172
displaying contents 172, 

183
moving items to 172, 183, 

189
opening items in 188
organizing web favorites in 

119, 120
sorting contents 172, 183, 

188
synchronizing messages 

in 92
Font color option 170
Font command 170
Font option 170
fonts 168, 170, 175, 206
footers 168
footnotes 168
forgetting passwords 215
format settings 207
formats, losing 167
formatting

charts 182
paragraphs and lists 171
spreadsheets 174, 180

system data 206
text 170

Formatting toolbar 171
forms (web) 119
formulas 175, 178, 183
forums 249
Forward command 96
forwarding

messages 96, 107
phone calls 46

freeing memory 192, 239, 
246

Freeze Panes option 177
front view (device) 5
full charge (battery) 9
Full Screen option 118
functions (spreadsheets) 

175, 178

G

games 11
Get Good program 88
getting started 2, 3, 12, 249
GIF files 102, 138, 141
Global Address List 94, 95, 

153
Global Address List Lookup 

187
Glossary 251

Go to Slide command 173
GPRS connections 252
graphics programs 140

H

Hands Free check box 53, 
126, 234

hands-free car kit 50, 53, 126
hands-free devices

connecting to 51
purchasing 261
setting up 50
tips for 54, 260
troubleshooting 234
turning Keyguard on or off 

for 213
hanging indents 171
hanging up phone 13, 42
hard resets 215, 227
hardware 1
Hardware buttons check box 

205
headers 168
headset button 51
headset jack 5
headsets

configuring as trusted 
devices 124

connecting 50–51, 126
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disabling Keyguard and 
213

hearing-impaired 56, 258, 
259, 261

heat sources 12
help 225, 249
Help topics 28
hiding

appointments 157
events 157
images 118
speed-dial buttons 36
Tasks entry bar 161

highlight 19
Highlight option 170
highlighting

applications 28
items in folders 189
items on screen 18, 

19–20
menu items 21, 22
options in lists 18, 23
text 20, 170

Hint tab 216
hints (passwords) 216
History command 121, 144
History list 121, 122
Hold button 42
home locations 216

Home page option 122
Hotmail accounts 86, 113
hypertext links. See links

I

icons
application 28, 208
battery status 10
data connections 224
data services 232
email 108
events 159
message status 108
navigator 17
phone status 61
signal-strength 33, 222

Identification tab 216
Ignore with text message 

command 40
IM messaging 113
image file types 138
image files 102, 141, 246
images

See also pictures
dimmed 231
downloading 121
hiding web page 118
incorrect color settings 

and 245

receiving 94
setting background 140, 

203
troubleshooting web page 

244
IMAP accounts 86, 89, 94
inactivity 134, 221
Inbox 18, 91, 92, 108
Inbox application 85, 86, 91, 

94
Include file attachments 

check box 93
incorrect passwords 215
Indentation setting 171
indented lists 168
indenting text 171
indicator light 5, 10, 33
information

accessing 29, 219
backing up 65, 225, 228
changing 70, 182
entering 24, 25–26
erasing all 235
filtering 152, 181
losing 167, 227
moving 172, 183, 198
protecting 212–216
removing battery and 229
restoring 227, 228
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searching for 169, 182, 
187–188

sharing 192
sorting 181
storing 195, 246, 247
synchronizing 68, 69, 70, 

235
transferring 65, 225
updating 65, 70

infrared port. See IR port
infrared transmissions 81, 

252
Input icon 211
input options 24, 211
Input screen 211
inserting expansion cards 

195–196
installation, troubleshooting 

228, 230, 246
installing

ActiveSync 68
applications 189–190, 

245, 246
bonus software 189
SIM smartcards 7–14
synchronization software 

71
VPN clients 223
Windows drivers 226

instant messages 113
instant messaging 

applications 245
internal memory. See 

memory
Internet 128, 222, 233

See also web browsing; 
websites

Internet Connection Speed 
option 147

Internet Explorer Mobile
browsing with 117–121
closing 119
customizing 122–123
installing from 190
scrolling in 18
starting 117
unsupported elements for 

117, 243
IR connections 194
IR port 6, 81, 193, 252
ISP mail systems 89
ISP settings 222
ISPs (Internet Service 

Providers) 222, 242
Italics option 170
Items tab 203

J

JavaScript 117
JPEG files 102
JPG files 138

K

keyboard
accessing alternate 

characters on 26
dialing from 34
entering information from 

25–26, 212
locking 213
pressing keys on 24
scrolling with 18
selecting menu items 

from 22
setting key combinations 

for 209
specifications for 264
troubleshooting 246

keyboard backlight 24, 221
keyboard icon 24
Keyguard 213
Keyguard icon 213
Known Caller option 54

L

language-impaired 56
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leading zeros 207
left action key 20, 154
Legacy Pocket Word files 

168
libraries (media) 144
Library command 143
Library list 143
Library screen 143, 147
Library tab 147
lightening bolt 10
Li-Ion battery 252

See also battery
links

clearing web 122
internal memory and 247
media files and 144
messages and 108, 119
selecting 19, 118
troubleshooting 244

list separators 207
List setting 171
Listen button 41
listening to

media files 142
voicemail messages 41

lists
accessing 22
creating 168, 171

displaying alternate 
characters and 26

exiting 23
formatting 171
highlighting in 18, 23
navigating web page 119
scrolling through 18
selecting items in 20, 23

Lithium Ion battery 252
See also battery

locating
contacts 30, 36, 153
information 182

location-specific information 
206, 216

Lock icon 118, 139, 215
Lock screen 215
locking

SIM smartcards 214
spreadsheet rows and 

columns 177
the keyboard 213
the screen 213
Treo device 215

logging in to
corporate servers 223
networks 218

looking up contacts 30, 36, 
153

lookup feature 187
losing

connections 234
information 167, 227
passwords 215
Treo device 75, 216

low coverage areas 232
low lighting conditions 24
lowercase letters 25

M

magnet 6
magnification. See zoom 

settings
mail servers 223, 243
Main tab 220
Make the device 

discoverable check box 
124

Make this device 
discoverable setting 126

Manage existing connections 
option 222, 223

Manage Folders command 
92

Manage tab 205
management tools 185
manually closing applications 

29
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MAPI clients 243
maps 244
margins 171
Match case box 169, 183
Match whole words only 

check box 169, 183
measurement units 207
media files

creating playlists for 145
formats for 142
linking to 144
playing 143
synchronizing 142
transferring 142, 146
troubleshooting 238

media libraries 144
Media Player 238
Media Player Mobile 

142–147
media players 11
Media sync option 142
meeting requests 94, 95, 

156, 159
memory

available 265
freeing 192, 239, 246
low conditions for 28, 220
running apps and 28, 197
storing numbers in 200

viewing expansion card 
198

memory buttons 200
memory dial 260
Memory icon 198
memory options (web) 122
Memory screen 220
Memory Settings screen 29
Memory tab 122
memory usage 220
memos. See messages; 

notes
menu items 21
Menu key 21, 22
menus 20–22
Menus icon 208
Menus screen 208
Message Details command 

106
message list 107, 108
Message Options command 

104
Message Options screen 

104
Message Priority list 105
message status icons 108
Message tab 97
Message validity period 

option 110

messages
See also multimedia 

messages; text 
messages; voice notes

adding signatures to 96, 
110

addressing 102, 103
automatically resending 

110
creating email 91
deleting 97, 109, 110
dialing from 39
displaying notification 206
displaying status of 108
forwarding 96, 107
invalid characters and 102
listening to 41
receiving notifications for 

105, 111, 234
saving 92
sorting 109
storing 247

Messages tab 110
Messaging application

See also text messages; 
multimedia messages

adding contacts and 151
chat sessions and 107
customizing 109–112
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email settings in 96
messaging options in 104
notification options in 105
overview 101
play options in 106
starting 101
status icons in 108

messaging applications 245
messaging services 233, 

252
microphone 5, 42, 137, 247
microphone icon 210
Microsoft ActiveSync. See 

ActiveSync
Microsoft Exchange 

ActiveSync.See Exchange 
ActiveSync

Microsoft Office 165, 167
Microsoft Office Excel 175

See also spreadsheets
Microsoft Office Outlook. 

See Outlook
Microsoft Windows Mobile 

software 190
Microsoft Windows Mobile 

website 225
Microsoft Word documents. 

See documents
MIDI files 102

miniSD cards 195
mirror 6, 134
Missed call option 54
MMS files 144
MMS messaging 101, 252
mobile accounts. See 

accounts
Mobile Device component 

(Windows) 252
Mobile Device folder 72, 191
Mobile Device icon 252
mobile devices 194, 225
mobile networks 231, 232
mobile phone numbers 151
mobile phones. See wireless 

phones
Mobile to Market certificates 

189
Mobile-Based Device icon 

191
Mode tab 124
Modem tab 223
ModemLink application 127
modems 127
Modify Sheets command 

181, 184
Month View 154
most recently dialed 

numbers list 38

moving
documents to folders 172, 

189
files to expansion cards 

142, 146, 197, 198
information 172, 183, 198
pictures and videos 139
speed-dial buttons 49
text 169
workbooks 183

moving around the screen 
17–19

moving through web pages 
118

MP3 files 142
MP4 files 142
MPEG files 138
MPEG4 files 102
MSN Hotmail 86, 113
MSN Messenger 113
multi-connector 5
multi-line fields 18
multimedia features 99, 131
multimedia file types 138
multimedia files 138, 247
multimedia messages

creating 102
deleting 109, 110
displaying 107
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downloading 105, 110
forwarding 107
internal memory and 247
opening 106
overview 99
phone numbers in 39
playing 106–107
previewing 104
receiving 105
replying to 106
requirements for 1
saving 107
sending 102, 104, 107
setting options for 104
sorting 109
troubleshooting 233

Multimedia Messaging 
System. See MMS 
messaging

multiple recipients 102
music 39, 142, 143, 204

See also media files
music files 238
Mute command 42
My Device folder 188
My Device library 144
My Documents folder 187, 

188, 228
My Pictures folder 133, 135

My Playlists category 145
My Storage Card library 144
My Text command 91
My Text phrases 91
My Windows Mobile-Based 

Device icon 192

N

names 30, 254
naming

document files 170, 172
expansion cards 199
folders 172
groups of pictures 137
speed-dial buttons 47
templates 169, 176
workbooks 183
worksheets 179, 180

navigating the screen 17–19
navigating web pages 118
navigator. See 5-way 

navigator
navigator buttons 17, 19
negative numbers 207
network protocols 147
network settings 60, 112
Network tab 61, 147
networks

changing 61

connecting to 61
logging in to 218
troubleshooting 231–235

New Account command 89
New Appointment command 

154, 155
New MMS command 103
New Partnership option 125
New Sound command 205
New Speed Dial command 

47
notes

adding 152, 160
creating 162, 163
removing 164
saving 163, 164

Notes application 161–164
Notes icon 162
Notes list 163, 164
Notes tab 152, 216
notification options 105, 111, 

205
notification screens. See 

notifications
Notification tab 111
notifications

changing event 205
closing 105
displaying 55
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downloading sounds for 
54

enabling or disabling 206
phone calls and 58
previewing sounds for 55
receiving messages and 

105, 111
receiving phone calls and 

44
receiving transmissions 

and 127
receiving voicemail 41
setting ringtones for 54
setting system sounds for 

204
silencing sounds for 204
troubleshooting 234

Notifications check box 205
Notifications tab 54, 205
Now Playing playlist 145, 

146
Now Playing screen 145
number format settings 207
number pad 12
number sign symbol 207
Number tab 207
numbered lists 171
numbers

See also phone numbers

entering 24, 25
formatting 175, 179
pasting into Calculator 200

O

Off Hold button 42
Office files 167
Office Outlook. See Outlook
Office Word documents. See 

documents
offline synchronization 238
Off-peak times options 79
OK button 5, 29
One Column option 118
online address book 94, 95, 

97, 153
online forums 249
online support (Palm) 249
Open URL command 144
opening

ActiveSync 72
alternate characters list 26
applications 28, 197, 208
attachments 93
calculator 199
Dial Pad 38
documents 168
email applications 244
File Explorer 188

items in folders 188
menus 20, 22
multimedia messages 106
on-device documentation 

249
Outlook folders 238
Phone Settings screen 13
Picsel PDF Viewer 167
Quick Tour 249
templates 176
text messages 106
Today screen 12, 29
web pages 117, 119, 121
Wireless Manager 33

operating system (device) 
230, 254, 263

operating systems (PCs) 71
operational warnings 258
Option key 18, 24, 25, 252
Option Lock icon 25
Option Lock mode 25
options

displaying 157
highlighting 18, 19, 23
selecting 22, 23

Options screen (ActiveSync) 
82

Options screen (Internet 
Explorer) 122
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Options screen (messaging) 
97, 109

Options tab 203, 211, 216
organizer features 34, 149
orientation (screen) 208
orientation (slides) 174
orientation options 208
Orientation tab 174
outages 233
Outbox 108
Outlook

accessing folders for 238
copying addresses to 238
downloading messages 

from 92, 93
email client software and 

242
entering information with 

70
installing drivers for 226
synchronizing with 76, 96

Outlook E-mail screen 89, 91
overdue tasks 161
Override playback options 

174
owner information 216
Owner Information icon 216
Owner Information screen 

216

P

page breaks 168
paired devices 128
paired relationships. See 

partnerships
pairing. See partnerships
Palm (online support) 249
Palm applications 190
Palm devices 73, 225
Paragraph command 171
paragraph formatting 171
partial battery icon 10
partnerships 125, 235, 253
passkeys 52, 125, 126
Password tab 215
Password type list 215
passwords

call-blocking and 57
corporate email accounts 

and 77
entering 77, 90, 215
forgetting or losing 215
locking device and 212, 

215
saving 90
spreadsheets and 175

Paste command 140, 170
patches 192
patterns in workbooks 175

Pause playback option 106, 
147

PCS phones. See wireless 
phones

PCs. See personal 
computers

PDF files 167, 176
PDF Viewer 167
Peak times options 79
performance 230, 245
Personal Address Book 238
personal computers

connecting to 70, 73
enabling dial-up 

networking for 128
installing from 191
reinstalling desktop 

software on 226
synchronizing with 70, 81, 

82
system requirements 71
viewing videos and 

pictures on 141
personal events 157
personal identification 

numbers (PINs) 60, 214, 
253

personal information 215, 
216, 251
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personal information 
managers 238, 253
See also PIM applications

Personal option 157
Personal tab 54
personalizing your device 

201
phone

See also phone calls; 
phone numbers; device

adjusting volume 13, 55
advanced features 41–47
answering 39, 44
customizing 54–61
dialing 12, 34–37, 38, 48
disabling touch-sensitive 

feature for 213
hanging up 13, 42
network settings for 60
ringtones for 54, 55
running applications and 

42, 43
selecting wireless band for 

59
silencing ringer 40
specifications for 263
waking up screen for 42

phone calls

See also phone; phone 
numbers

adding a second 44
blocking 57
ending 13, 42
forwarding 46
hands-free devices and 

50, 53, 54
making 12, 34, 38, 41, 

107
placing on hold 42
receiving 39, 41
receiving notifications for 

58
restricting 60
sending to voicemail 39
setting up conference 45
troubleshooting 234, 247

Phone dialog box 39
phone headset 50–51

See also headsets
Phone icon 214
phone lock feature 212
phone numbers

See also phone; phone 
calls

assigning to speed-dial 
buttons 47

copying 37, 39, 121

entering 12, 34, 37, 38
entering extra digits with 

48
locating device 13
missing from Phone 

Settings screen 14
redialing most recent 38
saving 43
selecting 20

Phone Off message 33, 253
Phone Settings screen 13, 

14, 56, 57, 214
phone status icons 61
Phone tab 56, 57
Phone/Send button 5, 13, 

35, 253
Phone/Send icon 34
phone-off icon 11, 33
photo albums 138
photos. See pictures
pick lists

accessing 22
exiting 23
highlighting in 18, 23
scrolling through 18
selecting items in 20, 23

Picsel PDF Viewer 167
picture files 102, 141
picture formats 138
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Picture Speed Dial button 48
picture speed-dial buttons 

35, 47
pictures

adding as backgrounds 
140, 203

adding as screensaver 136
adding sounds to 103
adding to messages 103
adjusting resolution of 

134, 141
creating caller ID 151
default resolution settings 

for 244
deleting 141
downloading 138
editing 140
hiding on web pages 118
naming groups of 137
previewing 134, 245
receiving 133
saving 137
sending 139
setting default size 137
storing 246
synchronizing 141
taking 133–134, 244
viewing 133, 138, 141

Pictures & Videos application 
136, 138–141

PIM applications 251, 253
PIMs 226, 238, 253
PIN unlock key 253
PINs 60, 214, 253
Play button 143
Play Slide Show command 

138
Play Sound box 55
Play sound check box 206
Play Sound list 218
playback icons 48
playback options 146, 174
Playback screen 146, 147
Playback tab 146, 174
playing

media files 143
multimedia messages 

106–107
presentations 173, 174
sounds 137
voice notes 163
voicemail messages 41

playlists 142, 145
plug-ins 117, 204
Pocket MSN 86, 113
POP accounts 86, 89
pop-up menus 22

port numbers 224
portable radio. See radio
ports. See IR port; USB ports
Power icon 220
Power screen 220
Power/End button 5, 33
PowerPoint files 165
PowerPoint Mobile 

application 173–174
PowerPoint Mobile icon 173
precautions 262
preferences 110, 201, 227

See also customizing
preinstalled applications 192, 

265
presentations 173, 174

See also PowerPoint 
Mobile

Preview Message command 
104

Preview Mode (camera) 245
previewing

multimedia messages 104
pictures 134, 245
sounds 55, 206
videos 135

priority levels 105, 160
Priority list 92
privacy mode 105, 112
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private events 157
Private option 157
processor 263
Program Buttons tab 209
Program Files folder 198
Programs check box 205
Programs screen 28
programs. See applications; 

software
Prompt if device unused for 

check box 215
Properties command 119
protected spreadsheets 175
protecting

information 212–216
the touchscreen 231
Treo device 212

proxy servers 223
PSW files 168
PUK (PIN unlock key) 253
punctuation marks 25, 27
Purge command 109
Purge screen 109
push technology 76

Q

QCELP files 102
Quality command 135
Quick Keys 36, 48

Quick Tour 249
Quick Tour icon 249
QuickTime Player 141
quitting applications 28, 220

R

radio 258, 263
radio frequency emissions 

257, 259
RAS connections 222
reassigning buttons 208–209
Receive all incoming beams 

check box 195
receiving

attachments 93
beamed information 194
email 92, 93, 241
meeting requests 94
multimedia messages 

102, 105, 110
pictures 133
text messages 101, 105, 

234
videos 133

Receiving Data message 195
recently-viewed web pages 

121
rechargeable battery. See 

battery

recipients, sending to 
multiple 102

Record button action option 
164

recording
sounds 205
videos 135–136
voice notes 211

Recording icon 162
recording toolbar 162
records (data) 194
recurring appointments. See 

repeating appointments
redialing phone numbers 38
redirector (websites) 244
Refresh command 118
refreshing web pages 118, 

243
Region tab 207
regional settings 206, 216
Regional Settings icon 206
Regional Settings screen 206
reinstalling software or 

applications 226, 228
Reminder option 155
reminders

adding 155, 160
events and 159
system alarms and 217
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tasks and 161
turning on and off 205

remote access servers 222
remote files 223
Remove Programs icon 192
Remove Programs list 192
Remove Programs screen 

192
Remove Split command 177
removing

applications 192, 247
battery 227, 229
battery door 7
Bluetooth connections 

126
certificates 219
contacts 152
directory services 95
documents 172
email accounts 89
events 158
expansion cards 196
favorites 120
files 189, 247
items from folders 188
items from libraries 145
items from playlists 146
messages 97, 109, 110
notes 164

partnerships 126, 235
pictures 141
speed-dial buttons 49
tasks 161
text 20
web files 122
workbooks 184
worksheets 184

Rename command 199
Rename/Move command 

169, 172, 183, 198
renaming

documents 172
expansion cards 199
items in folders 188
workbooks 183
worksheets 180

Repeat check box 206
Repeat command 143
repeat patterns 156
repeating appointments 156
repeating current song 143
repeating sounds 206
repeating tasks 160
Replace All button 169, 183
Replace button 169, 183
Replace text as you type 

check box 211
replacing

information 182
text 169
the battery 228–229

Request Delivery/Read 
Receipt check box 104

Require PIN when phone is 
used check box 214

reset button 6, 227
resets 215, 226–228, 232

caution for 227
resizing text 119
resolution (camera) 244
resolution (screen) 231, 264
Resolution command 134, 

244
restarting Treo device. See 

resets
restoring

backups 228, 240
information 227, 228
preferences and system 

settings 227
sound settings 204

Resume playback option 
106, 147

retrieving voicemail 41
Return key 24
reverse type 20
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Revert to Saved command 
141

revision marks 168
RF emissions 257, 259
RF Safety Statement 257
right action key 20
right-click menus. See 

shortcut menus
ringer switch 7, 204
ringer volume 55
ringer, silencing 40
ringtone files 102
ringtone managers 245
ringtones

assigning to contacts 48, 
55, 139, 152

creating video 139
downloading 54
previewing 55
selecting 54

roaming 79, 239
Roaming option 54
rotating pictures 136, 140
RTF files 167
RTSP files 138, 144
running multiple applications 

28
Running Programs tab 29, 

220

S

Safety Statement (FCC) 257
Save As command 120, 170
Save Image command 121
Save links… option 122
Save password check box 

77, 90
Save to Contact Ring Tone 

command 139
Save to Contacts command 

44
Save to list 197
Save to option 164
Save to Template command 

107
Saved folder 92
saving

documents 167, 168, 
170, 172

email messages 92
files 197
multimedia items 106
multimedia messages 107
notes 163, 164, 211
passwords 90
phone numbers 43
pictures and videos 137
text messages 107
workbooks 174, 176, 184

Schedule command 79
Schedule screen 79
scheduled syncs 239, 242
schedules

adding items to 154, 155, 
156, 159

managing 154–158
organizing events for 157
removing events 158
removing tasks 161
sorting tasks on 161
unavailable time on 157
viewing daily 154

scheduling synchronization 
78–79

screen
activating items on 20
activating wrong features 

231
adjusting brightness 206
adjusting display 206–208
aligning 207
arranging web pages on 

118
battery life and 12
caring for 6
changing color themes for 

203, 207
changing orientation 208
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disabling touch-sensitivity 
for 212

locking 213
moving around on 17–19
protecting 231
scrolling in 18–19, 212
selecting items on 20
setting backgrounds for 

140, 203
setting delays for 34
specifications for 264
troubleshooting 207, 231
turning on or off 33, 34, 

221, 251
waking up 34, 42

screen fonts 206
Screen icon 206, 207
screen resolution 231, 264
Screen taps check box 205
Screen view 207
screens, returning to 

previous 19
screensavers 136
scroll arrows 18, 19
scroll bar 19
Scroll upon reaching the last 

line check box 212
scrolling

device screen 18–19, 212

slides 173
spreadsheets 177
web pages 118

SD expansion cards 195
SDP files 144
SDP Streaming files 138
Search button 188
Search dialog box 187
Search for list 187, 188
Search icon 187
search results list 187, 188
searching

contacts list 36
documents 169
spreadsheets 182
web pages 117

searching for files 187, 188
searching for information 

169, 182, 187–188
searching for signal 12
secure websites 244
security 125, 212–216, 219
security certificates 117, 218
security options (web) 123
security software 212
Security tab 122, 214
Select All Text command 121
selecting

applications 28

items in folders 189
items in lists 23
items on screen 19, 20
menu items 21, 22
options in lists 20, 22, 23
speed-dial entries 30
tabs 18
web links 19, 118

self-portrait mirror 6, 134
Send Link via E-mail 

command 119
Send meeting requests via 

option 159
Send outgoing items… 

check box 79
Send Sound command 205
Send via E-Mail command 

193
Send/Receive command 93
sending

copyrighted items 139
email 92, 93, 98, 119, 241
meeting requests 95, 156, 

159
multimedia messages 

102, 104, 107
pictures 139
sounds 205
text messages 40, 101
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videos 139
sensitivity options 157, 160
Sent folder 97, 108
servers, troubleshooting 

239, 240, 243
See also Exchange 

Servers
service contracts 1
service providers 222, 233, 

242
Services tab 46, 57, 58, 59, 

60
Set as Hands-Free command 

234
Set as Today Background 

command 140
Set reminders for new items 

option 159, 161
Set up my proxy server 

option 224
setting alarm clock 218
settings. See options
shaded lightning bolt 10
sharing information 192
sheet list 177
Shift cells options 184
Shift key 24, 25
Short Messaging Service. 

See SMS messaging

shortcut menus 22
shortcuts 20
Show alphabetical index 

option 153
Show contact names only 

option 153
Show half hour slots option 

158
Show icons option 159
Show list 138, 197
Show Options command 

174
Show Pictures option 118
Show start and due dates 

option 161
Show Tasks entry bar option 

161
Show time stamps of each 

message option 111
Show week numbers option 

158
Shuffle command 143
side button 5
signal, searching for 12
signal strength 62, 231, 248
signal-strength icon 33, 222
Signature box 110
signatures 96, 110
Signatures screen 96, 110

silencing system sounds 7, 
204

silencing the ringer 40
silent alarm 204, 206
SIM smartcards 7, 9, 214, 

253
Size option 170
sketching 162
Skins tab 147
Slide Show tab 136
slide show toolbar 139
slide shows 136, 138, 173, 

174
slide timing option 174
slider 19
slides 103, 104, 107
smartcard. See SIM 

smartcards
SMS messaging 101, 254
SMTP servers 242
soft resets 226
software

See also applications
caution for hard resets and 

227
compatibility with 

Windows Mobile 230
included with device 2, 

265
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installing 71, 189
purchasing 230
reinstalling 226, 228

songs. See music
Sort By command 161
Sort by list 181, 188
Sort command 109, 181
sort options 161
sort order 181
sorting

folder items 172, 183, 188
History list items 121
information 181
messages 109
pictures and videos 140
tasks 161

sound clips 102
Sound Mode buttons 204
sound settings 204
sounds

adding to pictures 103
changing alarm 218
customizing 204
playing 137
previewing 55, 206
recording 205
selecting event 206
sending 205
setting ringtone 54

setting system 204
silencing 7, 204
turning off event 206

Sounds & Notifications 
screen 54

Sounds & Notifications 
Settings icon 204

Sounds & Notifications 
Settings screen 204, 205

Sounds tab 205
Space key 24
speaker 6, 142
speakerphone 42, 247, 259
Speakerphone command 42
special characters 27
special characters. See 

alternate characters; 
symbols

special occasions 155
specifications 263
speech-impaired services 56
Speed Dial Options 

command 49
speed-dial buttons 35, 47–49
Spell Check command 92
spell-checking 92, 171
Spelling command 171
split bar 177

spreadsheet templates 174, 
176, 184

spreadsheets
See also Excel Mobile; 

workbooks; 
worksheets

accessing 165
adding charts to 181, 182
calculations in 177–178
changing order of 

worksheets 179
creating 174
defining filters for 181
deleting elements in 183
display options for 177
entering data in 176, 178
formatting 174, 180
insertion options for 179
scrolling 177
searching 182
sending 83
sorting in 181
unsupported features for 

176
SSL (Secure Sockets Layer) 

117
standby mode 134
Start button 5, 28
Start menu 28, 208, 254
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starting
data connections 223
Excel Mobile 176
Internet Explorer Mobile 

117
Media Player Mobile 143, 

146
PowerPoint Mobile 173
Word Mobile 168

static electricity 261
status icons 61, 108
stereo headphones 142
Still image compression level 

list 137
Still Mode command 135
Stop command 143
stopping playback 143
stopping synchronization 82
Storage Card folder 192, 199
storage card symbol 188
Storage Card tab 198, 220
storage cards. See expansion 

cards
storage space 220, 239
Storage tab 98
storage temperatures 265
storing

applications 247
attachments 93, 98

device 6
document files 170
information 195, 246, 247
passwords 77
pictures 246
workbooks 183

streaming 121, 254
Streaming Media application 

144
Strikethrough option 171
stylus 7
submenus 22
Suggest words when 

entering text check box 
211

support 249
Swap button 45, 46
Symbol command 178
symbols 26, 27, 48, 178
Sync button 79
sync cable 71, 73, 75
sync conflicts 77
sync schedules 239, 242
synchronization

backing up information 
and 228

battery life and 11
benefits of 65
defaults for 67

defined 254
hard resets and 227, 228
overview 67
preparing for 71
scheduling 78–79
setting options for 82
setting up 76, 80, 81
stopping 82
troubleshooting 226, 

235–241, 243
synchronization software 69, 

71, 237
synchronizing

addresses 237
dates and time 217
email 11, 92, 235, 242, 

243
information 68, 69, 70, 

235
manually 79
media files 142
multimedia files 141
Office files 167
offline 238
over Bluetooth 

connections 80
over IR ports 81
playlists 143
through USB hubs 236
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wirelessly 68, 75, 80, 81, 
240

with multiple computers 
81

with sync cable 75
with third-party 

applications 71, 228
system alarms 217
system dates and time 216
system errors 232
system locks 212, 215
system requirements 71, 

265
system settings 216–222, 

227
system sounds 7, 204
system warnings 205

T

tables in documents 168
tabs 18
taking pictures 133–134, 244
tapping 17, 20, 207
tapping sounds 205
task categories 160, 161
Task tab 160
tasks

adding notes to 160
completing 160

creating 159
customizing 161
deleting 161
displaying 161
filtering 161
filtering and sorting 161
marking as sensitive 160
setting due dates for 160
setting reminders for 160, 

161
Tasks application 159–161
Tasks entry bar 159, 161
Tasks icon 159
Tasks list 161
Tasks tab (Connections) 222, 

223, 224
TDD devices 56, 258
technical support 249
telecommunications devices 

for impaired. See TTY 
devices

temperature range 265
templates

documents 169, 172
multimedia messages 107
notes 163, 164
spreadsheets 174, 176, 

184
text messages 107

Templates folder 169, 176
tentative appointments 155
text

aligning 171
changing 169
copying 121
deleting 20
entering 24, 25, 211, 212
finding and replacing 169, 

211
formatting 170
highlighting 20, 170
moving or copying 169
resizing 119, 206
selecting 20
spell-checking 92, 171
word-processing features 

for 168
text captions 104
text fields

moving to 18
opening drop-down lists in 

23
removing text in 20
scrolling through 18

text files 219
text messages

creating 101
deleting 109, 110
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forwarding 107
links in 108
opening 106
overview 99
phone calls and 42
phone numbers in 39
receiving 105, 234
replying to 106
saving 107
sending 40, 101
setting options for 104
sorting 109
troubleshooting 233

Text Size tab 206
Text Speed Dial button 48
text speed-dial buttons 35, 

47
text telephone devices. See 

TTY devices
themes 203, 207
third-party applications

accessing Outlook folders 
and 238

caution for hard resets and 
227

compatibility with 189
deleting 247
getting help with 246
installing 190, 245, 246

navigator and 17, 246
previewing pictures and 

245
reinstalling 226, 228
screen resolution and 231
synchronizing with 71, 

228
troubleshooting 190, 230, 

245–246
third-party vendors 71
Thumbnail View 134, 136
Thumbnails button 135
TIF files 138
time format settings 207
time system settings 216
Time tab 207, 217
time units 155
time zones 216, 239
Timer 134
tips 1
Today icon 203
Today screen

accessing 12, 29
accessing Dial Pad from 

38
color themes for 207
components of 30
customizing 140, 203
dialing from 34, 35, 37, 38

overview 29
recovering settings for 

240
retrieving voicemail from 

41
Today Settings screen 203
top view (device) 7
touchscreen. See screen
touchscreen lockout 212, 

213
touch-sensitive feature 212
transactions 244
transferring

applications 198
files 142, 146, 197, 198
information 65, 225

transition effects (slides) 174
transmission delays 234
Transparency level list 140
troubleshooting 225, 249
Trusted Device list 124
trusted devices 123, 124, 

126
See also partnerships

trusted pairs. See 
partnerships

TTY devices 56, 258
TTY/TDD options 56, 258
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Turn on Bluetooth check box 
52, 124

turning on or off
alarms 205, 218
caller IDs 58
Caps Lock 25
device 33, 258
event sounds 206
keyboard backlight 24
Keyguard 213
Option Lock 25
reminders 205
ringer switch 204
screen 33, 34, 221
wireless services 11

TXT files 167
Typing mode 164

U

UMTS services 254
unauthorized users 212, 219
unavailable time slots 157
Underline option 170
underlining text 168, 170
Undo command 141
Unfreeze Panes option 177
Unknown Caller option 54
unlocking

device 215

SIM smartcards 214
spreadsheet rows and 

columns 177
unread messages 108
unretrieved voicemail 40
unsafe areas 258
untimed events 155, 156
Update Library command 

145
updating information 65, 70
upgrades 225
uppercase letters 25, 212
urgent message icon 108
URLs 144, 173

See also web links
USB connections 127
USB controllers 237
USB hubs 236
USB ports 73, 236
USB sync cable 73
Use above settings while 

roaming check box 79
Use network time zone 

check box 217
user discussion groups 249
User Guide 249
usernames 254

V

Validity Period list 105
vCal attachments 242
vCard attachments 104, 242
Vibrate when… check boxes 

55, 206
vibrating alarm 204, 206
video albums 138
video file types 138
video files 102, 141, 238
Video Mode command 135
video options 147
video ringtones 133, 139
Video tab 137, 147
videos

adding sounds 137
adding to messages 103
changing resolution 135
defaults for 137
downloading 141, 142
limiting length 137
previewing 135
receiving 133
recording 135–136
saving 137
sending 139
setting resolution for 244
synchronizing 141
viewing 133, 138, 141
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View By command 152
View command 118, 153
View Recording Toolbar 

command 162
viewing

alternate characters 26
animated images 141
applications on device 28
appointments 154
calendar 153
contacts 37, 152
current connection 223
daily schedules 154
events 155, 157
folder contents 188
items in folders 172, 183
memory usage 220
multimedia messages 107
notifications 55, 206
on-device documentation 

249
PDF files 167
pictures 133, 138, 141
power settings 220
Quick Tour documentation 

249
running applications 220
space on expansion cards 

198, 220

tasks 161
videos 133, 138, 141
web pages 117, 118
wireless settings 221

virtual private networks. See 
VPN connections

voice captions 103
Voice Command button 210, 

211
Voice Command icon 230
Voice Command screen 210
Voice Command settings 

210, 230
voice commands 12, 211
Voice mail option 54
voice notes 162, 211
Voice recording format list 

211
voice recording formats 211
voicemail

customizing 48, 54
receiving notifications for 

41
retrieving messages 41
sending calls to 39, 44
setting up 40

voicemail buttons 48
Voicemail icon 40
voicemail systems 40

volume
phone 13, 55
ringer 55
tapping sounds 205

Volume button 5, 13, 55
VPN clients 223, 235
VPN connections 89, 94, 223
VPN software 223

W

waking up screen 34, 42
wallpaper 133
warnings 205, 258
warranty 2
WBMP files 102
weak signals 231, 248
web addresses 30, 118, 244

See also web links
web browser. See Internet 

Explorer Mobile
web browsing

memory consumption and 
247

requirements for 1
secure sites and 117, 118, 

244
troubleshooting 243

web files 122
web links
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clearing 122
internal memory and 247
messages and 108, 119
Palm online support 249
selecting 19, 118
troubleshooting 244

web pages
accessing 117, 119, 121, 

243
arranging on screen 118
clearing links to 247
copying from 121
dialing from 39, 121
display options for 118
downloading items from 

120, 191
hiding images on 118
moving through 118
playing media files from 

144
refreshing 118, 243
resizing text on 119
returning to recently 

viewed 121
scrolling 118
searching 117
security settings for 123
selecting addresses on 

244

sending email from 119
setting as home 122
viewing 117, 118

Web search field 117
websites

See also web browsing
accessing 115
compatibility with 117
connecting to 117, 127
ending connections to 224
redirectors and 244
searching over 117
submitting transactions 

and 244
week numbers 158
Week View 154, 158
Week view option 158
Windows Media Player 121
Windows Mobile devices 

194, 225
Windows Mobile Getting 

Started Disc 2, 189
Windows Mobile operating 

system 230, 254
Windows Mobile software 

190
wireless band setting 59
wireless connections 115, 

123, 127–129

wireless coverage 12, 33
wireless features 11, 115, 

222, 245
Wireless Manager 11, 33, 

221
Wireless Manager command 

11, 33
wireless modems 127
wireless phones 261
wireless services 11, 221
wireless synchronization 68, 

75, 80, 81, 240
WMA files 138, 142
WMV files 138, 142
Word application 165

See also documents
Word Completion tab 211
word matching 169, 183
Word Mobile application 18, 

167–173
Word Mobile icon 168
word-processing features 

168
workbook list 184
workbooks

See also Excel Mobile 
application; 
spreadsheets

creating 176
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deleting 184
displaying 177
moving around in 177
naming 183
organizing 183
replacing information in 

182
saving 174, 176, 184
searching 182
setting default template 

for 184
worksheet names 175
worksheets

See also spreadsheets; 
workbooks

adding 179
adjusting column and row 

size for 180

deleting 184
entering defined names in 

180
entering formulas in 178, 

183
entering functions in 178
filtering data in 181
formatting options for 180
inserting cells, rows, and 

columns 179
moving between 177
naming 179
removing cells, rows, and 

columns 183
renaming 180

Writing mode 164

X

Xpress Mail 87–88
troubleshooting 241

Xpress Mail website 87

Y

Year View 154

Z

ZIP files 189
zoom buttons (camera) 134
Zoom command 119, 169
zoom icons (presentations) 

173
Zoom In command 173
zoom options 134
zoom settings 175, 177, 212


	Contents
	Welcome
	What’s in the box?
	Hardware
	Documentation and software

	What do I need to get started?

	Setting up
	Palm Treo 750 smart device overview
	Front view
	Back view
	Top view

	Inserting the SIM card and battery
	Charging the battery
	Maximizing battery life

	Making your first call
	Adjusting call volume
	What’s my number?

	Setting up synchronization

	Moving around on your Palm® Treo™ 750 smart device
	Navigating around the screen
	Scrolling through screens
	Closing screens
	Highlighting and selecting items
	Highlighting text
	Using the action keys
	Selecting menu items
	Selecting options in a shortcut menu
	Selecting options in a list

	Using the keyboard
	Understanding the keyboard backlight
	Entering lowercase and uppercase letters
	Entering numbers, punctuation, and symbols
	Entering other symbols and accented characters
	Symbols and accented characters

	Opening and closing applications
	Opening applications
	Closing applications

	Using your Today screen

	Your phone
	Turning your Palm® Treo™ 750 smart device on/off
	Turning your phone on
	Turning your phone off
	Waking up the screen and turning it off

	Making calls from the Today screen
	Dialing from the Today screen
	Dialing with a speed-dial button
	Dialing by contact name
	Dialing using the onscreen Dial Pad
	Redialing a recently called number

	Other ways of making calls
	Dialing by company name
	Dialing from a web page or message

	Receiving calls
	Using voicemail
	Setting up voicemail.
	Retrieving voicemail messages from the Today screen
	Retrieving messages from a voicemail notification

	What can I do during a call?
	Ending a call
	Switching applications during an active call
	Saving phone numbers
	Making a second call
	Answering a second call (call waiting)
	Making a conference call
	Forwarding calls

	Defining speed-dial buttons
	Creating a speed-dial button
	Editing a speed-dial button
	Deleting a speed-dial button
	Arranging your speed-dial buttons

	Using a phone headset
	Using a wired headset
	Connecting to a Bluetooth® hands-free device
	Using a Bluetooth hands-free device

	Customizing phone settings
	Selecting ringtones and display notices
	Adjusting call and ringer volume.
	Assigning a caller ID ringtone
	Enabling TTY
	Adding Contacts numbers from new callers
	Blocking calls
	Setting caller ID
	Setting call waiting notification
	Manually selecting your wireless band
	Enabling fixed dialing
	Manually selecting your network settings

	What are all those icons?

	Synchronizing information
	How do I synchronize?
	Synchronizing with ActiveSync desktop software
	Synchronizing wirelessly with the server

	What can I synchronize?
	Setting up your computer for synchronization
	System requirements
	Installing the desktop synchronization software
	Using ActiveSync desktop software
	Connecting your Treo 750 to your computer

	Synchronizing using the sync cable
	Setting up wireless synchronization
	Setting the synchronization schedule
	Initiating a wireless sync manually

	Other ways to synchronize
	Synchronizing over a Bluetooth connection
	Synchronizing over an infrared connection
	Synchronizing with multiple computers

	Setting synchronization options
	Changing which applications sync
	Stopping synchronization


	Your email
	Setting up
	Entering settings for an email account
	Using a do-it-yourself setup application
	Using an IT-assisted setup application
	Setting up Xpress Mail
	Setting up Good Mobile Messaging
	Setting up an IMAP or POP email account

	Sending and receiving messages
	Creating and sending an email message
	Receiving email messages
	Receiving attachments

	Working with email messages
	Adding an online address book
	Using an online address book
	Forwarding a message
	Adding a signature to your messages
	Customizing your email settings

	Sending email messages from within another application

	Your text and multimedia messages
	Using the Messaging application
	Creating and sending a text message
	Creating and sending a multimedia message
	Setting message options
	Receiving text and multimedia messages
	Viewing/playing a message
	Using Messaging to chat
	Using links in messages
	Message status icons
	Sorting your messages
	Deleting a single message
	Deleting multiple messages

	Customizing the Messaging application
	Customizing message settings
	Customizing chat settings
	Customizing notification settings
	Customizing network settings

	Using Pocket MSN
	Signing in to Pocket MSN


	Your connections to the web and wireless devices
	Browsing the web
	Viewing a web page
	Creating a favorite
	Viewing a favorite
	Organizing your favorites
	Downloading files and images from a web page
	Copying text from a web page
	Returning to recently viewed pages
	Customizing your Internet Explorer Mobile settings

	Connecting to devices with Bluetooth® wireless technology
	Entering basic Bluetooth settings
	Requesting a connection with another Bluetooth device
	Accepting a connection from another Bluetooth device

	Using your device as a wireless modem
	Setting up Modem Link for a USB connection
	Creating a DUN connection using Bluetooth technology
	Setting up your computer for a Bluetooth DUN connection
	Accessing the Internet using a Bluetooth DUN connection
	Terminating a DUN Internet session


	Your photos, videos, and music
	Camera
	Taking a picture
	Taking pictures in burst mode
	Recording a video
	Customizing your Camera settings

	Pictures & Videos
	Viewing a picture
	Viewing a video
	Viewing a slide show
	Sending a picture or video
	Creating a video ringtone
	Organizing pictures and videos
	Using a picture as the Today screen background
	Editing a picture
	Deleting a picture or video
	Viewing pictures and videos on your computer

	Windows Media Player Mobile
	Transferring media files to your Treo 750
	Playing media files on your Treo 750
	Working with libraries
	Working with playlists
	Customizing Windows Media Player Mobile


	Your personal information organizer
	Contacts
	Adding a contact
	Viewing or changing contact information
	Deleting a contact
	Customizing Contacts
	Finding a contact in an online address book

	Calendar
	Displaying your calendar
	Creating an appointment
	Adding an alarm reminder to an event
	Creating an untimed event
	Scheduling a repeating appointment
	Sending a meeting request
	Marking an event as sensitive
	Organizing your schedule
	Deleting an event
	Customizing Calendar

	Tasks
	Adding a task
	Checking off a task
	Organizing your tasks
	Deleting a task
	Customizing Tasks

	Notes
	Creating a note
	Creating a voice note
	Creating a note from a template
	Organizing your notes
	Deleting a note
	Customizing Notes


	Your Microsoft Office tools
	Synchronizing your Microsoft Office files
	Word Mobile
	Creating a document
	Opening an existing document
	Creating a document from a template
	Finding or replacing text in a document
	Moving or copying text
	Saving a copy of a document
	Formatting text
	Formatting paragraphs and lists
	Checking spelling in a document
	Organizing your documents
	Deleting a document
	Customizing Word Mobile

	PowerPoint Mobile
	Playing a presentation
	Setting presentation playback options

	Excel Mobile
	Creating a workbook
	Creating a workbook from a template
	Viewing a workbook
	Calculating a sum
	Entering a formula
	Inserting a function
	Entering a sequence automatically
	Adding cells, rows, and columns
	Formatting cells
	Formatting rows and columns
	Renaming a worksheet
	Sorting info in a worksheet
	Filtering info in a worksheet
	Creating a chart
	Formatting or changing a chart
	Finding or replacing info in a workbook
	Organizing your workbooks
	Deleting cells, rows, and columns
	Customizing Excel Mobile


	Your application and info management tools
	Finding information
	Using Search
	Exploring files and folders

	Installing applications
	Installing bonus software from the CD
	Installing third-party applications
	Installing applications from the Internet
	Installing applications from your computer
	Installing applications onto an expansion card

	Removing applications
	Sharing information
	Beaming information
	Beaming a record
	Receiving beamed information

	Using expansion cards
	Inserting and removing expansion cards
	Opening applications on an expansion card
	Saving files to an expansion card
	Moving info between your Treo 750 and an expansion card
	Copying or moving applications and files between your Treo 750 and an expansion card
	Viewing available expansion card memory
	Exploring files on an expansion card
	Renaming an expansion card

	Calculator
	Performing calculations
	Using the Calculator memory


	Your personal settings
	Today screen settings
	Selecting your Today screen background
	Selecting which items appear on your Today screen

	System sound settings
	Silencing sounds
	Selecting Sounds & Notifications

	Display and appearance settings
	Adjusting the brightness
	Changing the text size and clarity
	Setting display formats
	Aligning the screen to correct tapping problems
	Changing the system color scheme
	Changing screen orientation

	Application settings
	Arranging the Start menu
	Reassigning buttons
	Setting up voice commands
	Using voice commands
	Setting input options

	Locking your Treo 750 and info
	Locking your keyboard (Keyguard)
	Locking your screen
	Locking the SIM card
	Locking your Treo 750
	Entering owner information

	System settings
	Setting the date and time
	Synchronizing the date, time, and time zone with the network
	Setting system alarms
	Managing identity certificates
	Enabling error reporting
	How much storage space do I have left?
	Optimizing power settings
	Turning wireless services on/off

	Connection settings
	Managing ISP settings
	Connecting to a VPN (virtual private network)
	Setting up a proxy server
	Ending a data connection


	Common questions
	Transferring info from another device
	Reinstalling the desktop software
	Resetting your Treo 750
	Performing a soft reset
	Performing a hard reset
	Replacing the battery

	Performance
	The applications are running slower than usual
	My battery seems to drain quickly

	Screen
	The screen appears blank
	The screen doesn’t respond accurately to taps or activates wrong features

	Network connection
	Signal strength is weak
	My Treo 750 won’t connect to the mobile network
	My phone seems to turn off by itself
	I can’t tell if data services are available
	My Treo 750 won’t connect to the Internet
	I can’t send or receive text or multimedia messages
	I can’t make or receive calls using a hands-free device with Bluetooth® wireless technology
	I lost the connection between my Treo 750 and my Bluetooth headset

	Synchronization
	ActiveSync desktop software
	ActiveSync desktop software does not respond to sync attempt
	Synchronization finishes but info doesn’t appear where it should
	Synchronization starts but doesn’t finish
	My video and music files won’t sync
	My appointments show up in the wrong time slot after I sync
	My scheduled sync doesn’t work
	An alert tells me that ActiveSync encountered a problem on the server
	An alert tells me that there is not enough free memory to sync my info
	An alert tells me that ActiveSync encountered a problem with [item type] [item name]
	My Today screen settings are not restored after a hard reset
	Exchange ActiveSync (wireless synchronization)
	An alert tells me that the server could not be reached
	An alert tells me that my account information could not be detected
	An alert tells me the device timed out while waiting for credentials

	Email
	I have problems using my account
	I have problems sending and receiving email
	Scheduled email synchronization is not working
	I have problems sending email
	My vCard or vCal email attachment isn’t forwarding correctly
	When I sync with my Exchange Server my info is not downloading to my Treo 750

	Web
	I can’t access a page
	An image or map is too small on my Treo 750 screen
	A secure site refuses to permit a transaction

	Camera
	The Camera preview image looks strange

	Third-party applications
	Getting more help

	Making room on your Treo 750
	Voice quality
	Is the other person hearing an echo?
	Are you hearing your own voice echo?
	Is your voice too quiet on the other end?


	Where to learn more
	For a quick introduction
	While using your Treo 750
	If you need more information

	Terms
	Regulatory information
	Specifications
	Index
	Symbols
	Numerics
	A
	B
	C
	D
	E
	F
	G
	H
	I
	J
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Y
	Z


